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CHAPTER 1

Introduction
Supported In:

Pulse is a documentation-centric social collaboration platform that enables you to connect, collaborate, and share knowledge with fellow authors, employees, and your end users. It functions
much like many of the social media websites on the Internet, except it revolves specifically around
your online output. It also gives you the ability to view several types of reports about your project,
including which topics are being seen the most and which search terms are not yielding any results.
This chapter discusses the following:
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Types of Users
Pulse gives you to form communities and groups around the following different types of users, who
can all use Pulse to communicate and facilitate exchange of ideas and information.

n

Administrators Administrators are users who have complete access to all Pulse features and
functionality. They have exclusive control over deleting other users' content, adjusting server
settings, and accessing reports.

n

Employees (Advanced Users) These are users who have been given a higher level of access
to Pulse features and functionality by the Administrator. They have a wider range of options
when it comes to directly communicating and interacting with other users, ranking topics, voting on answers, and filtering content. They do not necessarily have to be employees of your
company. That is simply the term used in Pulse.

n

Customers (Basic Users) These are users who have basic access to Pulse features and functionality, such as creating a profile, subscribing to topics, and posting content such as comments, articles, questions, and multimedia. They do not necessarily have to be customers of
your company. That is simply the term used in Pulse.

n

General Public (Unregistered) These users have restricted access to Pulse. They can read
comments, search comments, see topic ratings, and add a topic rating.
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Installation
The following describe installation information and steps for Pulse:
1. System Requirements As you prepare for your Pulse installation, familiarize yourself with the
minimum system requirements, depending on the operating system. See "Windows Server
2012 Requirements" on page 14, "Windows Server 2008R2 Requirements" on page 33, and
"Windows Server 2008 Requirements" on page 51.
2. Deployment Types Pulse can be installed on one or more systems running the required version of Windows Server. The installation type that you choose will largely depend on factors
that are specific to your environment, such as the number of users you plan to host, your web
usage, and other factors related to deploying an SQL database and IIS server. See "Installation" on page 11.
3. Install the Prerequisites To prepare for a Pulse installation, you will need to prepare the systems that will be hosting the Pulse server application and the Microsoft SQL Server instance
for the Pulse database. See "Installing the Prerequisites for Windows Server 2012" on page 22,
"Installing the Prerequisites for Windows Server 2008R2" on page 41, and "Installing
the Prerequisites for Windows Server 2008" on page 59.
4. Install Microsoft SQL Server You can install a Microsoft SQL Server instance to use as the
Pulse database. This instance can reside on the Pulse web server (this is the server running
IIS) or on a different system with access to the Pulse web server. See "Installing Microsoft
SQL Server" on page 72.
5. Install Pulse After preparing the Pulse web server and database server for the installation process, you can install Pulse. See "Installing and Activating Pulse" on page 92.
6. Pulse Server Configuration After the Pulse server application is installed on the Pulse web
server, use the desktop shortcut or the Programs menu in Windows to start the Pulse application.
7. Integrate Flare With Pulse To integrate the embedded discussion forms and other Pulse features with your Flare output, add a new community in Flare. This action automatically creates
a new system in Pulse, allowing your web server to host, store, and serve the embedded discussion forms that appear below the topics in your Flare output. This system also gives you
and your team members the ability to moderate and administer the Pulse features and content from the Pulse dashboard. See "Integrating Flare and Pulse" on page 126.
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Dashboard
The Pulse dashboard is the web-based interface to the Pulse system. Depending on your group
membership, authorized users can use the dashboard to configure a variety of server settings,
administer users and groups, moderate the Pulse content associated with your Flare output, and
access some basic end user features. See "Pulse Dashboard" on page 185.
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Using Pulse
After Pulse is set up and integrated with your Flare output, using the features of Pulse involves the
following:
n

Getting Started
l

l

l

Registering When you integrate a Pulse system with a Flare community, there are two
methods for joining the community. Both methods require you to register and activate an
account. See "Registering for a Pulse Account" on page 310.
Logging In Once you have registered for a Pulse account, you can log in to the Pulse dashboard or you can log in to the published Flare output to use the community features. See
"Logging In to Pulse" on page 317.
Creating and Editing Profile Registered Pulse users can edit their account profile by changing their personal information, uploading a profile images, and specifying their notification settings. See "Editing Your Profile" on page 323.

n

Posting Content Users can post content in a variety of ways, including status updates, questions, articles, and tasks. See "Posting Content" on page 328.

n

Responding to Posts Users can respond to posts by adding comments; following, liking, and
tagging posts; and mentioning documents, people, and groups. See "Responding to Posts" on
page 341.

n

Messaging The Messages app gives you the ability to read, send, and hide conversations with
other Pulse users. You must access the Messages app from the Pulse dashboard. Messages
are not accessible from the Flare content. See "Messaging Tasks" on page 352.

n

Moderating Pulse If you are a member of the Administrators or Employees group, there are
two user interfaces for moderating the activity in your Pulse system. You can use the Flare
output and/or the Pulse dashboard. See "Moderating Pulse" on page 361.

n

Searching Pulse When integrating a Pulse system with a Flare community, you have two different search options. You can search a feed in Pulse or, if you enable the feature, you can
extend the scope of a Flare search to include the Flare community results stored in Pulse. See
"Searching for Community Results" on page 452.
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NOTE: Although it is similar to Feedback, Pulse is newer and offers a more complete solution for incorporating social collaboration in your output. There is an upgrade path for Feedback users who would like to move to Pulse. This can be done when you install Pulse. There
is an option to "Import Feedback Data." This wipes out your new Pulse database and
imports all of your Feedback data.
When you import a database from Feedback, your report data, comments, and users are
imported. Since Feedback users do not have a password associated with their email
address, their passwords are their email addresses (e.g., if you have a user with bob@email.com, his password will now be bob@email.com). However, users can change their
passwords by clicking "I forgot my password" from a Pulse login screen.

NOTE: MadCap Pulse is an optional feature in Flare that is sold separately.
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CHAPTER 2

Installation
The installation of Pulse depends on multiple applications and utilities working together. There are a
couple of types of deployment you can use, and you can install Pulse on one of three different operating systems. The installation type that you choose will depend on factors that are specific to your
environment, such as the number of users you plan to host, your web usage, and other factors
related to deploying an SQL database and IIS server.
This chapter discusses the following:
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Two-Server Deployment
The most common deployment type for Pulse is to install the components in a distributed environment on two servers:
n

Pulse Web Server The web server is a Windows Server system running Microsoft Internet
Information Services (IIS). You install the Pulse server application on this system.

n

Pulse Database Server The database server is a Windows Server system running Microsoft
SQL Server. You install an instance of Microsoft SQL and create the Pulse database on this
system.

After deploying Pulse, the integrated Flare output can be published either to the Pulse web server or
to a different system with access to the Pulse web server.
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Single-Server Deployment
It is also possible to install all of the Pulse components on a single server. This means the Pulse web
server and database server are running on a single system. Although this is a simple way to deploy
Pulse, most organizations choose to install Pulse in a distributed environment because it offers
greater scalability and performance.

After deploying Pulse, the integrated Flare output can be published either to the Pulse web server or
to a different system with access to the Pulse web server.

IMPORTANT: When deciding which installation type is best for your environment, it is
recommended that you discuss your options, deployment strategy, and system requirements with your IT department.
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Windows Server 2012 Requirements
As you prepare for your Pulse installation, familiarize yourself with the minimum system requirements.

Pulse Web Server
The Pulse web server provides users the ability to access and use the web-based user interfaces of
the Pulse system.

WEB SERVER—MINIMUM HARDWARE REQUIREMENTS
This table details the minimum hardware requirements for the Pulse web server:
Component

Minimum Requirement (for a Pilot
Server)

Recommended (for a Production Server)

Processor

32-bit, quad-core

64-bit, quad-core

Memory

4 GB

4 GB

Hard Disk

100 GB (for data drives)

100 GB (for data drives)

80 GB (for system drives)

80 GB (for system drives)

For daily operations, maintain at least
twice as much free space as RAM.

For daily operations, maintain at least
twice as much free space as RAM.
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WEB SERVER—OPERATING SYSTEM REQUIREMENTS
This table details the operating system requirements to install the Pulse web server:
The Pulse setup program installs the Pulse application on the web server (this is the server running
IIS). Before running the setup program, you must make sure Microsoft .NET Framework 4.5 is
installed.
IMPORTANT: All of the latest Windows service packs and critical updates must also be
installed.

Requirement

Notes

Microsoft Windows Installer
(MSI) 5.0

The MSI 5.0 is included with the operating system.

Internet Information Services
Version 8

This is included with the operating system. Use the Server Manager to add the
Web Server (IIS) role service. See "How to Install IIS" on page 24.

ASP.NET 4.5

This is included with the operating system. Use the Server Manager to add the
ASP.NET role service. This is covered in the steps for installing IIS.

Microsoft
.NET Framework
4.5

This is included with the operating system and may already be installed on
your server, typically by a Network Administrator. If it is not installed, you can
download it from:
http://www.microsoft.com/en-us/download/details.aspx?id=30653

WEB SERVER—PULSE SETUP PROGRAM
The Pulse setup program installs the Pulse application on the web server (this is the server running
IIS). Before running the setup program, you must make sure Microsoft .NET Framework 4.5 is
installed. See "Installing the Prerequisites for Windows Server 2012" on page 22.
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WEB SERVER—MICROSOFT VISUAL C++ 2010 REDISTRIBUTABLE
The Pulse setup program requires the web server to be running the Microsoft Visual C++ 2010 Redistributable or a newer version.
This prerequisite is automatically installed when you run the Pulse setup program. The setup program automatically checks your system for a compatible version. If a compatible version is detected, you can quit the system check. If a compatible version is not detected, you will be prompted to
download and install it. See "Installing and Activating Pulse" on page 92.
IMPORTANT: Software vendors commonly redistribute different versions of Visual C++
with their programs. If your system is running more that one version of Visual C++, you do
not want to delete or uninstall any version from your system as doing so can render any
linked software programs inoperable.

WEB SERVER—RECOMMENDED BROWSERS
For best results, it is recommended that you use one of these web browsers when accessing the
web-based Pulse tools:
Browser

Version

Microsoft Internet Explorer

7 or later

Apple Safari

5

Mozilla Firefox

3.5 or later

Google Chrome

5.0 or later
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Pulse Database Server
The Pulse database server is the primary repository for Pulse data. This includes users, groups, files,
messages, videos, and images.

DATABASE SERVER—MINIMUM HARDWARE REQUIREMENTS
This table details the required hardware components for the Pulse Database server:
Component

Minimum Requirement (for Pilot)

Recommended (for Production)

Processor

32-bit, 4 core

64-bit, 4 core

Memory

4 GB

4 GB

Hard Disk

100 GB (for data drives)

100 GB (for data drives)

80 GB (for system drives)

80 GB (for system drives)

For daily operations, maintain at least twice as
much free space as RAM.

For daily operations, maintain at least twice as
much free space as RAM.
For every 1,000 users per
year, we recommend 100
GB for storage.
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DATABASE SERVER—OPERATING SYSTEM REQUIREMENTS
This table details the operating system requirements for the Pulse database server:
IMPORTANT: All of the latest Windows service packs and critical updates must also be
installed.

Requirement

Notes

Microsoft Windows Installer
(MSI) 5.0

The MSI 5.0 is included with the operating system.

Internet Information Services
Version 8

This is included with the operating system. Use the Server Manager to add the
Web Server (IIS) role service. See "How to Install IIS" on page 24.

ASP.NET 4.5

This is included with the operating system. Use the Server Manager to add the
ASP.NET role service. This is covered in the steps for installing IIS.

Microsoft
.NET Framework
4.5

This is included with the operating system and may already be installed on
your server, typically by a Network Administrator. If it is not installed, you can
download it from:
http://www.microsoft.com/en-us/download/details.aspx?id=30653
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DATABASE SERVER—SQL SERVER REQUIREMENTS
To give end users the ability to use the Pulse search features, you must install a supported version
of Microsoft SQL Server. The edition you install must support the full-text search feature. Please
refer to the documentation provided with SQL Server to determine if that edition supports full-text
search. See "Installing Microsoft SQL Server" on page 72.
IMPORTANT: Microsoft SQL Server Express Edition with Advanced Services is the only
Express edition from Microsoft that is compatible with Pulse. This is because Pulse requires
the full-text search feature.

IMPORTANT: Microsoft SQL Server Express with Advanced Services edition supports a
maximum database size of 10 GB. It is best suited when used in lab/test environments. It is
not recommended for production environments.
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Required Access Credentials and Networking Information
The user performing the installation will also need the following information in order to complete the
installation and configuration tasks:
Item
Active Directory
Domain
Account

DNS Entry

Requirements
Create a Domain Account with Local Administrator
Rights for the Pulse Server. This account will need:
n

A password that never expires

n

A valid email address in Active Directory

n

Read access to Active Directory

n

You should also grant this account System
Administrator (sysadmin) privileges in
SQL Server.

n

Resolves to the Pulse web server

n

Uses a fully qualified domain name

Purpose
Used by the PulseService
on the application server
to schedule notifications,
send emails, and deliver
posts.
Used by the Web Application Pool.

The URL that Pulse Administrators use to access
the Pulsedashboard.

Outbound
Email Settings
(SMTP Relay)

Port 25 (typical, depends on your network)

Gives Pulse the ability to
send outbound email messages.

Inbound
Email Settings

To enable reply-to email capabilities, you will need
settings for one of the following:

Required by Pulse web
server to provide reply-to
email capabilities.

n

POP3 host, username, and password
OR

n

Exchange Web Services URL,domain, username, and password for the Microsoft
Exchange account
OR

n
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Item
SSL Certificate for
Pulse Web
Server
(Optional)
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Requirements
If you plan to use the Secure Sockets Layer (SSL)
protocol to establish an encrypted connection with
your Pulse site, you must obtain an SSL certificate
from an SSL provider and install it on the Pulse web
server.

Purpose
Gives site visitors the ability to access your site
using the secure https://
protocol.
Use the Internet Information Services
(IIS) Manager to install
the SSL Certificate.
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Installing the Prerequisites for Windows Server 2012
Information for Network Administrators
To prepare for a Pulse installation, you need to prepare the systems that will be hosting the Pulse
server application and the Microsoft SQL Server instance for the Pulse database.

Before You Begin
In order to download and install the prerequisites, you need an Internet connection.
You also need the ability to log on the server(s) as a user who has access permissions to install software and change configuration settings on the system. This requires you to have access credentials for one of these accounts:
n

The Built-in Administrator Account for Windows Server This account has full administrative
privileges and is included with the operating system by default. See the person who installed
the server's operating system for the user name and password.
OR

n

A Local User Account with Administrative Privileges If available in your environment, you can
use a local administrator account. With a local administrator account, the server checks its
own files to authenticate the user and determine if they have the appropriate administrative
rights to install software on the system. This account is created on the server, typically by a
Network Administrator.
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Installing the Prerequisites
First, install Windows Server 2012 on the system acting as the Pulse web server and Pulse database
server. Whether you are setting up a new server or just using an existing Windows server, you should
also ensure that the operating system is updated with all of the latest service packs, critical
patches, and security updates from Microsoft.
If you are not familiar with how to install a server operating system, contact your Windows Administrator and/or Network Administrator for assistance. This will help to ensure that your server is in
compliance with any security and network requirements specific to your environment.
IMPORTANT: If you are not familiar with how to install a server operating system, contact
your Windows Administrator and/or Network Administrator for assistance. This will help to
ensure that your server is in compliance with any security and network requirements specific to your environment. See "Windows Server 2012 Requirements" on page 14.
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HOW TO INSTALL IIS
IIS provides the server hosting Pulse with web server capabilities and the ASP.NET framework,
which is a feature of the .NET Framework. It supports the creation of web pages and web services.
If you are setting up a new web server for Pulse, it is very important that you install IIS before
installing the .NET Framework.
IMPORTANT: Always make sure that you are installing IIS on the system designated as
the Pulse server. If you are setting up a new server, IIS must always be installed before the
.NET Framework.

IMPORTANT: Do not run IIS on a domain controller or a backup domain controller.

NOTE: IIS is a built-in component of the Windows OS. For Windows Server 2012, the
OS lets you install IIS 8.0.

1. Log in to the system that you selected to be the Pulse web server using one of these
accounts:
n

Built-in Administrator Account for Windows Server This account has full administrative
privileges and is included with the operating system by default. See the person who
installed the server's operating system for the user name and password.
OR

n

A Local User Account with Administrative Privileges If available in your environment, you
can use a local administrator account for the server. With a local account, the server
checks its own files to authenticate the log in and determine if the user has the appropriate administrative rights to install software on the system. This is different from a network domain account.

2. Determine if IIS is installed on the operating system. To do this, press the Windows key on
your keyboard.

Click the Server Manager tile to open the Server Manager.
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If IIS is installed, this should be indicated on the Server Manager.
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3.

If you need to install IIS on the server, add the Web Server (IIS) role service:
a. In the Server Manager, click Add roles and features.

The Add Roles and Features Wizard opens.
b. Click Next..
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c. Make sure Role-based or feature-based installation is selected. Then click Next.
The local server should be listed.

d. Click Next.. The list of roles is shown.
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e. Scroll down and place a check mark in the Web Server (IIS) box.
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A dialog opens.

f. Click Add Features. The Web Server (IIS) check box now has a check mark.
g. Click Next.
By default you should see options for .NET 3.5 and .NET 4.5. Only the option for .NET 4.5
should be selected.
h. Scroll down and select Windows Identity Foundation 3.5.
i. Click Next..
j. Click Next again.
k. Place a check mark next to all of the role services in the list below. When finished, click
Next.
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Select the desired services using the recommended role services listed below. Role services required by Pulse are marked with an asterisk (*).
Role Services Category
Common HTTP Features

Select These Role Service Check Boxes
*Static Content
Default Document
Directory Browsing
HTTP Errors

Application Development

*ASP.NET 4.5
.NET Extensibility 4.5
ISAPI Extensions
ISAPI Filters

Health and Diagnostics

HTTP Logging

Security

*Basic Authentication
*Windows Authentication
Request Filtering

Performance

Static Content Compression
Dynamic Content Compression

Management Tools

IIS Management Console

IIS 6 Management Compatibility

*IIS 6 Metabase Compatibility

l. Confirm your selections and click Install
m. After the installation finishes, click Close
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Windows Server 2008R2 Requirements
As you prepare for your Pulse installation, familiarize yourself with the minimum system requirements.

Pulse Web Server
The Pulse web server provides users the ability to access and use the web-based user interfaces of
the Pulse system.

WEB SERVER—MINIMUM HARDWARE REQUIREMENTS
This table details the minimum hardware requirements for the Pulse web server:
Component

Minimum Requirement (for a Pilot
Server)

Recommended (for a Production Server)

Processor

32-bit, quad-core

64-bit, quad-core

Memory

4 GB

4 GB

Hard Disk

100 GB (for data drives)

100 GB (for data drives)

80 GB (for system drives)

80 GB (for system drives)

For daily operations, maintain at least
twice as much free space as RAM.

For daily operations, maintain at least
twice as much free space as RAM.
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WEB SERVER—OPERATING SYSTEM REQUIREMENTS
This table details the operating system requirements to install the Pulse web server:
IMPORTANT: You should at least be using Service Pack 1 (SP1). Also, all of the latest Windows service packs and critical updates must also be installed.

Requirement
Microsoft Windows Installer
(MSI) 5.0

Notes
The MSI 5.0 is included with the operating system.

Internet Information Services This is included with the operating system. Use the Server ManVersion 7 (IIS 7.5)
ager to add the Web Server (IIS) role service. See "How to Install
IIS" on page 43.
ASP.NET 4.0

This is included with the operating system. Use the Server Manager to add the ASP.NET role service. This is covered in the steps
for installing IIS.

Microsoft .NET Framework
4.5 (Recommended) or 4.0
(Minimum)

If you do not already have .NET framework 4.5 or 4.0, you can
download it from the Microsoft Download Center.
n

.NET framework 4.5 You can download it from:
http://www.microsoft.com/en-us/download/details.aspx?id=30653

n

.NET framework 4.0 You can download it from:
http://www.microsoft.com/en-us/download/details.aspx?id=17718

WEB SERVER—PULSE SETUP PROGRAM
The Pulse setup program installs the Pulse application on the Pulse web server (this is the server
running IIS). Before running the setup program, you must you must make sure Microsoft
.NET Framework is installed. See "Installing the Prerequisites for Windows Server 2008R2" on page
41.
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WEB SERVER—MICROSOFT VISUAL C++ 2010 REDISTRIBUTABLE
The Pulse setup program requires the web server to be running the Microsoft Visual C++ 2010 Redistributable or a newer version.
This prerequisite is automatically installed when you run the Pulse setup program. The setup program automatically checks your system for a compatible version. If a compatible version is detected, you can quit the system check. If a compatible version is not detected, you will be prompted to
download and install it. See "Installing and Activating Pulse" on page 92.
IMPORTANT: Software vendors commonly redistribute different versions of Visual C++
with their programs. If your system is running more that one version of Visual C++, you do
not want to delete or uninstall any version from your system as doing so can render any
linked software programs inoperable.

WEB SERVER—RECOMMENDED BROWSERS
For best results, it is recommended that you use one of these web browsers when accessing the
web-based Pulse tools:
Browser

Version

Microsoft Internet Explorer

7 or later

Apple Safari

5

Mozilla Firefox

3.5 or later

Google Chrome

5.0 or later
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Pulse Database Server
The Pulse database server is the primary repository for Pulse data. This includes users, groups, files,
messages, videos, and images.

DATABASE SERVER—MINIMUM HARDWARE REQUIREMENTS
This table details the required hardware components for the Pulse Database server:
Component

Minimum Requirement (for Pilot)

Recommended (for Production)

Processor

32-bit, 4 core

64-bit, 4 core

Memory

4 GB

4 GB

Hard Disk

100 GB (for data drives)

100 GB (for data drives)

80 GB (for system drives)

80 GB (for system drives)

For daily operations, maintain at least twice as
much free space as RAM.

For daily operations, maintain at least twice as
much free space as RAM.
For every 1,000 users per
year, we recommend 100
GB for storage.
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DATABASE SERVER—OPERATING SYSTEM REQUIREMENTS
This table details the operating system requirements for the Pulse database server.
IMPORTANT: All of the latest Windows service packs and critical updates must also be
installed.

Requirement
Microsoft Windows Installer
(MSI) 5.0

Notes
The MSI 5.0 is included with the operating system.

Internet Information Services This is included with the operating system. Use the Server ManVersion 7 (IIS 7.5)
ager to add the Web Server (IIS) role service. See "How to Install
IIS" on page 43.
ASP.NET 4.0

This is included with the operating system. Use the Server Manager to add the ASP.NET role service. This is covered in the steps
for installing IIS.

Microsoft .NET Framework
4.5 (Recommended) or 4.0
(Minimum)

If you do not already have .NET framework 4.5 or 4.0, you can
download it from the Microsoft Download Center.
n

.NET framework 4.5 You can download it from:
http://www.microsoft.com/en-us/download/details.aspx?id=30653

n

.NET framework 4.0 You can download it from:
http://www.microsoft.com/en-us/download/details.aspx?id=17718
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DATABASE SERVER—SQL SERVER REQUIREMENTS
To give end users the ability to use the Pulse search features, you must install a supported version
of Microsoft SQL Server. The edition you install must support the full-text search feature. Please
refer to the documentation provided with SQL Server to determine if that edition supports full-text
search. See "Installing Microsoft SQL Server" on page 72.
IMPORTANT: Microsoft SQL Server Express Edition with Advanced Services is the only
Express edition from Microsoft that is compatible with Pulse. This is because Pulse requires
the full-text search feature.

IMPORTANT: Microsoft SQL Server Express with Advanced Services edition supports a
maximum database size of 10 GB. It is best suited when used in lab/test environments. It is
not recommended for production environments.
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Required Access Credentials and Networking Information
The user performing the installation will also need the following information in order to complete the
installation and configuration tasks:
Item
Active Directory
Domain
Account

DNS Entry

Requirements
Create a Domain Account with Local Administrator
Rights for the Pulse Server. This account will need:
n

A password that never expires

n

A valid email address in Active Directory

n

Read access to Active Directory

n

You should also grant this account System
Administrator (sysadmin) privileges in
SQL Server.

n

Resolves to the Pulse web server

n

Uses a fully qualified domain name

Purpose
Used by the PulseService
on the application server
to schedule notifications,
send emails, and deliver
posts.
Used by the Web Application Pool.

The URL that Pulse Administrators use to access
the Pulsedashboard.

Outbound
Email Settings
(SMTP Relay)

Port 25 (typical, depends on your network)

Gives Pulse the ability to
send outbound email messages.

Inbound
Email Settings

To enable reply-to email capabilities, you will need
settings for one of the following:

Required by Pulse web
server to provide reply-to
email capabilities.

n

POP3 host, username, and password
OR

n

Exchange Web Services URL,domain, username, and password for the Microsoft
Exchange account
OR

n
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Item
SSL Certificate for
Pulse Web
Server
(Optional)
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Requirements
If you plan to use the Secure Sockets Layer (SSL)
protocol to establish an encrypted connection with
your Pulse site, you must obtain an SSL certificate
from an SSL provider and install it on the Pulse web
server.

Purpose
Gives site visitors the ability to access your site
using the secure https://
protocol.
Use the Internet Information Services
(IIS) Manager to install
the SSL Certificate.
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Installing the Prerequisites for Windows Server 2008R2
Information for Network Administrators
To prepare for a Pulse installation, you need to prepare the systems that will be hosting the Pulse
server application and the Microsoft SQL Server instance for the Pulse database.

Before You Begin
In order to download and install the prerequisites, you need an Internet connection.
You also need the ability to log on the server(s) as a user who has access permissions to install software and change configuration settings on the system. This requires you to have access credentials for one of these accounts:
n

The Built-in Administrator Account for Windows Server This account has full administrative
privileges and is included with the operating system by default. See the person who installed
the server's operating system for the user name and password.
OR

n

A Local User Account with Administrative Privileges If available in your environment, you can
use a local administrator account. With a local administrator account, the server checks its
own files to authenticate the user and determine if they have the appropriate administrative
rights to install software on the system. This account is created on the server, typically by a
Network Administrator.
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Installing the Prerequisites
First, install Windows Server 2008R2 (SP1) on the system acting as the Pulse web server and Pulse
database server. Whether you are setting up a new server or just using an existing Windows server,
you should also ensure that the operating system is updated with all of the latest service packs, critical patches, and security updates from Microsoft.
If you are not familiar with how to install a server operating system, contact your Windows Administrator and/or Network Administrator for assistance. This will help to ensure that your server is in
compliance with any security and network requirements specific to your environment.
IMPORTANT: You must upgrade the operating system to Service Pack 1 (SP1).

IMPORTANT: If you are not familiar with how to install a server operating system, contact
your Windows Administrator and/or Network Administrator for assistance. This will help to
ensure that your server is in compliance with any security and network requirements specific to your environment. See "Windows Server 2008R2 Requirements" on page 33.
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HOW TO INSTALL IIS
IIS provides the server hosting Pulse with web server capabilities and the ASP.NET framework,
which is a feature of the .NET Framework. It supports the creation of web pages and web services.
If you are setting up a new web server for Pulse, it is very important that you install IIS before
installing the .NET Framework.
In the Web Server (IIS) page, review the information. Then click Next.
IMPORTANT: Always make sure that you are installing IIS on the system designated as
the Pulse server. If you are setting up a new server, IIS must always be installed before the
.NET Framework.

IMPORTANT: Do not run IIS on a domain controller or a backup domain controller.

NOTE: IIS is a built-in component of the Windows OS. For Windows Server 2008 R2, the
OS lets you install IIS 7.5.

1. Log in to the system that you selected to be the Pulse web server using one of these
accounts:
n

Built-in Administrator Account for Windows Server This account has full administrative
privileges and is included with the operating system by default. See the person who
installed the server's operating system for the user name and password.
OR

n

A Local User Account with Administrative Privileges If available in your environment, you
can use a local administrator account for the server. With a local account, the server
checks its own files to authenticate the log in and determine if the user has the appropriate administrative rights to install software on the system. This is different from a network domain account.
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2. Determine if the appropriate version of IIS is installed on the operating system.
a. Click Start > Administrative Tools and look for the Internet Information Services (IIS)
Manager menu command.
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b. Depending on whether or not the menu command is visible, select the appropriate
option:
n

If the Menu Command is Not Visible You need to install IIS.
OR

n

If the Menu Command is Visible Select the menu command to open the
IIS Manager window. Then choose Help > About Internet Information Services to
see the version number.

If IIS is already installed on the server, you can add a new web site in IIS to use with
Pulse.
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3. If you need to install IIS on the server, add the Web Server (IIS) role service:
a. Click Start > Administrative Tools and select Server Manager from the context menu.

b. In the left-pane under Server Manager, highlight Roles. Then in the right-pane under
Roles Summary, click Add Roles.

The Add Roles wizard opens.
c. In the Before You Begin page, click Next
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d. In the Select Server Roles page, place a check mark in the Web Server (IIS) box. Then
click Next.

e. In the Web Server (IIS) page, review the information. Then click Next.
f. In the Select Role Services page, place a check mark next to all of the role services in
the list below. When finished, click Next.
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Select the desired services using the recommended role services listed below. Role services required by Pulse are marked with an asterisk (*).
Role Services Category
Common HTTP Features

Select These Role Service Check Boxes
*Static Content
Default Document
Directory Browsing
HTTP Errors

Application Development

*ASP.NET
.NET Extensibility
ISAPI Extensions
ISAPI Filters

Health and Diagnostics

HTTP Logging
Logging Tools
Request Monitor
Tracing

Security

*Basic Authentication
*Windows Authentication
Digest Authentication
Request Filtering

Performance

Static Content Compression
Dynamic Content Compression

Management Tools

IIS Management Console

IIS 6 Management Compatibility

*IIS 6 Metabase Compatibility

g. In the Confirm Installation Selections page, click Install. A progress indicator shows you
the status.
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h. After the "Installation Succeeded" message appears, click Close in the
Installation Results page.
i. Click Close to quit the Add Roles Wizard.
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Windows Server 2008 Requirements
As you prepare for your Pulse installation, familiarize yourself with the minimum system requirements.

Pulse Web Server
The Pulse web server provides users the ability to access and use the web-based user interfaces of
the Pulse system.

WEB SERVER—MINIMUM HARDWARE REQUIREMENTS
This table details the minimum hardware requirements for the Pulse web server:
Component

Minimum Requirement (for a Pilot
Server)

Recommended (for a Production Server)

Processor

32-bit, quad-core

64-bit, quad-core

Memory

4 GB

4 GB

Hard Disk

100 GB (for data drives)

100 GB (for data drives)

80 GB (for system drives)

80 GB (for system drives)

For daily operations, maintain at least
twice as much free space as RAM.

For daily operations, maintain at least
twice as much free space as RAM.
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WEB SERVER—OPERATING SYSTEM REQUIREMENTS
This table details the operating system requirements to install the Pulse web server:
IMPORTANT: You should at least be using Service Pack 2 (SP2) or later. Also, all of the
latest Windows service packs and critical updates must also be installed.
The Pulse setup program installs the Pulse application on the Pulse web server (this is the server
running IIS). Before running the setup program, you must you must make sure Microsoft
.NET Framework is installed.
Requirement

Notes

Microsoft Windows Installer
(MSI) 4.5

The MSI 4.5 or later is not included with the operating system. You
can download version 4.5 or later and install it from the Microsoft
Download Center.

Internet Information Services Version 7 (IIS 7.0)

This is included with the operating system. Use the Server Manager to add the Web Server (IIS) role service. See "How to Install
IIS" on page 61.

ASP.NET 4.0

This is included with the operating system. Use the Server Manager to add the ASP.NET role service. This is covered in the steps
for installing IIS.

Microsoft .NET Framework
4.5 (Recommended) or 4.0
(Minimum)

If you do not already have .NET framework 4.5 or 4.0, you can
download it from the Microsoft Download Center.
n

.NET framework 4.5 You can download it from:
http://www.microsoft.com/en-us/download/details.aspx?id=30653

n

.NET framework 4.0 You can download it from:
http://www.microsoft.com/en-us/download/details.aspx?id=17718
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WEB SERVER—PULSE SETUP PROGRAM
The Pulse setup program installs the Pulse application on the Pulse web server (this is the server
running IIS). Before running the setup program, you must you must make sure Microsoft
.NET Framework is installed.(See "Installing the Prerequisites for Windows Server 2008" on page
59).

WEB SERVER—MICROSOFT VISUAL C++ 2010 REDISTRIBUTABLE
The Pulse setup program requires the web server to be running the Microsoft Visual C++ 2010 Redistributable or a newer version.
This prerequisite is automatically installed when you run the Pulse setup program. The setup program automatically checks your system for a compatible version. If a compatible version is detected, you can quit the system check. If a compatible version is not detected, you will be prompted to
download and install it. See "Installing and Activating Pulse" on page 92.
IMPORTANT: Software vendors commonly redistribute different versions of Visual C++
with their programs. If your system is running more that one version of Visual C++, you do
not want to delete or uninstall any version from your system as doing so can render any
linked software programs inoperable.

WEB SERVER—RECOMMENDED BROWSERS
For best results, it is recommended that you use one of these web browsers when accessing the
web-based Pulse tools:
Browser

Version

Microsoft Internet Explorer

7 or later

Apple Safari

5

Mozilla Firefox

3.5 or later

Google Chrome

5.0 or later
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Pulse Database Server
The Pulse database server is the primary repository for Pulse data. This includes users, groups, files,
messages, videos, and images.

DATABASE SERVER—MINIMUM HARDWARE REQUIREMENTS
This table details the required hardware components for the Pulse Database server:
Component

Minimum Requirement (for Pilot)

Recommended (for Production)

Processor

32-bit, 4 core

64-bit, 4 core

Memory

4 GB

4 GB

Hard Disk

100 GB (for data drives)

100 GB (for data drives)

80 GB (for system drives)

80 GB (for system drives)

For daily operations, maintain at least twice as
much free space as RAM.

For daily operations, maintain at least twice as
much free space as RAM.
For every 1,000 users per
year, we recommend 100
GB for storage.
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DATABASE SERVER—OPERATING SYSTEM REQUIREMENTS
This table details the operating system requirements for the Pulse database server:
IMPORTANT: All of the latest Windows service packs and critical updates must also be
installed.

Requirement

Notes

Microsoft Windows Installer
(MSI) 4.5 or later

The MSI 4.5 or later is not included with the operating system. You
can download version 4.5 or later and install it from the Microsoft
Download Center.

Internet Information Services Version 7 (IIS 7.0)

This is included with the operating system. Use the Server Manager to add the Web Server (IIS) role service.

ASP.NET 4.0

This is included with the operating system. Use the Server Manager to add the ASP.NET role service. This is covered in the steps
for installing IIS.

Microsoft .NET Framework
4.5 (Recommended) or 4.0
(Minimum)

If you do not already have .NET framework 4.5 or 4.0, you can
download it from the Microsoft Download Center.
n

.NET framework 4.5 You can download it from:
http://www.microsoft.com/en-us/download/details.aspx?id=30653

n

.NET framework 4.0 You can download it from:
http://www.microsoft.com/en-us/download/details.aspx?id=17718

Microsoft Visual C++ 2010
Redistributable
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Not included with the operating system.
If the operating system is not running Microsoft Visual C++ 2010 or
newer, you are prompted to download and install it.
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DATABASE SERVER—SQL SERVER REQUIREMENTS
To give end users the ability to use the Pulse search features, you must install a supported version
of Microsoft SQL Server. The edition you install must support the full-text search feature. Please
refer to the documentation provided with SQL Server to determine if that edition supports full-text
search. See "Installing Microsoft SQL Server" on page 72.
IMPORTANT: Microsoft SQL Server Express Edition with Advanced Services is the only
Express edition from Microsoft that is compatible with Pulse. This is because Pulse requires
the full-text search feature.

IMPORTANT: Microsoft SQL Server Express with Advanced Services edition supports a
maximum database size of 10 GB. It is best suited when used in lab/test environments. It is
not recommended for production environments.
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Required Access Credentials and Networking Information
The user performing the installation will also need the following information in order to complete the
installation and configuration tasks:
Item
Active Directory
Domain
Account

DNS Entry

Requirements
Create a Domain Account with Local Administrator
Rights for the Pulse Server. This account will need:
n

A password that never expires

n

A valid email address in Active Directory

n

Read access to Active Directory

n

You should also grant this account System
Administrator (sysadmin) privileges in
SQL Server.

n

Resolves to the Pulse web server

n

Uses a fully qualified domain name

Purpose
Used by the PulseService
on the application server
to schedule notifications,
send emails, and deliver
posts.
Used by the Web Application Pool.

The URL that Pulse Administrators use to access
the Pulsedashboard.

Outbound
Email Settings
(SMTP Relay)

Port 25 (typical, depends on your network)

Gives Pulse the ability to
send outbound email messages.

Inbound
Email Settings

To enable reply-to email capabilities, you will need
settings for one of the following:

Required by Pulse web
server to provide reply-to
email capabilities.

n

POP3 host, username, and password
OR

n

Exchange Web Services URL,domain, username, and password for the Microsoft
Exchange account
OR

n
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Item
SSL Certificate for
Pulse Web
Server
(Optional)
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Requirements
If you plan to use the Secure Sockets Layer (SSL)
protocol to establish an encrypted connection with
your Pulse site, you must obtain an SSL certificate
from an SSL provider and install it on the Pulse web
server.

Purpose
Gives site visitors the ability to access your site
using the secure https://
protocol.
Use the Internet Information Services
(IIS) Manager to install
the SSL Certificate.
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Installing the Prerequisites for Windows Server 2008
Information for Network Administrators
To prepare for a Pulse installation, you need to prepare the systems that will be hosting the Pulse
server application and the Microsoft SQL Server instance for the Pulse database.

Before You Begin
In order to download and install the prerequisites, you need an Internet connection.
You also need the ability to log on the server(s) as a user who has access permissions to install software and change configuration settings on the system. This requires you to have access credentials for one of these accounts:
n

The Built-in Administrator Account for Windows Server This account has full administrative
privileges and is included with the operating system by default. See the person who installed
the server's operating system for the user name and password.
OR

n

A Local User Account with Administrative Privileges If available in your environment, you can
use a local administrator account. With a local administrator account, the server checks its
own files to authenticate the user and determine if they have the appropriate administrative
rights to install software on the system. This account is created on the server, typically by a
Network Administrator.
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Installing the Prerequisites
First, install Windows Server 2008 (SP2) on the system acting as the Pulse web server and Pulse
database server. Whether you are setting up a new server or just using an existing Windows server,
you should also ensure that the operating system is updated with all of the latest service packs, critical patches, and security updates from Microsoft.
If you are not familiar with how to install a server operating system, contact your Windows Administrator and/or Network Administrator for assistance. This will help to ensure that your server is in
compliance with any security and network requirements specific to your environment.
IMPORTANT: You must upgrade the operating system to Service Pack 2 (SP2) or later.

IMPORTANT: If you are not familiar with how to install a server operating system, contact
your Windows Administrator and/or Network Administrator for assistance. This will help to
ensure that your server is in compliance with any security and network requirements specific to your environment. See "Windows Server 2008 Requirements" on page 51.
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HOW TO INSTALL IIS
IIS provides the server hosting Pulse with web server capabilities and the ASP.NET framework,
which is a feature of the .NET Framework. It supports the creation of web pages and web services.
If you are setting up a new web server for Pulse, it is very important that you install IIS before
installing the .NET Framework.
In the Web Server (IIS) page, review the information. Then click Next
IMPORTANT: Always make sure that you are installing IIS on the system designated as
the Pulse server. If you are setting up a new server, IIS must always be installed before the
.NET Framework.

IMPORTANT: Do not run IIS on a domain controller or a backup domain controller.

NOTE: IIS is a built-in component of the Windows OS. For Windows Server 2008, the
OS lets you install IIS 7.0. You can only upgrade the IIS version if you upgrade the OS version.

1. Log in to the system that you selected to be the Pulse web server using one of these
accounts:
n

Built-in Administrator Account for Windows Server This account has full administrative
privileges and is included with the operating system by default. See the person who
installed the server's operating system for the user name and password.
OR

n

A Local User Account with Administrative Privileges If available in your environment, you
can use a local administrator account for the server. With a local account, the server
checks its own files to authenticate the log in and determine if the user has the appropriate administrative rights to install software on the system. This is different from a network domain account.
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2. Determine if the appropriate version of IIS is installed on the operating system.
a. Click Start > Administrative Tools and look for the Internet Information Services (IIS)
Manager menu command.
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b. Depending on whether or not the menu command is visible, select the appropriate
option:
n

If the Menu Command is Not Visible You need to install IIS.
OR

n

If the Menu Command is Visible Select the menu command to open the
IIS Manager window. Then choose Help > About Internet Information Services to
see the version number.
If IIS is already installed on the server, you can add a new web site in IIS to use with
Pulse.

3. If you need to install IIS on the server, add the Web Server (IIS) role service:
a. Click Start > Administrative Tools and select Server Manager from the context menu.
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b. In the left-pane under Server Manager, highlight Roles. Then in the right-pane under
Roles Summary, click Add Roles.

The Add Roles wizard opens.
c. In the Before You Begin page, click Next
d. In the Select Server Roles page, place a check mark in the Web Server (IIS) box. Then
click Next.

e. In the Web Server (IIS) page, review the information. Then click Next
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f. In the Select Role Services page, place a check mark next to all of the role services in
the list below. When finished, click Next.
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Select the desired services using the recommended role services listed below. Role services required by Pulse are marked with an asterisk (*).
Role Services Category
Common HTTP Features

Select These Role Service Check Boxes
*Static Content
Default Document
Directory Browsing
HTTP Errors

Application Development

*ASP.NET
.NET Extensibility
ISAPI Extensions
ISAPI Filters

Health and Diagnostics

HTTP Logging
Logging Tools
Request Monitor
Tracing

Security

*Basic Authentication
*Windows Authentication
Digest Authentication
Request Filtering

Performance

Static Content Compression
Dynamic Content Compression

Management Tools

IIS Management Console

IIS 6 Management Compatibility

*IIS 6 Metabase Compatibility

g. In the Confirm Installation Selections page, click Install. A progress indicator shows you
the status.
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h. After the "Installation Succeeded" message appears, click Close in the
Installation Results page.
i. Click Close to quit the Add Roles Wizard.
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HOW TO INSTALL WINDOWS INSTALLER 4.5
If the server is running Windows Server 2008 and if you plan to install Microsoft SQL Server 2008 R2
(Express Edition with Advanced Services), you must download and install the Windows Installer 4.5
Redistributable. Other supported editions of SQL Server do not have this requirement.
Run the installation package that is appropriate for your platform.
1. Determine which version of Windows Installer is running on the server that will host your Pulse
database:
a. In Windows Explorer, navigate to the System32 folder. Typically, the path
is: C:\Windows\System32.
b. In the Windows Explorer search field, look for the file named "msiexec.exe."
c. Right-click the file and select Properties from the context menu.

d. In the Properties dialog, click the Details tab.
e. In the field next to Product Version, ensure that your system is running Version 4.5 or
higher.
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f. Click OK to close the Properties dialog.
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2. Visit the Microsoft Download Center to get a copy of the installation package.
a. Visit the Microsoft Download Center at:
http://www.microsoft.com/en-us/download/details.aspx?id=8483
b. Scroll down the page and click Install Instructions. It is recommended that you read the
instructions before proceeding.
c. Click the Download button.
d. In the Choose the Download You Want page, place a check mark next to the appropriate box:
n

x86 Platform Windows6.0-KB942288-v2-x86.msu

n

x64 Platform Windows6.0-KB942288-v2-x64.msu

n

IS64 Platform Windows6.0-KB942288-v2-ioa64.msu

3. Run the installation package that is appropriate for your platform.

CHAPTER 2

70

WINDOWS POWERSHELL
Windows PowerShell 2.0 can be added via the operating system. You will use the Server Manager to
add this feature.
1. On systems running Windows Server 2008, log in to the server as an administrator.
2. Click Start > Administrative Tools and select Server Manager from the context menu.
3. Under Server Manager, highlight Features. The Add Features Wizard opens.
4. In the Features Summary page, click Add Features.
5. In the Select Features page, place a check mark next to the Windows PowerShell box.
NOTE: If the Windows PowerShell box is grayed out and unavailable, a message will
indicate that PowerShell is already installed.
6. In the Select Features box, click Next.
7. In the Confirmation box, review any informational messages. When ready, click Install. A progress indicator shows you the status of the installation.
8. In the Installation Results page, look for the Installation Succeeded message. Then click
Close.
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Installing Microsoft SQL Server
Information for Network Administrators
You can install a Microsoft SQL Server instance to use as the Pulse database. This instance can
reside on the Pulse web server (this is the server running IIS) or on a different system with access to
the Pulse web server.

Before You Begin
To begin the installation, log in to the server where you will be installing the SQL database instance.
You must use the appropriate access credentials:
n

Built-In Administrator Account for Windows Server This is the account that lets you run programs as an administrator, before a user account is created.
OR

n

Windows User Account with Local Administrator Privileges This account must have local
administrator privileges for the server.
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Installing SQL Server
You must install a supported version of Microsoft SQL Server:
n

Microsoft SQL Server 2012

n

Microsoft SQL Server 2008R2

n

Microsoft SQL Server 2008

You can use a full or express version of any of these, but the full version is recommended because it
can store more data.
Regardless of your operating system (Windows Server 2012, 2008R2, or 2008), you should be able to
use any of the versions of Microsoft SQL Server listed above. Following are general steps for all
three. For the most part, the steps are identical for each, though there may be some minor variations.
It is recommended that you apply all available service packs and critical updates to your operating
system prior to the installation.
IMPORTANT: If you are running Windows Server 2012 or are installing Microsoft
SQL Server 2012, be sure you have the most current version of Pulse. Microsoft SQL Server
2012 and Windows Server 2012 are not compatible with earlier versions of Pulse.
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HOW TO INSTALL MICROSOFT SQL SERVER
1. Obtain the installation media.
2. Log in to the server as an administrator.
3. Run the setup program from a CD or the network.

IF YOU ARE INSTALLING FROM A NETWORK
If the Do You Want to Run This File dialog appears, click Run.
If prompted by Windows User Account Control message asking if you want to allow the program to make changes to this computer, click Yes.
Depending on your specific environment, you may also be prompted for access credentials
to access the setup program on your network share.
4. For SQL Server 2008: If you are performing the installation on a system Windows Server 2008
R2, the Program Compatibility Assistant appears. Read the message and then click Run Program.
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5. In the Planning page of the Installation Center, review the information. When ready to proceed, click Installation in the left pane.
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6. For SQL Server 2008 R2 In the Installation page, click the New installation or add features to
an existing installation option.
For SQL Server 2008 and 2012 In the Installation page, click the New SQL Server stand-alone
installation or add features to an existing installation option.

If a dialog opens with a security warning, click Run.
The wizard checks the system to detect potential issues.
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7. In the Setup Support Rules dialog, do one of the following:
n

If the wizard finds any failed, warning, or skipped rules, click Show Details and/or click
View detailed report. Any failures must be resolved before proceeding. When resolved,
click Re-run to perform another system check.
OR

n

If wizard determines that the system passes the system check, click OK.

The wizard ensures that you have a valid product key.
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8. In the Product Key page, validate the SQL Server instance:
a. In the Product Key page, select the Enter the product key option.
b. Type your Microsoft license key in the box.

c. Click Next to open the License Terms page.
d. Place a check mark in the I accept the license terms box.
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e. (Optional) If you wish to send feature usage data, select the check box at the bottom of
the dialog.

f. Click Next. (If your system requires updates, you may see a page at this point showing
available updates. You can click the check box to include updates in the installation and
click Next.)
g. Depending on the version of SQL Server, you may need to click Install at this point. The
setup program performs a system check to detect potential issues.

CHAPTER 2

79

9. In the Setup Support Rules page, do one of the following:
n

If potential issues are found, click Show Details. You can also click View detailed report
for more information. Issues must be resolved before proceeding. When resolved, click
Re-run to perform another check.

OR
n

If the Setup Support Rules indicates the system has passed, click Next.

10. In the Setup Role page, choose the appropriate installation type. Then click Next to proceed.

HOW TO CHOOSE AN INSTALLATION TYPE
If you are not familiar with SQL Server, it is recommend that you choose the following:
a. Select SQL Server Feature Installation. This lets you choose the features to install.
b. Click Next to open the Feature Selection page.
NOTE: You will not see this step if you are installing SQL Server 2008.
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11. In the Feature Selection page, place check marks next to the desired features. Then click
Next.

HOW TO INSTALL THE MINIMUM REQUIRED FEATURES
At a minimum, you should:
Use the default shared feature directory.
a. Select these check boxes:
n

n

Database Engine Services
l

SQL Server Replication

l

Full-Text Search or Full-Text Search and Semantic Extractions for Search

Management Tools - Basic
l

n

Management Tools - Complete

SQL Client Connectivity SDK

SQL SERVER 2008/2008R2 EXAMPLE
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SQL SERVER 2012 EXAMPLE

b. Use the default shared feature directory.
c. Click Next.
The setup program checks the system for potential issues.
12. In the Installation Rules page, do one of the following:
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n

If any issues are found, click Show Details. You can also click View detailed report for
more information. Issues must be resolved before proceeding. When resolved, click Rerun to perform another check.
OR

n

If all of the system configuration checks have passed, click Next.

The Instance Configuration page opens.
NOTE: You will not see this step if you are installing SQL Server 2008.
13. In the Instance Configuration page, select one of these buttons:
n

Default instance If this is the first time SQL Server instance is being installed on the system, use the default instance name. This is typically MSSQLSERVER.
OR

n

Named instance If you do not want to use the default instance, select this button and
type a unique name in the Instance ID box. For example, type PULSE01.
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14. Click Next to open the Disk Space Requirements page and then:
n

If your system does not meet the disk space requirements, review the Disk Usage Summary and address any issues before proceeding.
OR

n

If your system meets the disk space requirements, click Next.

15. In the Server Configuration page, under the Service Accounts tab you must provision service
accounts to each listed SQL service. When finished, click Next.

HOW TO PROVISION SQL SERVICE ACCOUNTS

IMPORTANT: Always contact your SQL Server Administrator and/or Windows
Administrator for the appropriate service accounts to use in your environment.
a. Provision the appropriate accounts to the list of SQL services.
b. Make sure the Startup Type for each service is set as follows, depending on the version
of SQL Server:
Service
SQL Server
Agent

Account Name/Password
SQL Server 2008/2008R2 There is no default account
for this service. The account you use depends on
your security requirements.

Startup Type
Automatic

SQL Server 2012 This account defaults to NT Service\SQLAGENT$[Name of Instance].
There is no default account for this service. The
account you use depends on your security requirements.
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Service
SQL Server
Database
Engine

Account Name/Password
SQL Server 2008/2008R2 The account you use
depends on your security requirements.

Startup Type
Automatic

SQL Server 2012 This account defaults to NT Service\MSSQL$[Name of Instance].
The account you use depends on your security
requirements.

SQL Full-text
Filter Daemon
Launcher

SQL Server 2008/2008R2 This account defaults to
NT AUTHORITY\LOCAL SERVICE.

Manual

The account you use depends on your security
requirements. Microsoft recommends using a low
privilege account.
SQL Server 2012 This account defaults to NT Service\MSSQLFDLauncher$[Name of Instance].

SQL Server
Browser

The default logon account is
NT AUTHORITY\LOCAL SERVICE.

Automatic

You will typically keep this setting.
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SQL SERVER 2008 EXAMPLE
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SQL SERVER 2008R2 EXAMPLE

SQL SERVER 2012 EXAMPLE

16. In the Database Engine Configuration page, under the Account Provisioning tab (SQL Server
2008/2008 R2) or the Server Configuration tab (SQL Server 2012), choose one of these
options:
n

Windows authentication mode If you choose this option and are not logged in as an
administrator, it is recommended that you add an account that has sufficient permissions to perform all of the needed SQL administrative tasks. If you are logged in as an
administrator, it is recommended you also click Add Current User.
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SQL SERVER 2008/2008R2 EXAMPLE
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SQL SERVER 2012 EXAMPLE
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n

Mixed Mode (SQL Server authentication and Windows authentication) If you choose this
option, you must specify the password to use for the SQL Server system administrator
account.

When finished, click Next.
17. In the Error Reporting page, select whether or not you want to send error reports to Microsoft.
This is your preference. Then click Next.
18. In the Installation Configuration Rules page, do the following:
n

If there are issues, you must address them before clicking Next.
OR

n

If there are no issues, click Next.

19. In the Ready to Install page, click Install. A progress indicator shows you the status of the process.
20. When the installation is complete, you will see the "Installation Succeeded" message. Click
Close.
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NOTE: If a failure occurs, troubleshooting information may be available on the
MadCap Software knowledge base at: http://kb.madcapsoftware.com/

NOTE: You may also want to check with your SQL Server Administrator about any
errors you experience during installation.
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Installing and Activating Pulse
Information for Network Administrators
After preparing the Pulse web server and database server for the installation process, you can install
Pulse.

List of Pulse Components
The Pulse setup program installs the following components and features on your server:
n

Pulse Server Application This is the server application that you install on the Pulse web server.
Pulse Administrators use this tool to perform the initial server configuration.

n

Pulse Dashboard This is the web dashboard that Pulse Administrators use to view different
configuration settings and to manage the embedded discussion forms in the output.
Registered users can access the dashboard using the Pulse URL.

n

Community Tab and Embedded Discussion Forms This is the Community tab (optional) and
the embedded discussion form that integrates with your published Flare output. It gives users
the ability to share knowledge and expertise by posting status updates, asking and responding
to questions about topics, creating articles, and more.

List of Windows Service Applications
Pulse runs the following Windows service applications:
n

MadCap Pulse Management Service This service supports the Pulse application.

n

Pulse Service This service also supports the Pulse application.

n

RabbitMQ This service supports communication between IIS and SQL Server. It also monitors
the amount of RAM on the server. When free space becomes low, this service raises alarms
and block connections for the server.
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Installing the Pulse Server Application
Do the following on the web server (this is the server running IIS):

HOW TO INSTALL THE PULSE SERVER APPLICATION
1. Install the prerequisite software. See "Installing the Prerequisites for Windows Server 2012"
on page 22, "Installing the Prerequisites for Windows Server 2008R2" on page 41, or "Installing
the Prerequisites for Windows Server 2008" on page 59.
2. Install a Microsoft SQL Server instance for the Pulse database. See "Installing Microsoft
SQL Server" on page 72.
3. Obtain the installation media and a license code from MadCap Software:
n

CD Insert the installation CD.

n

Online Download the setup program using the link that you received from MadCap Software. .
NOTE: You can obtain the Pulse license code from your MadCap Software Sales Representative.

NOTE: You can create an unlimited number of Flare communities with your Pulse
license code.
4. Log on to the server running IIS using an account that has administrator privileges.
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5. Right-click the Pulse setup program and select Install from the context menu. This is the Windows Installer Package file named "SetupMadCapPulse.msi."

IF YOU ARE NOT LOGGED IN AS AN ADMINISTRATOR
If the Install context menu command does not appear, you are not logged in as an administrator. You can use the steps below to run the program as an administrator:
a. Navigate to the Pulse setup program. This is the Windows installer package named
"SetupMadCapPulse.msi."
b. Right-click the setup program and select Run as Administrator from the context menu.
c. If prompted by Windows User Account Control (UAC), click Yes or Continue.
d. If you are logged in with a different account, you may be prompted to enter the user
name and password for the administrator account. After entering the account information, click Yes.
6. When the Welcome page of the MadCap Pulse Setup Wizard appears, click Next.
7. Select the I Agree option to accept the terms of the license agreement. Then click Next.
8. In the Select Installation Folder page, browse to the desired installation folder or accept the
default folder. Then click Next.
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NOTE: To view a list of drives where you can install Pulse and to see the available/required space on the drives, click the Disk Cost button.

NOTE: To make the Pulse application available to any user who logs into the server,
click Everyone. To make the program available only to the logged in user account,
click Just Me.
9. In the Confirm Installation page, click Next. A progress indicator shows the status of the process.

IF YOU ARE PROMPTED TO INSTALL THE VISUAL C++ 2010 REDISTRIBUTABLE
If the Microsoft Visual C++ 2010 Redistributable is not installed on the server, a dialog will
prompt you to install it. Here is how you proceed through the system check:
In the Trial/Activation dialog, do one of the following in the Provide Your License Code field:
a. Place a check mark in the I have read and accept license terms box. Then click Install. A
progress indicator appears to show you the status.
b. If the following message appears, click Retry.
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c. Depending on your system, one of the following occurs:
n

If you do not have the correct distributable, you will be prompted to install it.

n

If the following message reappears, click Cancel. In most situations, this means the
setup program has detected a newer version of Visual C++ on your system and is
installing the required elements. The remaining steps show you how to proceed.

d. In the Installation Did Not Succeed dialog, click the log file link.
e. In the Installation Log, place a check mark in the Verbose box.
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f. Scroll down the log and determine if the operating system is running a newer version of
the redistributable:

NOTE: If you are running a newer version of the redistributable, you do not need
to install version 2010.
g. Close the Installation Log.
h. Click Finish in the Installation Did Not Succeed dialog.
10. In the Installation Complete page, click Close..

NOTE: After completing the installation, use Windows Update to run any available
.NET Framework updates on the server. For information about Windows Update, visit this
Microsoft link: http://windows.microsoft.com/en-us/windows/help/windows-update.
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Activating Pulse
After successfully installing Pulse, you must activate the product.

HOW TO ACTIVATE PULSE
1. Log on to the server running IIS using an account that has administrator privileges.
2. Launch the Pulse server application.

HOW TO LAUNCH THE PULSE SERVER APPLICATION
n

From the Desktop Hold down the Shift key and right-click to select MadCap Pulse from a
context menu. To use this method, you must be logged in as an administrator.
OR

n

On 64-bit Systems Double-click the Pulse.exe file. The path to this file is C:\Program
Files\MadCap Software\MadCap Pulse\Pulse.app\Pulse.exe.
OR

n

On 32-bit Systems Double-click the Pulse.exe fie. The path to this file is C:\Program Files
(x86)\MadCap Software\MadCap Pulse\Pulse.app\Pulse.exe.
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3. In the Trial/Activation dialog, do one of the following in the Provide Your License Code field:
n

Type the license code that you received from MadCap Software.
OR

n

Copy the license code from your download notification email and paste it into the field.A
check mark appears when you enter a valid code.

4. Click Next.
5. In the Enter Your Information page, type your name and email address in the fields provided.
6. Click Next.
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7. Select the desired activation method:
n

Internet Activation If you are connected to the Internet, select this option. If you are
behind a firewall, you may need to enter your Proxy Server information.

HOW TO ACTIVATE WITH A PROXY SERVER
a. If you are behind a firewall, place a check mark in the Use Proxy Server box:
b. Enter the required proxy server and authentication information for your network.
c. Click Next.
OR
n

Manual Activation To activate by email, select this option. Then enter the license code
and machine ID.

8. Click Next.
9. Copy and paste the activation code included in the email that was sent to the provided
address.
10. Click Next.
The system activates your product.

IF YOU ENCOUNTER ACTIVATION ISSUES
If you encounter an activation issue, an error message similar to the one below appears. Take
note of the error message text as it can help you troubleshoot the issue.
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Possible issues that might be encountered during the activation process include:
n

Entering an Invalid License Code Try re-entering your code to make sure it was typed correctly. If you have purchased other MadCap products, make sure the code you typed is
for the Pulse product.

n

Entering a License Code that Has Already Been Activated If Pulse has already been activated on another system, you will need to deactivate it before using the license code on a
different system.

n

Your System Cannot Communicate With the Activation Server The system where you are
installing Pulse is not able to communicate with the MadCap Activation Service. We suggest checking your network and Internet connection and after waiting a few minutes, try
to activate the product again.

n

You Must Use a Proxy Server If you are using the Internet Activation method, a notification message like the one below typically indicates that you will need to use a proxy
server to access external URLs. To obtain your proxy server information, see your Network Administrator. Then try to activate your product again. If you experience an issue,
theMadCap Software knowledge base has a helpful tip about registration behind a proxy
server: http://kb.madcapsoftware.com/default.htm#cshid=GEN1004Z

The Welcome page of the Pulse Configuration Wizard appears so you can configure Pulse for first
time use. See "Pulse Server Configuration" on the next page.
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Pulse Server Configuration
AVAILABLE TO: Administrators only
After the Pulse server application is installed on the Pulse web server, use the desktop shortcut or
the Programs menu in Windows to start the Pulse application.

Configuring Pulse for the First Time
After you install and activate the Pulse server application, the Welcome page of the MadCap Pulse
Configuration Wizard appears so you can perform an initial configuration.

HOW TO CONFIGURE PULSE FOR FIRST TIME USE
1. Install and activate Pulse as described in "Installing and Activating Pulse" on page 92.
2. If the MadCap Pulse Configuration Wizard is not already open, double-click the MadCap Pulse
desktop shortcut.
3. In the Welcome page of the MadCap Pulse Configuration Wizard, click Next.
4. In the Select Web Site page, do the following:
a. Select the Website for the Pulse Services Select the website on the IIS Server that will be
storing your Pulse data. By default, Pulse will use the "Default Web Site" in IIS.
b. Pulse Server URL This is the Site URL for the Pulse dashboard. Typically, it will consist of
the protocol (http:// or https://), the IP address (or the machine name), and the Pulse directory.
EXAMPLES
HTTP:
http://<ipaddress>/pulse
http://<servername>/pulse
Secure HTTP:
https://<ipaddress>/pulse
https://<servername>/pulse
c. Click Next.
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5. In the Select SQL Server page, do the following:
a. In the SQL Server drop-down list, select Get list of SQL Servers.
If the SQL Server Browser service is turned on, the program looks for all available
SQL Servers in the Windows domain.

HOW TO TURN ON THE SQL SERVER BROWSER
If SQL Server Browser service is turned off, use these steps to turn it on:
i. Start the SQL Server Configuration Manager.
ii. Select Start > Programs. Then point to your version of SQL in the menu and select
Configuration Tools > SQL Server Configuration Manager.
iii. In the left pane, highlight SQL Server Services.
iv. Right-click SQL Server Browser and select Properties from the context menu.
v. On the Service tab, set the start mode to Automatic and click OK.
vi. Right-click the SQL Server Browser again, and select Start.
b. In the SQL Server drop-down list, select the desired server. If instead you enter a server
manually, click Connect.
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NOTE: You can alternatively enter the IP Address or Computer Name of the
server in the SQL Server field. Use this format: <Server
Name>\<SQL Instance> or <IP Address>\<SQL Instance>
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IF YOU ENCOUNTER A CONNECTION FAILURE
If the SQL Server is not local (i.e., it resides of a different server than the Pulse web
server), it is common for users who might be less familiar with networking to experience
failures when the following is true:
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n

The SQL Server name and/or instance was entered incorrectly. You must enter the
correct server name and instance.

n

The account that you are using to perform the installation does not have sysadmin
permission on the SQL Server. See your SQL Server Administrator or Network
Administrator for the appropriate account to use.
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n

The SQL Server resides in an untrusted Windows domain. There must be a domain
trust relationship between the Pulse web server and SQL server hosting the Pulse
database. Make sure you selected the correct server.

c. If necessary, complete the authentication fields at the bottom of the page.
d. Click Next.
6. In the Database Options page, select one of the following options:
n

Create new This creates a new database instance with Pulse.
OR

n

Use existing Select this option only if you have previously installed Pulse. You may click
the Browse (…) button to open the Select Database dialog. Select the desired Pulse Database ID from the list. Then click Connect. Then click OK.

7. If necessary, in the Backup path for local SQL database field, you can click the browse button
and choose a location to store a copy of the current database. This field is only enabled if the
database has been using a previous version of Pulse. Also, it is not enabled if you are connecting to a database on a remote server.
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8. In the PulseAdmin Password box, specify the password for the default Pulse Administrator
account. Then click Next.
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IMPORTANT: Record this password in a safe place. This is the default PulseAdmin
account. You will need this information to log into the Pulse dashboard for the first
time. See "Pulse Dashboard" on page 185.

NOTE: As you type, the program lets you know when your password meets the minimum password strength thresholds, such as Very Weak, Medium, Strong, Very
Strong, and Excellent.
9. In the Configure SMTP page, enter your SMTP server settings:
NOTE: To get your SMTP server settings, see your Email or Network Administrator.

n

SMTP Server This is the IP address of the SMTP relay that accepts incoming requests
which is the host that will send outbound emails for Pulse.

n

SMTP Port This is the port number of the SMTP server handing outbound emails. This is
Port 25 (or the port number for your environment).

n

SMTP User Name This is the username of a valid account on the SMTP relay.

n

SMTP Password This is the password for the valid account on the SMTP relay.

n

From Address This is the from address for emails sent by Pulse. You must have a valid
address for this account. For example, type: PulseRegistration@example.com.

n

From Display Name This is the name that displays in email client applications for the
email address. For example, type: Pulse Registration.

n

Enable SSL A check mark in this box enables Secure Socket Layers (SSL) encryption. It is
recommended that you leave this box blank.
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NOTE: If you have content security requirements, purchasing an SSL certificate
for your web domain is suggested. This lets you enable SSL transport security, so
users can access your site via the https:// protocol. This ensures that the page
content that a URL points to is encrypted while the data is being transmitted to
your end user (so the content is not visible to others as it passes through the communication chain). See your Network Administrator for more information about
SSL.
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10. (Optional) Test your SMTP settings.
a. In the Configure SMTP dialog, click Test.
b. In the SMTP Test dialog, enter a valid address in the Email address box.
c. Click Send Test Email.
d. Depending on which message you see, do the following:
n

Test message has been sent Click OK. Then check the email account to ensure
you received the test email.

n

Error sending message Click OK. Ensure that you entered the correct
SMTP settings for your environment. Then try testing the settings again.

11. Click Next. The Verify Configuration page appears.
12. In the Verify Configuration page, review the components list. When you are ready to proceed,
click Next. A progress indicator shows you the status of the installation.
13. When the Configuration Complete page appears, you can click View Log or Save Log if you
want to see or save the results.
14. Click Finish.
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Starting the Pulse Server Application
When you start the Pulse server application, the system opens the Pulse Server Configuration window.

HOW TO START THE PULSE SERVER APPLICATION
1. Log in to the Pulse web server as an administrator.
2. Start the Pulse application by selecting one of these options:
n

Desktop Shortcut On the Windows desktop, click the MadCap Pulse shortcut. This is automatically added to the desktop at the end of the installation process.

n

Start Menu In Windows, click Start > All Programs > MadCap Software > MadCap Pulse.

n

Program Files Double-click the program icon in the Program Files directory. If you
installed the program using the default installation folder, it is located at one of these
paths:
l

l

On 64-bit Platforms C:\Program Files\MadCap Software\MadCap Pulse\Pulse.app\Pulse.app
On 32-bit Platforms C:\Program Files (x86)\MadCap Software\MadCap
Pulse\Pulse.app\Pulse.app

Here is the Pulse Server Configuration window:
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Setting the PulseAdmin Password
During the Pulse installation, you created a password for the default PulseAdmin account. You can
reset that password at any time.

HOW TO SET THE PULSEADMIN PASSWORD
1. Log in to the Pulse web server as an administrator:
n

Username The username is always "PulseAdmin" by default.

n

Password This is the password that you defined during when you installed the Pulse
server application.

2. Start the Pulse server application.
3. Select File > Set Admin Password.
4. In the Set PulseAdmin Password box, type a new password. Then click OK.
5. In the configuration dialog, click OK to acknowledge that your password was updated.
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Pulse Server Configuration Window
The Pulse Server Configuration window contains options that let you perform a variety of maintenance and management tasks.

GENERAL TAB
The controls in the General tab give you the ability to view and test the general connection settings
for the Pulse server application.
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User Interface
SQL Server

Description
Contains information about your Pulse database.

Name

A read-only field that shows the computer name of the SQL Server and the instance for the Pulse
database.

Databases

A read-only field that shows the Database IDs for the Pulse databases.

Test

Click this button to test the database connection settings.

Server

HOW TO TEST THE SQL SERVER SETTINGS
1. Launch the Pulse server application.
2. In the Pulse Server Configuration window, select the General tab.
3. In the SQL Server area, review the Server Name and Databases that were
configured during installation.
4. Click Test.
5. If the test is successful, the system shows a message indicating this.
6. Click OK to close the message.
Web Site

Contains information about the site running on your Pulse web server.

Location

Typically this reads Default Web Site.

URL

The URL for the Pulse dashboard.
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User Interface
View

Description
Click this button to open the Pulse dashboard in a web browser.

HOW TO VIEW THE WEB SITE SETTINGS
1. Start the Pulse server application.
2. In the Pulse Server Configuration window, select the General tab.
3. Click View.
4. Depending on your configuration, one of the following occurs:
n

If You are Able to View the Web Site If your web site settings is properly
configured, the Pulse dashboard appears in a separate browser window.
OR

n

Test

If You are Not Able to View the Web Site If your web site settings are not
properly configured, a "Pulse was not able to process your request
message" may appear.See "Pulse Installation Frequently Asked Questions" on page 163.

Click this button to test the web site settings.

HOW TO TEST THE WEB SITE SETTINGS
1. Start the Pulse server application.
2. In the Pulse Server Configuration window, select the General tab.
3. Click Test.
4. Depending on your configuration, one of the following occurs:
n

Web site test succeeded If your web site settings is properly configured,
the Web site test succeeded dialog appears.
OR

n
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Web site test failed If your test is not successful, an error message is
shown.See "Pulse Installation Frequently Asked Questions" on page 163.
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USERS TAB
The controls in the Users tab provides you with user counts and name information.
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User Interface
Groups

Description
Select one of the listed groups from the drop-down list.

HOW TO VIEW USER COUNTS AND INFORMATION
1. Start the Pulse server application.
2. In the Pulse Server Configuration window, select the Users tab.
3. From the Groups list, select one of these options:
n

All View counts and users for all administrative and registered users.

n

Administrators View user counts and member information for the Administrators group.

n

Customers View user counts and member information for members of
the Customers group

n

Employees View user counts and member information for members of
the Employees group

Count

A read-only field. Shows the total number of users for the selected group.

First Name

A read-only field. The last name of the user.

Last Name

A read-only field. The first name of the user.

Email
Address

A read-only field. A valid email address for the user.
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MAINTENANCE TAB
The controls in the Maintenance tab lets you manage the Pulseserver application's services. The
options that are available in this dialog depend on the version of Microsoft SQL Server being used:
n

If You are Using Microsoft SQL Server Express Edition with Advanced Services You have the
ability to view and start the Pulse Server and RabbitMQ service (these are both services that
run in Windows). You also have the ability to schedule database backups.

HOW TO SCHEDULE A BACKUP
This feature is available only when the Pulse database is using Microsoft SQL Server
Express Edition with Advanced Services.
Use the Maintenance tab to schedule backups of your Pulse database, whether it resides on
the local server or a different server on the network.
You can schedule a backup of your Pulse database on the SQL server on a daily or weekly
schedule. This saves your database information in a backup file (e.g., a file with the BAK file
name extension).
In the event that a database recovery is needed, your SQL Administrator can use SQL Server
Management Studio to restore your Pulse database using the latest backup file.
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IMPORTANT: For a backup to take place at the scheduled time, the Pulse web
server must be powered on and the MadCap Pulse Management Service and RabbitMQ service and must be running.
1. Start the Pulse server application.
2. In the Pulse Server Configuration window, select the Maintenance tab.
3. In the Location field, click Browse. Then, navigate to the directory where you want to
save the backup files. Important things to keep in mind:
l

l

Local Backup If you want to store the backup file (BAK) on the local system, the
default backup folder is : C:\Databases. This is the recommended method.
Network Drive If you want to store the backup file (BAK) on a network drive, select
the desired location.
NOTE: If you choose this method, the Pulse web server must have permission to write to the drive. In addition, the system drive must be
powered on and connected to the network at the scheduled backup time.

4. In the Day & Time fields, specify the desired backup schedule:
l

l

l
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Daily or Weekly Select either Daily or Weekly.
Day of Week If you select a Weekly backup schedule, you can also select the
desired day to perform the backup.
Time Select the time of day to perform the backup.
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5. As long as the listed Services are running, you will not need to click Start. In the event
that services stop running,simply click Start to restart the services and backup schedule.
WARNING: You do not have the ability to disable the MadCap Pulse Management Service or Rabbit MQ service. To function properly, the Pulse server
application requires these Services to run in the background.
6. Save your changes by selecting File > Save.
NOTE: If you do not save your changes, you will be prompted to save them
when you exit the application.

n

If You are Using a Different Edition of Microsoft SQL Server You have the ability to view the
status of and start the Pulse Service and RabbitMQ service. However, backups are not supported by Pulse. This is because the full versions of SQL provide administrators with several
options for creating full database backups.
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HOW TO BACKUP AND RESTORE DATABASES IN SQL SERVER
To learn how to backup and restore a database in SQL server, see the Microsoft SQL Server
web site at:
l

l

l

For SQL Server 2012 http://technet.microsoft.com/en-us/library/ms187048
(v=sql.110).aspx
For SQL Server 2008 R2 http://technet.microsoft.com/en-us/library/ms187048
(v=sql.105).aspx
For SQL Server 2008 http://technet.microsoft.com/en-us/library/ms187048
(v=sql.100).aspx
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Importing Feedback Data
If your company previously used the MadCap Feedback product, you can import information from
your existing Feedback database into the Pulse database.

WHAT GETS IMPORTED
The following describes what Feedback data is imported to the Pulse database:
n

Report Data All of the report data.

n

Comments All of the comments.

n

User Information All of the user account information, except passwords.

IMPORTANT: Feedback users do not have passwords. Their email address will serve as
both their user name and password (e.g., if you have a user with bob@example.com, his
password will now be bob@example.com). Users can change this password by clicking the
Forgot your password? link in any Pulse Account Login page.

HOW TO IMPORT FEEDBACK DATA
1. Launch the Pulse server application.
2. Click Import Feedback Data.
3. In the Select SQL Server and Database dialog, complete the following:
n

SQL Server The computer name of the SQL server.

n

Authentication The authentication method.

n

User name The account username.

n

Password The account password.

n

Database The SQL Server instance.

4. Click OK.
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Updating Pulse
You may periodically wish to check to see if there are updates for the Pulse server application to
download.

HOW TO UPDATE PULSE
1. Launch the Pulse server application.
2. In the toolbar, select Help > Check for Updates.
3. In the dialog that opens:
n

No Updates Available If not updates are available, simply click Close.

n

Updates Available If updates are available, highlight the update in the Download list. Then
click Download Updates.
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Uninstalling Pulse
You can uninstall the Pulse server and the application.

HOW TO UNINSTALL THE PULSE SERVER
When you use this method to remove Pulse, only the configuration information for the Pulse server
is removed. The existing Pulse database remains untouched by this process. It also leaves the Pulse
server application on the system, so you can reconfigure it at a later time.
When prompted to decide if you want to proceed, click Yes. The system removes all of the Pulse
server's configuration information.
1. Log in to the Pulse web server as an administrator.
2. Launch the Pulse server application.
3. In the toolbar, click the Uninstall Pulse Server button.

4. When prompted to decide if you want to proceed, click Yes. The system removes all of the
Pulse server's configuration information.
The next time you launch Pulse, you will need to activate and configure the server for first-time use.
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HOW TO UNINSTALL THE PULSE SERVER APPLICATION
If you want to completely remove the Pulse application from the server, use the Windows Control
panel.
1. Log in to the Pulse web server as an administrator.
2. Open the Windows Control Panel.
3. Under Programs, click Uninstall a Program.
4. In the Uninstall or Change a Program page, right-click MadCap Pulse and select Uninstall from
the context menu.

5. In the Programs and Features dialog, click Yes..
6. In the MadCap Pulse dialog, a list of applications related to Pulse appears. Review the list and
select Automatically close applications and attempt to restart them after setup is complete.
Then click OK. Windows begins removing the Pulse server application.
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Integrating Flare and Pulse
To integrate the embedded discussion forms and other Pulse features with your Flare output, add a
new community in Flare. This action automatically creates a new system in Pulse, allowing your
web server to host, store, and serve the embedded discussion forms that appear below the topics in
your Flare output. This system also gives you and your team members the ability to moderate and
administer the Pulse features and content from the Pulse dashboard.

Integration Options
If you are developing an online Flare target for a single product, service, or purpose, integrating Flare
is a straightforward process. You simply install Pulse and then add a new Flare community to create
a corresponding system in Pulse. However, because many organizations develop multiple Flare targets, you also have these options:
n

Add a Single Flare Community for Use With Multiple Targets In this scenario, you add one
Flare community which creates a corresponding Pulse system. Then you associate that community with multiple Flare targets. This method gives you less-granular reporting capabilities
in Pulse.

n

Add a Unique Flare Community for Each Different Target In this scenario, you add a unique
Flare community for each different target. This creates a separate system in Pulse. The
advantage of using this option is that it gives you more granular reporting capabilities, letting
you generate usage reports for each community.
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Enabling the Pulse Server
To give Flare the ability to interact with Pulse, you must supply the Flare community in the target
with the appropriate connection information and administrative access credentials for the Pulse
web server.

HOW TO ENABLE THE PULSE SERVER
1. Open the desired Flare project.
2. In the Project Organizer, open the desired WebHelp or HTML5 target.
3. In the Target Editor, select the Community tab.
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4. Enable the server as follows:
a. At the top of the Community tab, place a check mark in the Enable Pulse/Feedback
Server box.
b. In the URL field, type the URL for the Pulse web server.

NOTE: To find the URL, log in to the Pulse dashboard as an administrator. Then
select Administration > Settings > General Settings. The URL above corresponds
to the value in the Site URL box.

NOTE: If you have installed a Secure Sockets Layer (SSL) certificate on the
Pulse web server, ensure that the URL starts with the https:// protocol (instead
of http://). See "Windows Server 2012 Requirements" on page 14, "Windows
Server 2008R2 Requirements" on page 33, or "Windows Server 2008 Requirements" on page 51.
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c. Enter the access credentials as appropriate:
n

If this is the first time you are enabling the Pulse community in the Flare target, the
Log In dialog automatically appears.
OR

n

If you want to change the existing login information, click the Logout button to clear
the existing credentials. Then click Login. The Log In dialog appears.

d. In the Log In dialog, type the appropriate User name and Password. The account that you
use must have administrative permissions to Pulse. You have these options:
n

Use the PulseAdmin Account This is the default administrator account that was created by the person who installed Pulse.

n

Use an Account that is a Member of the Administrators Group This can be any
account belonging to a registered Pulse user who is a member of the Administrators
group.

e. Click OK or press Enter to close the Log In dialog.
f. Before you can save the Flare target, you must associate a Flare community with the
Pulse system.
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Setting Up the Community in Flare
After enabling the Pulse server in the desired target, you can set up the community in Flare. If you
are setting up Flare for the first time, you will add a new Flare community.

HOW TO ADD A NEW FLARE COMMUNITY
If this is the first time you are integrating Flare andPulse, add a new Flare community to your project's Flare target. This process automatically creates a new "system" on the Pulse server. In Pulse,
a system hosts the following items:
n

The activity streams that are used when moderating your topics with the Pulse dashboard

n

The embedded discussion forms that registered Pulse users can access in the Flare output

IMPORTANT: To integrate Flare content with Pulse integration, you must always add new
or use existing communities in Flare. While you have the ability to create systems using the
Pulse dashboard, you do not have the ability integrate those systems with a Flare community.

1. In the Community tab, locate the Communities list and then click Manage.

2. In the Manage Community dialog, click Add.
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3. In the Enter Name dialog, type a name for your community. In this example, we are creating a
community to use with a Flare target about Pets. Then click OK.

4. In the Manage Communities dialog, the new community appears. Click OK to close the dialog.
5. Click Refresh to update the Current Pulse Configuration info. This provides you with basic
information about the community, such as the status of the server, and the total number of
users.
After the community is associated with the Flare target, the Remap Topics button becomes available so you can map your community topics to Pulse for the first time.
You also have the ability to select an existing community, delete a community, provide a published
URL, and rename a community as follows:

HOW TO SELECT AN EXISTING FLARE COMMUNITY
If you need to publish any updates for your Flare output and do not wish to create a new community
for your documentation release, select the community that you previously created for the target.
This gives you the ability to ensure that any new, removed, and updated topics are mapped to the
appropriate embedded discussion forms in the Pulse system.
1. In the Community tab, locate the Community area.
2. From the Communities list, select an existing community.
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3. Click Refresh to update the Current Pulse Configuration info. This provides you with basic
information about the community, such as the status of the server, and the total number of
users.

NOTE: The Communities list in Flare initially only includes communities that have
been added with the Flare user interface. If you create Pulse systems using the Pulse
dashboard, those systems will be not be listed as Flare communities until you remap
the topics.

NOTE: You can associate multiple Flare targets with a single community if desired.
However, for best results with reporting, we recommend that you create a separate
community for each target. This will also simplify any mapping/remapping tasks
when you publish updates.

NOTE: If you want to verify that the Flare community you added is now a system in
Pulse, log in to the Pulse dashboard using an account that is a member of the Administrators or Employees group. The select Systems > Find Systems from the menu.
The community you created will appear in the list.
After the community is activated, the Remap Topics button becomes available so you can
remap the community topics to Pulse.
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HOW TO DELETE A FLARE COMMUNITY
If you want to delete a Flare community, use the steps below. This deletes both the Flare community and the Pulse system.
1. In the Community tab, locate the Communities list and click the Manage.

2. In the Manage Community dialog, select the community that you want to remove. Then click
Delete.
3. When prompted to confirm the delete action, click Yes. This removes your selection from the
Communities list.
4. Click OK to close the Manage Communities dialog.
5. Click Remap Topics and confirm the topics to remove.
6. Click
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HOW TO PROVIDE A PUBLISHED URL FOR A COMMUNITY
You can assign a URL path to your community from your Flare target. This can also be done from
the Pulse dashboard (by selecting Administration > Settings and clicking Communities), but using
the Flare target is recommended.
1. Under the Community area, click the Manage button.
2. In the Manage Communities dialog, highlight the community that you want to edit. Then click
Edit
3. In the Edit Community dialog, click in the Enter published url field and enter a path to the main
landing page of your Flare output.

When you enter a published URL path, make sure you include http:// at the beginning of the
URL.
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EXAMPLE
Let's say you've generated a target called "FlareOutput" and you've uploaded the
output so that users access it
here: help.mycompany.com/FlareOutput/Default.htm. In that case, enter
http://help.mycompany.com/FlareOutput in the Published Url field.
4. Click OK to close the Edit Community dialog. Click OK to close the Edit Community dialog.
5. Click OK to close the Manage Communities dialog.
6. Click

to save your work.

Why is it a good idea to assign a URL path to a community? Because it allows topic feeds to open in
context.
EXAMPLE
Let's say you have not provided a published URL for your community. You receive an
email notification stating that a user has posted a comment in one of your topics. So
you click the topic name link in the email notification to see the feed where the comment was posted. The feed opens in the dashboard view of Pulse, which shows only
the feed and not the topic associated with it.

On the other hand, let's say you provide a published URL to your community. In that
case, when you click the topic link, the topic opens in the actual Flare output. You see
both the topic and the Pulse feed below it, therefore giving context to the post.
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HOW TO RENAME A FLARE COMMUNITY
1. In the Community tab, under Current Pulse Configuration, click the Refresh button.
2. Under the Community area, click the Remap Topics button ensure your topics have been
mapped
3. Under the Community area, click the Manage button.
4. In the Manage Community dialog, highlight the community that you want to rename. Then
click Rename.

In order to add the embedded discussion forms to the Flare output that you will publish, you
must map/remap the community topics in Flare for Pulse.
5. In the Enter Name dialog, type a new name for your community. Then click OK.
This changes the name of the community in Flare, as well as the name of its corresponding
Pulse system.
NOTE: If an error message appears, try clicking the Refresh button and the remapping the topics. This typically resolves any issues.
6. Click OK to close the Manage Communities dialog.
7. Click
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Mapping/Remapping a Flare Community to Pulse
In order to add the embedded discussion forms to the Flare output that you will publish, you must
map/remap the community topics in Flare for Pulse.

HOW TO MAP A NEW FLARE COMMUNITY TO A PULSE SYSTEM
If this is the first time you are setting up a Flare community for a target, you will need to map the topics for your community to Pulse.
1. Make the desired changes to your Flare target. Always be sure to update the TOC before
remapping the topics.
2. In the Target Editor, select the Community tab.
3. From the Communities drop-down list, select the appropriate community.
4. Click Remap Topics.
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This opens the Remap Community Topics dialog.
5. In the Remap Community Topics dialog, make sure the New Topics tab is selected and review
the topics in the list.
EXAMPLE
A topic count appears in the label of the New Topics tab. The tab lists the topic
titles and paths to the topics. These items will be mapped to a corresponding
stream in Pulse. In a new community, the counts in the other tabs will typically be
zero (0).

6. When finished, click OK. The system automatically maps each community to a stream in
Pulse. The community updated message appears.
7. Click
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HOW TO REMAP A FLARE COMMUNITY TO AN EXISTING PULSE SYSTEM
As you prepare to publish content updates to a Flare target, you can review the new, removed, and
updated topics and then reassign any of the topics to the appropriate stream in the Pulse system.
This stream corresponds to the embedded discussion form at the bottom of the Flare topic.
1. Make your content changes in Flare. Be sure to make all of the desired updates in the Flare
TOC associated with your target.
2. Open the Flare target.
3. In the Target Editor, select the Community tab.
4. From the Communities drop-down list, select the appropriate community.
5. Click Remap Topics. This opens the Remap Community Topics dialog so you can review the
updates:

NEW TOPICS TAB
The New Topics tab lists Flare updates that have an effect on the Pulse mapping definitions:
n

New Topics New topics that have been added to the Flare TOC associated with the target.

n

Moved Topics Existing topics that have been moved to a different folder or location in
the Content Explorer.

n

Renamed Topics (New Name) Existing topics where the actual file name has changed.
The new file name appears in this tab.
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REMOVE TOPICS TAB
The Remove Topics tab lists Flare updates that have an effect on the Pulse mapping definitions:
n

Deleted Topics Topics that have been removed from the Flare TOC associated with the
target.

n

Moved Topics Existing topics that have been moved to a different folder or location in
the Content Explorer.

n

Renamed Topics (Former Name) Existing topics where the file name has changed. The
former file name appears in this tab.

UPDATE TOPICS TAB
The Update Topics tab only lists community topic updates that specifically relate to Pulse
mapping definitions. This includes topic updates such as title changes, reassigned links, and
so on.
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EXCLUDE TOPICS TAB
The Exclude Topics tab lists all topic files where Flare changes have no effect on the Pulse
mapping definitions.

When finished, click OK. The community updated message appears.
6. Review the topics in each tab and then reassign the links as desired. See below for instructions.
7. When finished, click OK. The community updated message appears.
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HOW TO REASSIGN A LINK
When you are preparing to publish content updates for a Flare target, there may occasionally be
times when you want to reassign a link that is associated with a community topic. This lets you take
the embedded discussion form associated with a topic and associate it with a different topic.
EXAMPLE
Let's say you have a topic with the file name, "Feeding_Cats.htm" and you decide to
rename it, "Feeding_a_Cat.htm." When you make this change, the Remap Community
Topics dialog will list this change in two places.
The New Topics tab will shown the new topic file name. If you click OK in the dialog,
the system would add a new stream for the topic in the Pulse system:

The Remove Topics tab will show the former file name. If you click OK in the dialog,
the system would remove the corresponding stream for the topic in the Pulse system:
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Instead of creating a new stream for the new topic named "Feeding_a_Cat.htm", let's
say you want to keep the discussion from the existing stream associated with "Feeding_Cats.htm." You can reassign the link to tie the discussion with the old file name to
the new file name.
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HOW TO REASSIGN A LINK
1. Make your content changes in Flare. Be sure to make all of the desired updates in the Flare
TOC associated with your target.
2. Open the Flare target.
3. In the Target Editor, select the Community tab.
4. Select the appropriate Flare community in the Community drop-down list.
5. Click Remap Topics. This opens the Remap Community Topics dialog so you can review the
updates. In this example, we've renamed a topic file from "Feeding_Cats.htm" to "Feeding_a_
Cat.htm."

6. In the New Topic tab, right-click the new topic and select Reassign Link from the context
menu.

This opens the Reassign Community Link dialog.
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7. From the Select Links drop-down list, select the desired topic. This will map the embedded
discussion form for the selected link with the topic. In this example, we will select the topic
formerly named, "Feeding_Cats.htm."

8. When finished, click OK. The community updated message appears.
When you republish your Flare target, the discussion originally linked to the former file is now
linked to the new file.
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HOW TO VERIFY THE COMMUNITY TOPICS IN THE PULSE SYSTEM
To see the community topics that have been created for your Flare output:
1. Log in to the Pulse dashboard with an appropriate user account.
NOTE: To access systems, you must be a member of the Administrators or Employees group.
2. In the menu bar, select Systems > Find Systems. The Find Systems page appears.
3. Under New Systems, click the Pulse system that corresponds to the appropriate Flare community.
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4. In the community page, click the Topics link.

5. In the list of topics, click a topic. Any community activity for the topic will be reflected in the
stream.
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Enabling the Community Tab in the Output
You need to decide whether you want to include or exclude the Community tab with your published
output. For HTML5 output, this can be done for Tripane skins only.
Below is an example of the Community tab:

You can enable or disable this feature by editing the general features of the skin associated with the
Flare target.
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The benefits of including the Community tab in your output include:
n

Gives site visitors the ability to register for a Pulse account. Also gives registered users the
ability to log in to Pulse directly from the Flare output.
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n

Gives registered users the ability to edit their profile, which includes changing their avatar
image, updating personal information, and modifying notification preferences.

NOTE: You cannot add a Community pane to Top Navigation or skinless HTML5 output,
because those outputs do not use panes. However, registered users can open the dashboard in a browser and access some of the features that are normally available in the Community pane in the Flare output (depending on the access level).
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Setting the Community Options—Comments and Search
Results
You can set community options, which control the display of comments and search results. For
both Standard and HTML5 skins, you can do this in the Skin Editor. For HTML5 outputs—including
skinless—you can also use your stylesheet to display or hide topic comments; this makes it possible
to show comments for some topics but hide them for others.

HOW TO SET THE COMMUNITY OPTIONS USING A SKIN
1. In the Project Organizer, open a Standard or HTML5 skin.
2. In the Skin Editor, click the Community tab. You have these options:

TO DISPLAY TOPIC COMMENTS
If you want registered Pulse users to have the ability to post comments in the embedded discussion forms that Pulse includes at the bottom of the Flare topics, place a check mark in the
Display topic comments at the end of each topic check box. This check box is selected by
default.

TO DISPLAY COMMUNITY SEARCH RESULTS
You can configure the Flare skin to give the Flare search engine the ability to index the Pulse
system and return any community results when end users perform searches.
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EXAMPLES
In HTML5 output, Pulse posts matching the search query are listed on the
Search Results page under a Community Results link:

If a user clicks the Community Results link shown above, only the matching
Pulse content appears in the results page:

CHAPTER 2

153

Users can then hover the mouse cursor over the content to reveal a links that
open either the matching Pulse post, the matching Flare topic and the matching Pulse post, or the Pulse user feed.

This feature works similarly in WebHelp output.

TO DISPLAY SEARCH RESULTS
a. Open a Standard or HTML5 skin.
b. Click the Community tab.
c. Place a check mark in the Display community search results box.
d. (Optional) In the Number of community search results field, you can enter the number
of community search results shown by default when a search is made in the output.
The default number in this field is 3.
NOTE: The Feedback area in the Community tab of the Skin Editor is only relevant to
Feedback Server Admin. The Feedback option is not supported by Pulse.

3. Click
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HOW TO SET THE COMMUNITY OPTIONS (DISPLAY COMMENTS) USING A
STYLESHEET
1. Open the stylesheet.
2. Find and select the html style or the appropriate class.
3. In the Show filter field, select Alphabetical List.
4. Find the mc-community-features property and set it to enabled or disabled. The default setting is "enabled."
5. Click

to save your work.

This stylesheet method can be especially useful if you only want some topics to display the comment area.
EXAMPLE
Let's say you create a Flare project and structure it in much the same way that some of
Flare's project templates are structured. In other words, you have a main Home page
that looks much different than the rest of your topics and serves primarily as a landing
page with links, not to provide content. Therefore, you do not want the Pulse comment
area to be displayed at the bottom of that topic.
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However, you do want the comments to appear at the bottom of all of your other topics.

You have two stylesheets—one for the Home topic and another for all the other topics.
So you open the stylesheet that is designated for the Home page and for a special html
style class you've created (called "HomePage"), you set the mc-community-features
property to disabled.
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Then you open the Properties dialog for that Home topic. You associate the topic with
the stylesheet and choose the HomePage style class.

As far as the other topics are concerned, they are using a different stylesheet. But you
don't need to set the mc-community-features property in it, because the default setting
is to enable the Pulse comments area. Therefore, the comment area will automatically
be displayed. The only thing you need to do is make sure all of those topics are using
the appropriate stylesheet.
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NOTE: If there is a discrepancy between the skin and the stylesheet setting (e.g., the skin is
set to disabled and the CSS is set to enabled), the stylesheet setting has precedence.

NOTE: Comments at the bottom of topics are not shown in tablet or mobile view. This is the
same case for HTML5 Tripane output.

NOTE: The comments area at the bottom of topics is wrapped in an iframe. Therefore, the
output is technically not entirely frameless. However, because it is only the comments that
are contained in the iframe, the main topic content still retains the benefits (e.g., better
search results) of frameless output.
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STYLES FOR GENERATED PULSE AND SEARCH TOPICS
Sometimes your output may display content that is entirely auto-generated, rather than pulling content from one of your topics. This occurs when search results are displayed. It also occurs if your
output is integrated with MadCap Pulse and a user clicks the Edit User Profile button, which then displays information on the Pulse home page, with no topic content shown.

STYLE CLASSES
For HTML5 Side and Top Navigation (and skinless outputs), you can add the following classes of the
html style to control the look of these generated pages:
n

pulseTopic This style class controls the look of a generated Pulse page (i.e., page opened via
the Edit User Profile button).

n

searchTopic This style class controls the look of a generated search results page.

n

templateTopic This style class controls the look of all generated pages and has precedence
over the other the pulseTopic and searchTopic classes.

EXAMPLE
Let's say you want Pulse-generated pages to show a yellow background. So you add a
class to html, name it pulseTopic, and set the background color to yellow.
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On the page showing search results, you want the background color to be light blue. So
you add a class to html, name it searchTopic, and set the background color to light
blue.

When you view those pages in the output, the background colors are just as you specified.
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But then let's say you add a class to html, name it templateTopic, and set the background color to light red.

As a result, the yellow and blue background colors will be overridden. Both kinds of generated pages will display with a light red background.

SUGGESTED STYLE SETTING
If you include a side menu—via a Menu proxy—that is not context-sensitive, this menu may display
on generated pages, not just in regular topics. This is probably something you want to avoid.
Therefore, to prevent this issue, you may want to copy the following to your stylesheet via the
Internal Text Editor.
html.templateTopic div.sideContent
{
display: none;
}

NOTE: These styles are supported only in HTML5 Top Navigation and skinless outputs.
They are not supported in HTML5 Tripane output.
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Building and Publishing the Flare Output
Once you set up the community features, you can build and publish your Flare output.
When building the output, you may see a message that states, "Some community features will not
be displayed in tablet and mobile outputs." This means that when users are viewing your responsive
output on a tablet or phone, they will not see comments or the Community tab. However, Pulse still
tracks hits on pages in those formats for reporting purposes. You can hide the warning if you do not
want to see it in future builds.
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Pulse Installation Frequently Asked
Questions
Following are some frequent questions about the Pulse installation and administration tasks.

General
Following are general frequently asked questions about the Pulse installation.

DO I HAVE TO HOST MY FLARE CONTENT ON THE PULSE WEB SERVER?
No. You can host the published Flare output on any server, computer, or location that has access to
your Pulse web server.

DO I NEED A SEPARATE LICENSE CODE FOR EACH FLARE TARGET THAT I PUBLISH?
No. Each Flare target can be set up to have its own Pulse community. With Pulse, you can create an
unlimited number of communities using the same license code.

HOW DO I INTEGRATE PULSE WITH MY FLARE CONTENT?
If you have installed Pulse, you can now open the Flare project and enable the Pulse features using
the Community Tab in the Flare target. See "Integrating Flare and Pulse" on page 126.
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Windows Installer
Following are frequently asked questions about the Windows installer.

WHAT VERSION OF WINDOWS INSTALLER DO I HAVE?
1. In the Windows Start menu, type Run in the Search Programs and Files box. Select Run from
the Program menu to open the Run dialog.
2. In the Open box, type system32. Then, press Enter or click OK.
3. Locate the file named "msiexec.exe."
4. Right-click the file and select Properties from the context menu.
5. Click the Details tab.
6. In the field next to Product Version, ensure that your system is running Version 4.5 or higher.
You should be running version 4.5.6001.22159 or greater. Most systems will be running version 5.0, which meets the minimum requirement.
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.NET Framework
Following are frequently asked questions about the .NET framework.

HOW DO I DETERMINE IF THE .NET FRAMEWORK IS ALREADY INSTALLED?
1. In the Windows Start menu, type Run in the Search Programs and Files box. Then select Run
from the Program menu to open the Run dialog.
2. In the Open box, type regedit.exe. Then, press Enter or click OK.
3. If you are prompted by the following User Account Control message. Click Yes to open the
Registry Editor.
4. In the Registry Editor, the following registry keys will be visible if the required versions are
installed:

IMPORTANT: When checking the information below, always make sure you are verifying the version numbers in the in "NET Framework Setup" directory and not the
".NET Framework" directory.
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n

For Version 4.0 Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\NET Framework Setup\NDP\v4\Full. You should see 4.0 or above in the Version row.
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n

For Version 4.5 Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\NET Framework Setup\NDP\v4\Full. The existence of DWORD in the Release row indicates that
.NET 4.5 or above is installed. The number shown in parentheses refers to a specific .NET
version (see http://msdn.microsoft.com/en-us/library/hh925568(v=vs.110).aspx).

SHOULD I INSTALL THE FULL PACKAGE OR CLIENT PACKAGE?
You should always install the full package when working with server applications. The full framework provides a number of features and assemblies that are not available with the client package.
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IIS
Following are frequently asked questions about IIS.

WHAT IS IIS?
Internet Information Services is a web service role that is enabled in the operating system to give
the system its web server capabilities. IIS must be installed on the computer that will be acting as
your Pulse web server.

HOW DO I DETERMINE IF IIS IS INSTALLED?
There are two ways to determine if IIS is installed on a system:

INSTRUCTIONS FOR USING THE WINDOWS CONTROL PANEL
1. Open the Windows Control Panel.
2. Click Programs.Then under Programs and Features click Turn Windows features on or off.
The Windows Features On or Off dialog appears.
3. Look for Internet Information Services.

INSTRUCTIONS FOR USING RUN COMMAND
1. Open the Start menu and choose Run.
2. In the Run dialog, type inetmgr Then, press Enter or click OK.
3. If the Internet Information Services (IIS) Manager appears, the program is installed.

CHAPTER 2

168

IIS IS ALREADY INSTALLED ON OUR SERVER. HOW DO I CREATE A NEW WEB SITE FOR
PULSE IN IIS?
When you install IIS for the first time, a "Default Web Site" is automatically created in the \inetpub\wwwroot directory on the web server. You can either use this default directory to publish the
Pulse content or you can create a new directory in the IIS file system by following these steps:
1. Click Start > Administrative Tools and select the Internet Information Services (IIS) Manager.
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2. In the Connections pane, right-click the Sites container and select Add Web Site.

3. In the Add Web Site dialog, type a name for your Pulse site in the Site name box. For example,
type Pulse
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4. In the Application pool box, make sure the desired application pool appears. In this example,
the default application pool is named Pulse.

NOTE: If you want to use a different application pool, click the Select button. Then,
choose the desired Application pool from the list and click OK.
5. In the Physical path box, type the physical path to the folder that you want to use as your content directory for Pulse. In this example, we created this folder structure: %SystemDrive%\pulsepub\wwwroot.
6. From the Type list, select the desired protocol. In this example, we selected http.
7. In the IP address box, type a static IP address.
8. Type a port number in the Port text box. The default port number is 80.
9. If you want to use a host name for your URL, enter it in the Host name box. In this example, we
are using pulse.example.com.
10. If you do not have to make any changes to the site, and you want the web site to be immediately available, place a check mark in the Start Web site immediately box.
11. Click OK.
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HOW DO I USE A HOST NAME FOR THE PULSE URL?
By default, the Default Web Site that Pulse uses to serve your dashboard content requires you type
<localhost>/Pulse to gain access your dashboard content. However, you can change the localhost
to a domain name, if desired.
EXAMPLE
Let's say that to access your Pulse dashboard content users must type:
http://127.0.0.1/Pulse/ in the browser address bar. Using the steps below, you
can change the host name to give users the ability to type: http://pulse.example.com.
1. Click Start > Administrative Tools and select the Internet Information Services (IIS) Manager.

CHAPTER 2

172

2. Right-click your Pulse web site and select Switch to Features View from the menu.

NOTE: In this example, we are using the Default Web Site for Pulse.
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3. In Features View, under the ASP.NET area, right-click Providers and select Bindings from the
context menu.
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4. In the Site Bindings dialog, highlight the appropriate protocol. In this example, we highlighted
the protocol http in the Type column.Then click Edit.

5. In the Edit Site Binding box, type the host name for your Pulse URL. For example,
type: pulse.example.com. Then click OK.
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6. In the Site Bindings dialog, click Close.

7. Select File > Exit to close IIS Manager.
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Pulse Setup Program
Following are frequently asked questions about the Pulse setup program.

DO I INSTALL THE .NET FRAMEWORK BEFORE PULSE?
Yes. The .NET Framework is a prerequisite for the Pulse setup program. If you do not install the
framework, a notification message similar to the following one will appear when you attempt to run
the Pulse setup program on the server:

You should click Yes in the error message. This will direct you to the Microsoft .NET Framework
(Web Installer) page in a new browser window, so you can download and install the framework.
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Pulse Server Application
Following are frequently asked questions about the Pulse server application.

WHY AM I SEEING THE "PULSE WAS UNABLE TO PROCESS YOUR REQUEST"
MESSAGE?
This message displays when you are attempting to log in to the Pulse dashboard.

When this message appears, first try refreshing your browser content. If the message still appears,
it typically means that IIS is not able to properly handle responses for the ExtensionlessURL
resources. This can quickly be resolved in Internet Information Services (IIS) Manager.
1. Log in to the Pulse web server as an administrator.
2. Click Start > Administrative Tools and select the Internet Information Services (IIS) Manager..
3. In the left pane, double-click the appropriate connection. Then double click Handler
Mappings.
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4. In the Actions pane, click View Ordered List

5. Look for these mappings in the Name column:ExtensionlessUrl-ISAPI-4.0_32bitExtensionlessUrl-ISAPI-4.0_32bitExtensionlessURL-Integrated-4.0
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6. Select each mapping individually. Then in the Actions pane, click Move Down until all of the
mappings are near the bottom of the list, just above StaticFile.

7. Close the IIS Manager.
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WHY AM I SEEING THE "WEB SITE TEST FAILED" MESSAGE?
If you encounter the "Web site test failed" message when testing your web site setting in the Pulse
Server Configuration window, it is recommended that you first ensure your Pulse web site is running
in IIS.
1. Log in to the Pulse web server as an administrator.
2. Click Start > Administrative Tools and select the Internet Information Services (IIS) Manager..
3. In the Connections pane on the left side of the window, expand the Sites container.
4. Locate your Pulse web site. In this example, the Pulse web site is the "Default Web Site."
5. Right-click the website and select Manage Web Site > Start from the context menu.

If your website is running successfully, we recommend returning to the Pulse Server Configuration
window in the Pulse server application. Then, test your website settings again.
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RabbitMQ
Following are frequently asked questions about RabbitMQ.

WHAT IS RABBITMQ?
The Pulse setup program installs a third-party tool, RabbitMQ. This runs as a Windows service and
supports communication between the Pulse web server (IIS) and the SQL Server hosting your Pulse
database.
RabbitMQ monitors the amount of RAM on the server, to raise alarms and block connections until
the alarm is cleared. This is helpful because it will assist you preventing the server from crashing
should free disk space get low.

WHERE IS THE RABBITMQ SERVICE INSTALLED?
The Pulse setup program installs the RabbitMQ tool at this path where Pulse is installed: C:\Program
Files (x86)\MadCap Software\MadCap Pulse\Pulse.app\Tools. Please note that this is just an
example. Your files might be in different folder than C:\Program Files (x86).
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Once installed, Pulse runs the RabbitMQ tool as a Windows service:
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User Administration
Following are frequently asked questions about user administration.

HOW DO I REMOVE A USER SO THEY CAN RE-USE THEIR EMAIL ADDRESS IN PULSE?
Deleting a Pulse user removes all access to Pulse and keeps the user information in the Pulse database. To give a user the ability to re-use the email address in Pulse, you must first delete the user
from the dbo.Users and dbo.Login tables in SQL Server. Once the entries are deleted, the email can
be used to create a new Pulse account.
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CHAPTER 3

Pulse Dashboard
The Pulse dashboard is the web-based interface to the Pulse system. Depending on your group
membership, authorized users can use the dashboard to configure a variety of server settings,
administer users and groups, moderate the Pulse content associated with your Flare output, and
access some basic end user features.
This chapter discusses the following:
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Dashboard Structure
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Using the People Menu
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Group Dashboards
The Pulse dashboard gives registered users the ability to view and gain access to different features
based on the group membership of their user account. See "Managing Groups" on page 251.
There are three levels of group access available:

ADMINISTRATOR DASHBOARD
Users who have been granted access privileges to the Administrator dashboard include:
n

PulseAdmin Account This is the default PulseAdmin user account. It is created during the initial server configuration and the person configuring the server sets the password. See "Pulse
Server Configuration" on page 102.

n

Members of the Administrators Group Registered users who are members of the Administrators group. See "Managing Groups" on page 251.

Members of the Administrators group have full access to all dashboard features and options. It is
recommended that you limit the number of members in the Administrators group. See "Managing
Users" on page 261.
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EMPLOYEE DASHBOARD
The Employee dashboard is available to registered users who have been added as members of the
Employees group in Pulse. See "Managing Users" on page 261 and "Managing Groups" on page 251.
This dashboard provides members with access to a variety of Pulse moderation features and all of
the customer-facing community features.
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CUSTOMER DASHBOARD
The Customer dashboard has limited access to features. It lets users edit their profile, view the general system status, view system notifications, and use messaging features.Users with access to
functions of the Customer dashboard include:
n

All Registered Users All registered Pulse users have access to the features that are available
in the Customer dashboard.

n

Members of the Customers Groups An Administrator can also explicitly add a user as a member of the Customers group. See "Managing Users" on page 261.

Because the Customer dashboard functions are limited, most organizations integrating a Pulse system with Flare encourage their end users to access Pulse directly from the Flare output. The embedded discussion forms and optional Community tab in the Flare output provide end users with the
richest community experience.
NOTE: By default, registered users who are not explicitly added to a group are granted the
same access privileges as members of the Customers group.
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Initial Dashboard Login for Administrators
If this is your first time logging in to the Pulse dashboard, you must log in with the PulseAdmin
account that was created during the initial server configuration. See "Pulse Server Configuration" on
page 102.

HOW TO INITIALLY LOG IN TO THE DASHBOARD
In a web browser, navigate to the Pulse Server URL.
If you do not know the Pulse Server URL:
1. In a web browser, navigate to the Pulse Server URL. If you do not know the Pulse Server URL:
a. Log in to the Pulse web server as the server administrator.
b. Double-click the MadCap Pulse desktop shortcut. The starts the Pulse application on the
server.
c. In the Pulse Server Configuration window, the Pulse Server URL appears in the Web Site
area in the URL box.
d. Click the View button to launch the Pulse dashboard.

2. In the Pulse Account Login page, do the following:
a. In the Email Address box, type: PulseAdmin.
b. In the Password box, enter the password that you created during the initial server configuration. See "Pulse Server Configuration" on page 102.
3. Click Login.
After logging in to the Pulse dashboard for the first time, you should create at least one administrator account before you start inviting users to join Pulse. See "Managing Users" on page 261.
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Dashboard Structure
The Pulse dashboard consists of several areas:
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MENU BAR
Across the upper-left of the Pulse dashboard is the menu bar. The menus and commands that are
accessible to you depend on your group membership. This table details the general availability of
the Pulse dashboard menus:
Menus
Pulse

Commands

Customers Group

Employees Group

Administrators Group

Home
Messages
Profile
Timeline
Logout

People

Find People
Followed by Me

Groups

Find Groups
Followed by Me
Owned by Me
Create Group

Tags

Find Tags
Followed by Me
Create Tags

Systems

Find Systems
Create Systems
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Menus
Administration

Commands

Customers Group

Employees Group

Administrators Group

Settings
Reports
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SYSTEM BAR AND SEARCH
Across the upper-left of the Pulse dashboard is the system notification bar. This area shows general
system status information, including notifications and messages. It also gives users the ability to
perform full-text searches of the posts and comments in the embedded discussion forms.

This table details the availability of the system bar and search functions:
Feature

Customers Group

Employees Group

Administrators Group

Status
Notifications
Messages
Search

PROFILE
The profile area of the Pulse dashboard shows the user's first and last name, profile avatar, and a
link to edit the user profile.
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YOUR APPS AND LISTS
The Apps area displays a list of Pulse applications. It lets users customize which apps display in the
personalized Your Apps menu. The Lists area displays items that the user adds to his or her list of
Favorites.

The following apps can be added to the Pulse dashboard. This feature is available to members of
the Administrators or Employees group.

CHAPTER 3

194

Your Apps

Description

Most
Recent 1

Shows your most recent posts.

Files

Upload files to share with others, and download files.

Messages1

Shows a list of all system conversations. This includes both chat messages and
email messages.

Notifications
1

Shows all of the notifications about system events. You can turn notifications on
and off by clicking Edit My Profile and then selecting the Notifications tab.

Moderation

View content that is pending (i.e., awaiting moderation).

Tasks1

Shows a list of tasks assigned to you.

Mentions1

Lists posts where you are mentioned.

Top News

Shows the top news.

Read it Later

Lists items you have marked to read later.

Statuses

Shows the latest updates posted to the selected feed.

Questions

Shows a list of all your posted questions.

Articles

Shows a list of all your posted articles.

Profile

Opens the Profile Editor.

1This

displays in the Your Apps list by default.
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STATUS UPDATES
This lets you post status updates, ask questions, create articles, and assign tasks to other
registered users.

SEARCH THIS FEED
The Search this Feed area lets users perform full-text search on the contents of the active system
feed. As shown below, matches to search queries are highlighted in bold text.

The Search this Feed area is powered by the Pulse search engine. The Pulse search engine restricts
its search to the system feed. It does not search your Flare content for matching topics.
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Using the Pulse Menu
AVAILABLE TO: Administrators, Employees, and Customers
In the Pulse dashboard, the Pulse menu provides all registered users with the ability to access general system and profile information.

Home
Select Pulse > Home to open your personalized Home page. The options available to you in
the Home page depend on your user account's group membership. See "Managing Groups" on page
251.
EXAMPLES
Home page options for members of the Administrators group:
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Similar options are available for members of the Employees group:
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Limited options are available for members of the Customers group:

Messages
Select Pulse > Messages to open the Messages page. This lets registered users create and send
messages to other registered users. See "Messaging Tasks" on page 352.

Profile
Select Pulse > Settings to open your Profile page. This lets you edit your profile and update your notification settings. The tasks that you can perform in this page are identical to the ones that you can
perform when editing your profile from the embedded discussions forms. See "Editing Your Profile"
on page 323.
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Timeline
Select Pulse > Timeline to open the Activity Timeline page. This shows a list of Pulse activity in chronological order. You can click the links at the top right-side of the page to limit the activity shown in
the timeline to the Past Year, Past Month, or Past Week. The posts with the most user activity
appear under Hottest Posts.

Logout
Select Pulse > Logout to quit the Pulse dashboard session.
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Using the People Menu
AVAILABLE TO: Administrators and Employees
In the Pulse dashboard, the People menu provides members of the Administrators and Employees
groups with the ability to find registered Pulse users.

Menu Commands
In the Pulse dashboard, there are two menu commands in the People menu:
n

Find People Select this menu command to search through the list of people in Pulse.

n

Followed by Me Select this menu command to search through the list of people that you follow.

Finding People
Use the following steps to find registered users.

HOW TO FIND PEOPLE
1. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
2. Select People > Find People. This opens the Find People page.
3. In the Find People page, the most recently created users appear by default. You have these
options:

HOW TO FILTER THE FIND PEOPLE LIST
Filter the Find People list by selecting one of these options from the drop-down:
n

New People Shows the most recently created users.

n

Most Followed People Shows the users with the largest combined number of followers
and tags.

n

Most Active People Shows the users with the greatest amount of activity.

n

Followed by Me Shows a list of users that you follow. If you are an Administrator or
Employee group, this is the same as selecting People > Followed by Me.

n

All People Shows a list of all registered Pulse users.
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HOW TO SEARCH FOR PEOPLE
In the Find People page, type a query in the Search field. Then press Enter. Matches appear in
the Find People page.
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Using the Groups Menu
AVAILABLE TO: Administrators and Employees
In the Pulse dashboard, the Groups menu provides members of the Administrators and Employees
groups with the ability to create and moderate special interest groups in Pulse.

Menu Commands
In the Pulse dashboard, the Groups menu contains the following commands:
n

Find Groups Select to find a specific group.

n

Followed by Me Select to see the groups that you are following.

n

Owned by Me Select to see a list of groups where you have been assigned owner permissions.

n

Create Groups Select this menu command to open the Create Group page.

Understanding Groups
You can create groups to communicate with a specific subset of users. This is helpful when you
want to use Pulse as a vehicle for sharing Pulse content with a specific audience. For example, you
might have a Flare community with a Pulse system for a project about pets and have a need to create separate groups for users with a specific interest in dogs or cats. This gives you the ability to
post updates and articles, as well as ask questions specifically targeted for those members.
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Finding Groups
Use the following steps to find groups.

HOW TO FIND GROUPS
1. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
2. Select Groups > Find Groups.
3. In the Find Groups page, the most recent groups display by default.

HOW TO FILTER THE FIND GROUPS LIST
You can filter the groups list by selecting one of these options from the drop-down list:
n

New Groups Shows the most recently created groups .

n

Most Followed Groups Shows the groups with the largest combined number of followers
and tags.

n

Most Active Systems Shows the groups with the greatest number of user activities.

n

Followed by Me Shows the groups in which you are currently included. If you are an
Administrator or Employee group, this is the same as selecting Groups > Followed by Me.

n

Owned by Me Shows groups where your permissions setting is set to Owner. If you are an
Administrator or Employee group, this is the same as selecting Groups > Owned by Me.

n

All Groups Shows all groups that exist in the Pulse database.

HOW TO SEARCH FOR A GROUP
To quickly find the group you are looking for, enter a query in the Search field in the upperright corner of the Find Groups page.

HOW TO CREATE A GROUP
To create a group, click the Create Group link at the bottom of the page.
4. Click on any of the groups to open the Groups page.
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Joining and Participating in Groups
You can join groups; chat with members; view recent updates, members, and tags; subscribe to
group feeds; and add feeds to your favorites.

HOW TO JOIN OR LEAVE A GROUP
1. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
2. Select Groups > Find Groups.
3. In the Find Groups page, click the desired group to open its page.
4. Depending on the option available to you, click the appropriate button:
n

Join this Group Click to become a group member.

n

Leave this Group Click to remove yourself as a group member.

HOW TO CHAT WITH GROUP MEMBERS
1. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
2. Select Groups > Find Groups.
3. In the Find Groups page, click the desired group to open its page.
Text
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4. Click

to start a group conversation.

5. In the Conversation with Group popup window, do the following:
a. Type a message in the Enter a message box.
b. If you want to add an attachment, click the attachment link.
c. Press Enter.

CHAPTER 3

206

HOW TO VIEW RECENT UPDATES
Click
to view recent updates to the group's feed. The number next to the Update link indicates the number of updates to the group.
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HOW TO VIEW GROUP MEMBERS AND TAGS
Click the Followers link to see a list of group members. The number next to the Follower button indicates the combined number of followers and tags for the group.
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HOW TO SUBSCRIBE TO A GROUP FEED
To subscribe to a group feed to receive updates by email, click the envelope icon. If you have not
already been added as a group member, you are added now.
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HOW TO ADD THE GROUP FEED TO YOUR FAVORITES
To add a group to your list of Favorites, click the heart icon.

You have these options and you can add group feeds to more than one list:
n

Add to Favorites List Place a check mark in the Favorites box to add it.

n

Create a New List Click +NewList to create a new favorites list. Then enter a name for the list
and place a check mark next to that list name.
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Creating Groups
Use the following steps to create groups.

HOW TO CREATE GROUPS
1. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
2. Select Groups > Create a Group
3. In the Create Group page, click the Basic tab and enter the appropriate group information:

HOW TO ENTER THE GROUP INFORMATION
a. In the Name field, type a group name.
b. In the Description field, type a short group description.
c. In the Audience field, select the desired audience. These settings correspond to the membership group permissions.
n

Employees Members of the Employees group can be invited to and join groups.

n

Employees and Customers Members of both the Employees and Customers groups
can be invited to and join groups.

d. (Optional) Place a check mark in the Moderation box if you want all group posts to be
approved by a moderator before being displayed. See "Moderating Posts" on page 361.
e. (Optional) Place a check mark in the Visibility box. The group will be visible to users who
perform a search for the group. If the check box is left blank, users must be invited to join
the group.
The check box "Allow Users to Find This Group" doesn't affect audience permission in the privacy tab.
4. Click the Privacy tab. Then do the following:

HOW TO ADD USERS AND GROUPS
a. Click the Add a user or group link.
b. In the Add a user or group box, start typing a user or group name. Matches appear in the
list.
c. Place a check mark next to the users or groups that you want to add as members.
d. Click Add.
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HOW TO REMOVE A USER OR GROUP
To remove a user or group from the membership list, click

next to the appropriate name(s).

HOW SET PERMISSIONS FOR GROUP MEMBERS
If you are the owner of a group, you can set access permissions for the group from the dropdown list:
Option

Description

Owner

Gives the user or group full access permissions to the group. Owners can
comment, post, add and remove content, adjust group settings, and add
group members.

Moderator

Gives the user or group access permissions to moderate (approve/reject)
posts and comments.

Contributor

Gives the user or group access permissions to post to the group.

Commenter

Gives the user or group access permission to comment on posts, but restricts
the user from creating posts.

Viewer

Gives the user or group access permissions to view posts and comments, but
restricts the user from any other type of group participation.

5. Click Create this Group
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Moderating Groups
If you are a group member who has been granted Owner permissions, you have the ability to moderate a group from the Pulse dashboard.

HOW TO INVITE PEOPLE TO A GROUP
1. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
2. From the menu bar, select Groups > Owned by Me.
3. In the Find Groups page, click the desired group to open its page.
4. Under the Invites area, click the Invite People link.

This opens the Invite People dialog.
5. In the Invite People dialog, you can invite people by doing the following:
a. In the Invite People dialog, click a user or group name in the box.
b. Place a check mark next to the users or groups to invite.
c. Click Invite.
d. If the people do not have access to the feed, click Grant Access.
This sends an invite to the person you added.
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HOW TO ADJUST THE GROUP SETTINGS
1. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
2. Select Groups > Owned by Me
3. In the Find Groups page, click the desired group to open its page.
4. In the group's page, click the Settings button.
5. In the My Group page, click the Basic tab and change the group information as needed:
a. In the Name field, type a group name.
b. In the Description field, type a short group description.
c. In the Audience field, select the desired audience. These settings correspond to the membership group permissions.
n

Employees Members of the Employees group can be invited to and join groups.

n

Employees and Customers Members of both the Employees and Customers
groups can be invited to and join groups.

d. (Optional) Place a check mark in the Moderation box if you want all group posts to be
approved by a moderator before being displayed. See "Moderating Posts" on page 361.
e. (Optional) Place a check mark in the Visibility box. The group will be visible to users who
perform a search for the group. If the check box is left blank, users must be invited to join
the group.
6. Click the Privacy tab.
7. In the Privacy tab, you can do the following:

HOW TO ADD USERS AND GROUPS
a. Click the Add a user or group link.
b. In the Add a user or group box, start typing a user or group name. Matches appear in the
list.
c. Place a check mark next to the users or groups that you want to add as members.
d. Click Add.
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HOW TO REMOVE A USER OR GROUP
To remove an existing user or group from the membership list, click
priate name(s).

next to the appro-

HOW TO SET PERMISSIONS FOR GROUP MEMBERS
If you are the owner of a group, you can set access permissions for the group from the dropdown list:
n

Owner Gives the user or group full access permissions to the group. Owners can comment, post, add and remove content, adjust group settings, and add group members.
Contributor Gives the user or group access permissions to post to the group.

n
n

Commenter Gives the user or group access permissions to comment on posts, but
restricts the user from creating posts.

n

Viewer Gives the user or group access permissions to view posts and comments, but
restricts the user from any other type of group participation.

8. When finished, click Save
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Joining Groups
If you add a member of the Customers group to a discussion group, those users do not have the ability to accept or deny invitations. However, if you are a member of the Employees group, you will be
notified and have the ability to join the group.

HOW TO JOIN GROUPS
1. If you have been invited to join a group, you will be notified by email and when you log in to the
Pulse dashboard.
2. Log in to the Pulse dashboard. Then click the
dashboard.

link in the upper-right corner of the Pulse

3. Open the group page by doing one of the following:
n

Click the group name.
OR

n

Click View all notifications to open the Notifications page. Then click the group name.

4. In the group's page, click the Join this Group button. This option is only visible to members of
the Administrators and Employees group.
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Using the Tags Menu
AVAILABLE TO: Administrators and Employees
In the Pulse dashboard, the Tags menu is available to members of the Administrators and Employees groups. Tags are used to organize information.

Using Tags
While tags can be created and applied to posts by any registered user (see "Tagging Posts" on page
345), members of the Employees and Administrators group also have the ability to create, follow,
and delete tags in feeds.
EXAMPLE
Let's say you want to create tags to apply to posts that talk about cats, fish, or nutrition.

When posts are tagged, members of the Employees and Administrators groups can
click a tag to view all of the posts with that tag.
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GROUP PERMISSIONS AND TAGGING OPTIONS
The table below details the tagging options that are available for members:
Feature

Customers
Group

Employees
Group

Administrators
Group

Create New Tags and Add Existing Tags to
Posts
Follow Tags
Create New Tags and Add Existing Tags to
Topic Feeds
Invite People to Follow a Tag's Feed
Subscribe to a Tag's Feed
Edit Basic Settings for Tags
Edit Privacy Settings for Tags
Create Parent and Child Tags
Change the Image Associated with the Tag
Delete a Tag from the System
Find Topic Leaders Based on Answers to
Tagged Questions
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Creating Tags
Tags can be created by any registered user. Keep the following in mind:
n

There is no limit to the number of tags that you can create in Pulse.

n

You can create tags up to 100 characters in length. However, tags are most effective when
limited to one or two keywords.

n

If you create a tag that contains multiple words, you do not need to separate the words with
an underscore.

n

There is no limit to the number of tags that can be applied to a post.

HOW DO YOU CREATE TAGS?
How you create tags depends on your group membership:
Group
Administrators

Pulse Dashboard
Use the Tags > Create Tag menu command.

Embedded Discussion Forms
n

Click the Tag link at the bottom
of a post.
OR

Employees

Use the Tags > Create Tag menu command.

n

Click the Edit link in the Tags
section.

n

Click the Tag link at the bottom
of a post.
OR

n

Customers
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HOW TO CREATE TAGS IN THE PULSE DASHBOARD
1. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
2. Select Tags > Create Tag.
3. In the Create Tag page, click the Basic tab. Then do the following:
n

Change the Tag Name In the Name field, you can enter a new tag name.

n

Change the Tag Description In the Description field, you can enter a new tag description.

n

Change the Tag's Profile Image You can click Change Image to open a dialog to select a
new image. Once you select an image, the Crop Your Image dialog appears. Select the
area of the image that you want displayed and click Crop and Save.

n

Delete the Tag You can remove the tag from Pulse by clicking Delete Tag.

4. Click the Privacy tab. Then set permissions for the tag as follows:

HOW TO CONFIGURE PRIVACY SETTINGS
You have a variety of options when configuring privacy settings:
n

Add Users and Groups You can add users by clicking Add a user or group. This opens
the Add a User or Group dialog. Do the following.
l

l

l

Enter the name of the user or group in the small field at the top of the dialog.
Names that already exist in the Pulse database will appear in the large field below.
Click the check box next to the name of the user or group you want to add in the
large field. You can then enter other names in top field and select different users or
groups if you need to.
Click Add.

n

Remove Users You can remove users by clicking

n

Set Permissions for Users Select the permission settings for each user. You can select
the following options:
l

l
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Owner Gives the user full access to the group. Owners can comment, post, add and
remove content, adjust group settings, and add users to the group.
Contributor Lets lets the user create group posts.
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l

l

Commenter Lets the user comment on group posts, but restricts the user from
posting content.
Viewer Lets the user view the group, but they cannot interact with it in any other
way.

5. At the bottom of the Create Tag page, click the Create this Tag button.
This opens a page that gives you different options for editing tag settings.

HOW TO CREATE TAGS IN THE EMBEDDED DISCUSSION FORMS
Tags can be created in two ways using the Pulse system that is integrated with the Flare output—
from the Tags section of the embedded discussion forms or by clicking the Tag link directly under a
post.

HOW TO ADD TAGS FROM THE TAGS SECTION OF A FEED
1. Log in to the Flare output using an account that is a member of the Administrators or
Employees group.
2. In the right column of an embedded discussions form, next to the Tags section, click Edit. A
field will appear displaying existing tag(s).

3. Enter a new tag and click Update.
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HOW TO ADD TAGS TO A POST
1. Log into the Flare output using a registered Pulse account.
NOTE: This is the only method that members of the Customers group can use to
create tags.
2. In the options below a feed post, click Tag.

3. In the Edit Tag dialog, enter a new tag name in the field. If you want to add multiple tags, separate each tag with a comma.
4. Click Update. The tag is created and the post is tagged with the selected tag. Click Update.
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Finding and Moderating Tags
Use the following steps to find and moderate tags.

HOW TO FIND AND MODERATE TAGS
1. Log in to the Pulse dashboard as an Administrator or Employee.
2. Select Tags > Find Tags.
3. In the Find Tags page, all of the tags in the Pulse system are listed. You can click one of the
tags to open its corresponding page.
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4. Depending on what you want to accomplish, do one of the following:

HOW TO SEARCH FOR A TAG
1. In the Find Tags page, type part or all of the tag name in the Search box and press
Enter.
2. Click the tag to open it in a new web page.

HOW TO FILTER THE TAGS ON THE PAGE
Using the drop-down list in the Find Tags page, you can narrow the tags that are viewable on
the page by selecting one of these items:
n

New Tags Shows the most recently created tags.

n

Most Followed Tags Shows the tags with greatest numbers of followers.

n

Most Active Tags Shows the tags with the greatest numbers of updates.

n

Followed by Me Shows the tags that you are following.

n

All Tags Shows all tags.

HOW TO FOLLOW A TAG
There are two ways for members of the Administrators or Employees group to follow a tag.

HOW TO FOLLOW A TAG FROM THE DASHBOARD
1. Log in to the Pulse dashboard as an Administrator or Employee.
2. Select Tags > Find Tags. Then open the desired tag's page.
3. Under the tag's image, click the Follow link.

HOW TO FOLLOW A TAG FROM A POST
1. In a web browser, navigate to your published Flare output.
2. Log in to Pulse as an Administrator or Employee.
3. In the embedded discussion form, hover the mouse cursor over a tag. A popup window
appears.
4. In the popup window, click Follow.
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HOW TO CHANGE THE TAG SETTINGS
1. Log in to the Pulse dashboard as an Administrator or Employee.
2. Select Tags > Find Tags. Then open the desired tag's page.
3. Click Settings.
4. Change the tag name, description, privacy settings, profile image, or manage parent
and child tags.

HOW TO VIEW TAG INFORMATION
In the tag's page you have other options that include:
n

View Updates Click Updates to view updates to the tag's feed. The number next to the
button indicates the number of updates to the tag's feed.

n

View Followers Click Followers to view a list of users and groups following the tag. The
number next to the button indicates the number of followers.

n

View the Following Click Following to view the users, groups, systems and searches the
tag is following.

n

Filter the Tag Feed Using the Your Apps Menu Use the Your Apps menu on the tag page
to filter the posts displaying in the tag's feed. For example, click Images to view only the
tagged images.

n

Find Topic Leaders Topic leaders are users who have answered questions that have
been tagged. To find a topic leader for a tag, go to the tag's page and click Find Topic
Leaders to open the ranking page.See "Finding Topic Leaders" on page 425.
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Using the Systems Menu
AVAILABLE TO: Administrators and Employees
In the Pulse dashboard, the Systems menu is available to members of the Employees and Administrators group. Members of the Employees group can find existing systems. Members of the Administrators group can both find and create systems.

Pulse Systems and Flare Communities
To integrate a Pulse system with the Flare output, you must first create a community in the Flare target (see "Integrating Flare and Pulse" on page 126). This action also creates a corresponding system in Pulse.
A Flare community always corresponds to a Flare target. If you publish more that one online Flare
target, you have these options:
n

Enable One Flare Community for All Targets This creates one Pulse system and Flare community to use with all of your Flare targets. It also lets you run reports for the entire community.

n

Enable a Unique Flare Community for Each Target This creates a separate Flare community
and Pulse system for each Flare target. The benefit to this approach is that it lets you run
reports for each community.
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Creating Systems and Communities
There are two ways to create a new system in Pulse to integrate with a Flare community. For the
best experience, it is recommended that you always create communities using the Flare Target
Editor:
Method

Description

Notes

Community
Tab in
the Flare
Target
Editor

When you add a Flare community to a target, that community is
automatically added as a system in Pulse. This gives members of
the Customers group the ability to post updates, questions, articles, and tasks in embedded discussion forms for your Flare output. Members of the Administrators and Employees groups can
also moderate these posts and other Pulse features using the
Pulse dashboard.

This is the
recommended
method.

Systems
If you decide to create a system in Pulse, it will require several
Menu in the extra steps on your part to integrate that system with Pulse.
Pulse Dashboard

See "Integrating Flare
and Pulse" on
page 126.
This method is
supported, but
not recommended.
See the instructions below.
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HOW TO CREATE A SYSTEM USING THE PULSE DASHBOARD

WARNING: If you create your new system using the Pulse dashboard, it will require several
extra steps on your part. This is why we recommend creating Pulse systems from the Community tab of the Flare Target Editor. See "Integrating Flare and Pulse" on page 126.

1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Open the Create System page using one of these methods:Select Systems > Create System.
Select Systems > Find System. Then click Create System at the bottom of the page.
3. Under the Basic tab, type the following for the system hub:Name The name of the
system.Description A short description about the system.
4. Click Create this System. This opens the new system's page in thePulse dashboard.
5. Select Administration > Settings. The Settings page opens.
6. In the Settings page, click Communities.
7. In the Communities page, click New. Then type the name of the system in the Name
box. Your entry must exactly match the system name you created earlier.
8. Click Save Changes. When prompted to confirm that you want to save all changes, click OKA
key for your new Flare community appears in the Communities list and a message confirms
that your changes have been saved successfully.
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9. Log out of the Pulse dashboard.
10. Open the Flare target.
11. In the Target Editor, select the Community tab.
NOTE: These instructions assume that you have already enabled the Pulse server
and entered your community login information. If this is not the case, see "Integrating
Flare and Pulse" on page 126.
12. Under Current Pulse Configuration, click Refresh.
13. Under Community, click Manage. Note that your new Pulse system/Flare community is now
listed in Flare.
14. Click Remap Topics.
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Configuring Systems
You can configure a variety of settings for a Pulse system.

HOW TO CONFIGURE THE BASIC SETTINGS FOR A SYSTEM
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Systems > Find Systems. Then click the desired system link to configure it. The system
page appears.

3. In the system page, click Settings. The system's Feed Settings page opens.
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4. In the Basic tab, define the general system settings. You have these options:
n

Change Image Click Change Image to upload an image file for your system. Adding an
image is a helpful way to distinguish between multiple systems.

n

System Name Change the name of the system. For best results and to ensure that your
Flare topics are properly mapped to the Pulse features, it is strongly recommended that
you always change the Flare community name. This will automatically change the System Name in Pulse.

n

Description Update the system description. If this is a Flare-integrated system, we recommend noting it in the description.

n

Audience Select the groups that are allowed to interact in the community. You can
select Employees and Customers, or just Employees.

n

Embed Signing If you have an embedded signing requirement for SSL, place a check
mark in this box. This is the default setting. Remove the check mark to disable the option.
To find out if your company has SSL requirements, see your Network Administrator.

n

Moderation Select this option if you want new posts to always require approval by a moderator. See "Moderating Posts" on page 361.

n

Certificate If you require a certificate for SSL, click Generate a new certificate. This creates a certificate file that you can download in the Personal Information Exchange (PFX)
file format. To find out if your company has SSL requirements, see your Network Administrator.
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5. Click Save.
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HOW TO CONFIGURE THE PRIVACY SETTINGS FOR A SYSTEM
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Systems > Find Systems. If you cannot see this menu, your user account does not
have sufficient permissions to find systems.
3. Click the appropriate system link. The system page appears.
4. In the system page, click Settings. The system settings are shown.
5. Click the Privacy tab. Use the controls in this tab to define the privacy settings for access to
the system. You have these options:

HOW TO REMOVE USERS AND GROUP
If you want to remove a user or group from the privacy list, click the
item.

next to the desired

NOTE: By default, Pulse will automatically add your user name and any groups that
your account belongs to as privacy settings for the system.

HOW TO ADD A USER OR GROUP
a. In the Privacy tab, click Add a user or group.
b. In the Add a User or Group dialog, do the following:
i. In the entry field, type the user or group name to add. This populates the list with
matching items from the Pulse database.
ii. Place a check mark in the box next to the desired user account or group name.
iii. Repeat these steps until you have added all of the desired users and groups.
c. Click Add.
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HOW TO SPECIFY USER AND GROUP PERMISSIONS
Next to each user group, select one of the following settings from the drop-down list:
Option

Description

Owner

Provides full access to the system and its feeds. They can comment, post,
add and remove content, adjust system settings, and add feeds.

Moderator

Provides users in the group with the ability to moderate (approve or reject)
new posts in the community.

Contributor

Provides users and group members with the ability to post content to the
system and its feeds.

Commenter

Provides users and groups members with the ability to comment on system
post and its feeds. This setting does not allow individuals to post content
themselves.

Viewer

Provides users and group members with read-only access to the system
and its feeds.

6. Click Save.
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Adding and Configuring System Feeds
You can add and configure system feeds in Pulse.

HOW TO ADD FEEDS TO A SYSTEM

IMPORTANT: If you use the instructions below to add feeds for a Flare community, you
must remap the topics in the Community tab of the Flare Target Editor. See "Integrating
Flare and Pulse" on page 126.

1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Systems > Find Systems. If this menu item is not available, your user account does not
have administrator permissions.
3. Click the appropriate system link. The system page appears.
4. In the system page, click Add Feed. This opens the Add System Feed page. Next, you must
configure the feed as described below.

HOW TO CONFIGURE A FEED
You can configure a variety of settings for a Pulse system feed.
Click Create this Feed. The feed is created and added to the system.
IMPORTANT: If you use the instructions below to configure feeds for a Flare community,
you must remap the topics in the Community tab of the Flare Target Editor. See "Integrating Flare and Pulse" on page 126.

1. Follow the steps above to add a new feed to a system.
2. In the Add System Feed page, enter the following information:
n

System Feed Name Type a name for the system feed (e.g., MadCap Software Blog).

n

Description Add a short description about the feed.

n

Source Select the source for the feed. You can select from a list of common formats for
content syndication. You have these options:RSS 2.0 or Atom 1.0 Feed This is the default
option. Microsoft CRM Pop3 Email Address Exchange Web Services Email Address
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n

Feed Format Select the format of the data for the feed. Choose one of the following
options.Text This is a text format for information interchange. Json Short for "JavaScrip
Object Notation." This is a text-based open standard for readable database interchange.
Jws Java Web Start. This is another means for information interchange.

n

Allow Impersonation This option determines whether the system can post messages to
the feed on behalf of the users in response to updates from the external source. Select
True if you want the system to make posts for the users. Select False if you do not.

n

Source URL Enter the source URL address of the feed you are adding to the system.

n

Poll Period (Minutes) This determines the amount of time in minutes that the system
waits in between polling the source for updates. Those updates are then added to the system feed.

n

Use Credentials Check this check box if you want this feed to require credentials. Clicking this check box causes three additional fields to appear. Use these fields to enter a
user name, password, and domain name to use for credentialing.

3. Click Create this Feed. The feed is created and added to the system.
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Finding Systems
Users who are members of the Administrators and Employees groups are permitted to find systems
in Pulse.
It is recommended that you rename communities within Flare, rather than within the dashboard. If
you rename a community via the Pulse dashboard, it will not automatically update within the Flare
target.

HOW TO FIND SYSTEMS
1. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
2. Select Systems > Find Systems. The Find Systems page appears.
3. The newest systems in the Pulse database will be displayed by default. You can search for a
system in the Search field in the upper-right corner of the page. You can also filter the systems by clicking the down arrow in the upper-left corner of the page and selecting from the following options.
n

New Systems Displays the most recently created systems.

n

Most Active Systems Displays the systems with the most user activity.

n

All Systems Displays all systems that exist in the Pulse database.

4. Click a system.
NOTE: You can also create a system in the Find Systems dialog by clicking Create
System.

IMPORTANT: It is recommended that you rename communities within Flare, rather than
within the dashboard. If you rename a community via the Pulse dashboard, it will not automatically update within the Flare target.
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Using the Administration Menu
AVAILABLE TO: Administrators only
In the Pulse dashboard, the Administration menu is available to members of the Administrators
group. With the commands in this menu, you have the ability to modify the Pulse web server settings or to run reports.

Pulse Database
In the Pulse dashboard, the Administration > Settings menu command is available to members of
the Administrators group. This gives administrators the ability to click Database to view connection
information for the Pulse database.

Viewing the Database Settings
Use the following steps to view database settings.

HOW TO VIEW THE DATABASE SETTINGS
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. Click Database. This opens the Database page.
TIP: We recommend that you keep a record of these settings in case you experience
an issue in the future.
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Understanding the Database Settings
The settings in Database page are pre-populated for you during the Pulse installation process.
These settings supply the Pulse web server with connection information for the Pulse database
server.
The table below details the settings in the Database page:
Because you create the database during the installation process, you will not use this feature.
Item

Description

Database
Type

This is the type of database being used for your Pulse data. It is always set to
Microsoft SQL Server.

Database
Server

This is the host name or IP Address of the Windows machine hosting the Pulse
database server.
This setting must always correspond to a valid host name or IP Address. To avoid
database connectivity issues, do not change the value in this field.

Database
Name

The name of the SQL database hosting your Pulse content.

Authentication
Type

Depending on your specific configuration, this will be set to Windows Login or
SQL Login.

Admin Username

This is the valid Active Directory account with Administrator privileges to the SQL
Server hosting Pulse.

Admin Password

This is the password for the Admin User Name detailed above.

Admin Domain

This is the Active Directory domain name.

Create Database

Because you create the database during the installation process, you will not use
this feature. See "Installing Microsoft SQL Server" on page 72 and "Installing and
Activating Pulse" on page 92.
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General Settings
In the Pulse dashboard, the Administration > Settings menu command is available to members of
the Administrators group. This gives administrators the ability to click Settings to view and update
general system settings for the Pulse web server.

Viewing the General Settings
You will not typically need to modify the information in the General Settings page. However, you
have the ability to both view and change the settings if needed.

HOW TO VIEW THE GENERAL SETTINGS
Select Administration > Settings. The Settings page opens.
Click General. This opens the General Settings page.
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. Click General. This opens the General Settings page.
TIP: We recommend that you keep a record of these settings in case you experience an
issue in the future.

Understanding the General Settings
The Pulse server and its settings are populated during the installation process. You can view the
general settings by selecting the Administration > Settings menu command and then clicking General. You can make changes to your settings you have special requirements for your environment.
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Setting
Site URL

Description
This is the URL that users

Typical Setting/Format

Additional Information

http://application.domain.com

This setting is pre-populated for

will enter in their web

you during the installation pro-

browser to gain access to

cess.

Pulse. In order for email

The site URL is used when it is

and other settings to work

different from the URL used dur-

properly, you must type the

ing the Pulse configuration. For

exact URL.

example, the user may have configured to an IP address, but now
the user is replacing that
IP address with a host name.
It is important to ensure that the
Site URL exactly matches the
DNS entry for your Pulse server.
The Site URL is also included in
outbound email notifications.

Restricted Word

Click Show to reveal an

blank

Typically, this is left blank. Your

List

entry field where you can

environment may have a dif-

type any words you would

ferent requirement. If you

like to restrict from use in

choose to create a word list,

end user posts.

always use comma-separated
text.

Customer

Place a checkmark in this

checkmark=enabled

Groups

box to allow external users.

environment may have a dif-

This allows the Admin-

ferent requirement.

istrator to disable the

Typically, this is selected. Your

A checkmark grants external

embedded discussion

users (i.e., Customers) access to

forum for any users who

Pulse. Remove the checkmark to

have not been granted

revoke access.

Administrator or Employee
privileges. See "Managing
Users" on page 261.
Group Sync

Place a checkmark in this

checkmark=enabled

box to enable group sync.
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Setting
SMTP Host

Description
This is the hostname or
IP address of the SMTP
relay that accepts incoming
requests which is the host

Typical Setting/Format
exchange01
or

Additional Information
Obtain this information from
your company's Email Administrator.

smtp.example.com

that will send outbound
emails for Pulse.
SMTP Port

SMTP SSL

This is the port number of

25

Typically, the port number is 25.

the SMTP server handing

Your environment may have a dif-

outbound emails.

ferent requirement.

Place a checkmark in the
box to enable Secure Sockets Layer (SSL).

checkmark=enabled
blank=disabled

disabled. Your environment may
have a different requirement.

SMTP User-

Type the user name of a

name

valid account on the SMTP

your company's Email Admin-

relay.

istrator.

SMTP Password

Type the password for the

pulse@example.com

Typically, this feature is

<password>

Obtain this information from

Obtain this information from

valid account on the

your company's Email Admin-

SMTP relay.

istrator.

Incoming Mail

Select the type of incoming

Server Type

email server to use.

POP3
Exchange Web Services

Obtain this information from
your company's Email Administrator.

Poll the Local SMTP Drop
Folder
Incoming Bad

Enter the path of the local

Mail Folder

server folder to hold raw
incoming messages that
have failed processing.

POP3 Host

Enter the name or IP

pop3.gmail.com

address of the POP3 host.
POP3 Username
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Setting

Description

POP3 Password

Enter the POP3 password.

POP3 Poll Task

Enter the POP3 poll task fre-

Frequency in

quency in minutes. This

Minutes

determines how often

Typical Setting/Format

0=off

Additional Information

1 is the recommended setting.

1=1 minute

incoming mail is pulled.
POP3 Enable

Place a checkmark in the

SSL

box to enable Secure Sockets Layer (SSL).

checkmark=enabled
blank=disabled

Static

Use of this feature depends on
company policy. We recommend
leaving it unchecked.

Notification

Set this to a single email

Typically, this will be static. Your

Email Type

address that does not

environment may have a dif-

change.

ferent requirement.
Pulse supports three types of
email notifications: static,
domain, and plussing.
n

Static For a single email
address that doesn't
change, and no support
for posting to a group via
email.

n

Domain If you have a
whole domain you'd like
Pulse to control.

n

Plussing If you have one
email address you'd like
Pulse to manage but
would like to be able to
post to groups via email.

Notification

Type a single email address

Email Address

from which notifications

gistration@example.com (where

and registration emails are

example = your domain name).

sent.

Your environment may have a dif-

accountname@example.com

Typically, it is PulseRe-

ferent requirement.

CHAPTER 3

243

Setting

Description

Typical Setting/Format
Pulse Notifications

Additional Information

Notification

The name that you want to

Email Display

appear as the sender in

want to appear in messages

Name

email notifications sent by

from the Notification Email

Pulse.

Address.
0 (off)

This defines the name that you

Activity Purge

The frequency at which

Task Frequency

Pulse will run message

Typically, this feature is
disabled. Your environment may

in Days

archive task. When mes-

have a different requirement.

sages reach the age
defined in the Message
Archive Task Max Message
Age in Day field, Pulse
archives the messages and
they will not display any
longer in the user's task
pane. 0=off, 1=1 day,
2=2days, etc.
Activity Purge

The maximum age a mes-

180

Typically, this is set to 180. Your

Task Max Mes-

sage can be until it is

environment may have a dif-

sage Age in

archived. After the estab-

ferent requirement.

Days

lished days, all messages
will be archived and will
not display any longer in
the user's messages pane.

Account Sync

The number of minutes the

Period

authentication providers

environment may have a dif-

will sync with Pulse.

ferent requirement.

Always Use SSL

Place a checkmark in this
box to redirect calls for
http:// to https://.
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checkmark=enabled
blank=disabled

Typically, this is set to 0. Your

Typically, this feature is
disabled. Your environment may
have a different requirement.
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Setting

Description

Typical Setting/Format

Additional Information

Windows Auto

Define the range of IP

0.0.0.0-10.10.10.10 (or the IP

Typically, this field is left blank.

Login IP Ranges

addresses that will be per-

range for your environment)

Your environment may have a dif-

mitted to automatically

ferent requirement.

login to Pulse using windows credentials. If a user
attempts to login from an
IP address outside of the
defined range, Pulse will
prompt for credentials.
Mobile Client

Place a checkmark in this

Persistent

box to enable mobile client

Login

persistent login.

checkmark=enabled
blank=disabled

When this feature is enabled
Pulse mobile clients will remember user login information. If this
feature is disabled, users will be
required re-login after 60
minutes of inactivity.

Video Encoding

Place a checkmark in this
box if you have setup an
encoding server. When this

checkmark=enabled
blank=disabled

Typically, this feature is
disabled. Your environment may
have a different requirement.

feature is enabled Pulse
can support additional
video formats (.mov, .3gp,
.wmv, .avi) in addition to
MP4. Requires a licensed
copy of Microsoft Expression Encoder or Handbrake.
Log Retention

Specify the number of days

30

The default value is 30. Your

to retain the error message

environment may have a dif-

log on the server.

ferent requirement.

Content Pur-

Place a checkmark in this

ging

box to enable content purging.

checkmark=enabled
blank=disabled

When content purging is
enabled, any content that is
marked as deleted will be permanently deleted from the database.
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Setting

Description

Direct Mes-

Select where direct mes-

saging

saging should be enabled
in Pulse.

Typical Setting/Format

Additional Information

Off
Users and Groups
Users Only

Files

Select where files should
be enabled in Pulse. See
"Files" on page 381.

Off
Users and Groups
Users Only
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Incoming Mail Server Type Settings
The Pulse web server can connect to a mail server using one of these methods:

POP3 MAIL SERVER SETTINGS
These settings give the Pulse server to use Post Office Protocol Version 3 (POP3) to collect incoming email (i.e., email replies to Pulse notifications):
Setting
POP3

Description
Type the name of the host.

Host

Typical Setting/Format
pop3.example.com
or

Additional Information
Obtain this information from your
Email Administrator or POP3 Service
Provider.

10.10.18.222
POP3

Type the username of a valid

Username

account.

POP3

Type the password for the

Password

account.

POP3 Poll

This defines how frequently

Task

incoming mail is pulled by

accountname@example.com

<password>

1

This is set to 0 by default. It is recommended that you set the value to 1.

the server.
POP3

Place a checkmark in the box

Enable

to enable Secure Sockets

box blank. Your environment may

SSL

Layer (SSL).

have a different requirement.
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EXCHANGE WEB SERVICES
These settings give the Pulse server the ability to connect to Microsoft Exchange Web Services for
incoming email (i.e., email replies to Pulse notifications):
Setting
EWS URL

Description
Type the URL for your
Exchange Web Services endpoint.

Typical Setting/Format
https://mail.mycompany.com/ews/exchange.asmx
mail.us.example.com
mail.emea.example.com

EWS
Domain
EWS
Username

Type the domain name for your

CORP

Exchange Web Server.
Type the username of a valid
account. For example, enter the
username of an account that

Additional
Information
Obtain this
information
from your
Email Administrator or
EWS Provider.

accountname@example.com
PulseRegistration@example.com

has an Exchange inbox. This
account should not be a real
user’s account. Additionally, the
account name is usually how
your name appears in emails
sent from this email configuration.
EWS
Password

Type the password for the
account.

<password>
p@ssword1

EWS Poll

This defines how frequently

1

This is set to

Task

incoming mail is pulled by the

0 by default. It

server.

is recommended that
you set the
value to 1.
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POLL THE LOCAL SMTP DROP FOLDER
These settings give the Pulse server the ability check the SMTP areas of Internet Information Services (IIS) for incoming email (i.e., email replies to Pulse notifications):
Setting

Description

Typical Setting/Format

Additional Information

SMTP Drop

The path to the local message

C:\Inetpub\Mailroot\Drop

This server must exist on all

Folder

store on the SMTP server

Folder Poll Task

This defines how frequently

Frequency in

incoming mail is pulled by the

is recommended that you

Minutes

server.

set the value to 1.
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Configuring the Auto Login for Internal Windows Users
Click General.
This opens the General page. In the Windows Auto Login IP Ranges box, enter one of the following:
n

An IP Address Range For example, type: 10.0.0.0-10.255.255.255. This permits all IP
addresses within that range to log on automatically.

n

Multiple IP Address Ranges If you have multiple ranges, separate each range with a comma.
For example, 0.0.0.0-10.10.10.10,192.168.0.0-255.255.255.255.

If you are using Active Directory to control access to Pulse, you can configure the Windows Auto
Login IP Ranges feature. This gives individuals the ability to log into servers and workstations in the
defined range, and automatically logs them into Pulse using their windows credentials.
NOTE: To use this solution, you will need a valid IP address range or list of valid IP
addresses to work with.

HOW TO CONFIGURE THE AUTO LOGIN FOR INTERNAL WINDOWS USERS
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. Click General. This opens the General page. In the Windows Auto Login IP Ranges box, enter
one of the following:An IP Address Range For example, type: 10.0.0.0-10.255.255.255.
This permits all IP addresses within that range to log on automatically. Multiple IP Address
Ranges If you have multiple ranges, separate each range with a comma. For example,
0.0.0.0-10.10.10.10,192.168.0.0-255.255.255.255.
4. Click Save.
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Managing Groups
As an Administrator, you can manage groups in several ways.

IMPORTANT: The Groups menu in the dashboard deals with groups that are different from
those accessed from the Administration menu.

Group Types
When you install Pulse, the system automatically creates these predefined permission
groups: Administrators, Employees, and Customers.
Default Group
Name

Description

Administrators

Members of this group have the highest level of permissions.

Employees

Members of this group have fewer permissions than Administrators, but more
permissions than Customers.

Customers

Members of this group have fewer permissions than Administrators and Employees

You may want to add new groups to manage membership permissions on your server.
EXAMPLE
Let's say your company develops a software product. As part of your company's sales
efforts, there are individuals outside your organization who sell your products either as
part of a solution or as part of a referral program. In this scenario, you may want to create separate groups named "Solution Providers" and "Referral Partners" and give each
group Employee permissions.
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Group Access Permissions
This table details the access permissions for the default Pulse groups:
User Activity

General Public

Customers
Group

Employees
Group

Administrators
Group

Register for a New Account (One
Account Per Email Address)
Read Access to Posting Activities in
Topic Feeds
Search Posts in Topic Feed
Click a Star to Rate Topics
Edit User Profile
Upload Profile Image
Update Notification Preferences
Post Status Updates to Topics
(Includes Options to Share a Video,
Image or File)
Post Questions in Topic Feeds
Post Answers to Questions in Topic
Feeds
Like/Dislike/Vote on Answers to
Questions in Topic Feeds
Post Articles in Topic Feeds
Add Comment, Like, Follow, and Tag
User Posts
Subscribe to Topics
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User Activity

General Public

Customers
Group

Employees
Group

Administrators
Group

Delete and Edit Your Own Content
Assign Tasks to Yourself or Other
Registered Pulse Users
View Task Assignments by Status
Customize the Your Apps list in the
Community Tab
Mention and Message Other Users
Designate Topics as Favorites
Add Topics as Favorites
Contact and Mention Other Users
Filter and View Content (Including
Comments, Images, and Files)
Create Groups for Audiences
(Employees and Customers)
Delete Content Added by Other
Users
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Adding and Managing Groups
After adding a group, you can update a variety of settings to control access to Pulse.

HOW TO ADD A GROUP
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Groups.
The Groups page opens. By default, the Manage Groups tab is active in this page.
4. Below the Manage Users tab, click Add a Group. The Create a Group dialog opens.
5. In the Create a Group dialog, type the following information:Name Type a name for the group.
For example, type Partners.Description Type a short description for the group. For
example, type This is a group for partners.
6. Click Create Group.

HOW TO SELECT A GROUP TO MANAGE
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Groups.The Groups page opens. By default, the Manage Groups tab
is active in this page.
4. Below the Manage Users tab, click Manage Groups.
5. In the Select a group to manage box, type part or all of a group name. Then press Enter. For
example, type part.
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6. Place a checkmark next to the group that you want to manage. For example, select Partners.

7. Click Manage Group.Information about the group appears in the Manage Groups page. There
are three tabs: Basic, Membership, and Advanced.
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HOW TO UPDATE BASIC GROUP SETTINGS
1. Select the group to manage (see above). In this example, we will select the Partners group
that we added.
2. In the Basic tab, change the following information as desired:
n

Name The name of the group. For example, Partners.

n

Description A description to help identify the group. For example, This is a group
for partners.

n

Group Type Sets access permission for group member. You can select either Employee
or Customer.
NOTE: Pulse only permits one Administrators group, which is created by default.

3. Click Save.

HOW TO UPDATE GROUP MEMBERSHIP
1. Select the group to manage (see above).
Information for the selected group should now appear in the Manage Groups page. You will
see three tabs: Basic, Membership, and Advanced.
2. In the Membership tab, you have these options:
n

Add a Member In the What users are members of this group? box, type a full or partial
name. Then place a checkmark next to the user name(s) that you want to add to the
group.
NOTE: When a user is added to multiple groups, their level of system access corresponds to group with the highest permissions. For example, if a user belongs to
both the Employees and Customers group, the user will be granted all of the permissions for the Employees group.

n

Remove a Member Clear the checkmark next to the appropriate user name to remove
the select user(s).
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NOTE: If a registered user is not a member of any group, the system provides
that user with the same permissions as members of the Customers group.
3. Click Save.

HOW TO UPDATE THE ADVANCED GROUP SETTINGS
1. Select the group to manage (see above).
Information for the selected group should now appear in the Manage Groups page. You will
see three tabs: Basic, Membership, and Advanced.
2. Select the Advanced tab.
3. In the Host Site URL box, type the URL of the site that hosts Pulse.
IMPORTANT: It is strongly recommended that you do not change the default settings.
4. Click Save.

HOW TO DELETE A GROUP
1. Select the group to manage (see above).
2. Place a check mark next to the group to delete.
3. Click the

button.

NOTE: The default Administrators, Employees, or Customers groups cannot be
deleted. Members of the Administrators group have permissions to delete both the
groups they create, as well as groups created by other Administrators.
The Confirm Delete Group dialog opens.
4. In the Confirm Delete Group dialog, click Delete Group to remove it.
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Suggested Feeds
In the Pulse dashboard, the Administration > Settings menu command is available to members of
the Administrators group. This gives administrators the ability to click the Suggested Feeds feature.
This lets administrators use Pulse as a content distribution network by adding feeds to Pulse. Administrators can set up suggested feeds to make them available to users who belong to the Administrators or Employees group.

Adding a Suggested Feed
Use the following steps to add a suggested feed.

HOW TO ADD A SUGGESTED FEED
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Suggested Feeds.
4. In the Suggested Feeds tab, click Add a Suggestion List.
5. Create the feed by doing the following:
a. Name Type a name for the feed.
b. Automatic Follow Select whether users should be automatically subscribed as followers
to the new feed. You can select Yes or No.
c. Suggest To Select the audience to whom you are making the suggestion. You can
select Administrators or Employees.
6. Click one of these tabs: People, Groups, or Tags. Then type part of the item you want to
search for and place a check mark next to the item you want to select.
7. Click Ok to save the new feed.
The next step is to configure the suggested feed.
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Configuring a Suggested Feed
Use the following steps to configure a suggested feed.

HOW TO CONFIGURE A SUGGESTED FEED
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Suggested Feeds.
4. In the Select a Suggestions List to Manage box, place a check mark next to the desired list.
Then click Configure.
5. Create the feed by doing the following:
a. Name Type a name for the feed.
b. Automatic Follow Select whether users should be automatically subscribed as followers
to the new feed. You can select Yes or No.
c. Suggest To Select the audience to whom you are making the suggestion. You can
select Administrators or Employees.
6. Click one of these tabs: People, Groups, or Tags. Then type part of the item you want to
search for and place a check mark next to the item you want to select.
7. Click Ok to save the configuration changes.
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Removing a Suggested Feed
Use the following steps to remove a suggested feed.

HOW TO REMOVE A SUGGESTED FEED
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Suggested Feeds.
4. In the Select a Suggestions List to Manage box, place a check mark next to the desired list.
Then click Remove.
5. In the confirmation message, click Remove Suggestion List. This removes the selection from
the Suggested Feeds list.
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Managing Users
In the Pulse dashboard, the Administration > Settings menu command is available to members of
the Administrators group. This gives administrators the ability to click the Users feature to add new
users and perform user administration tasks on the Pulse web server.

Types of Users
When you open the Users page, you will notice counts showing the total number of users:

n

Internal Users This is the total number of user accounts associated with the Administrators
and Employees groups. These are the individuals responsible for administering and/or moderating Pulse. The PulseAdmin account is not included in this total.

n

External Users This is the total number of user accounts for the Customers group. These are
the users who will typically log in to Pulse and use the community features in the Flare output.
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User access to Pulse tools and features is governed by group membership. There are four access
levels for users:
Group Name

Access Level

User Type

Administrators

Full Access

Registered

Employees

Advanced Access

Registered

Customers

Limited Access

Registered

General Public

Restricted Access

Unregistered

NOTE: By default, registered users who are not explicitly added to a group are granted the
same access privileges as members of the Customers group.
In addition to the default groups above, Administrators can create more groups. See "Managing
Groups" on page 251.

CHAPTER 3

262

Creating an Administrator Account
Although a default administrator account named "PulseAdmin" is created during the initial server
configuration (see "Pulse Server Configuration" on page 102), it is strongly recommended that you
create a "standard" user account and assign it administrative permissions for day-to-day administrative operations.
NOTE: The default PulseAdmin account gives the account holder permission to log on to
the Pulse server and perform administrative tasks, such as installing software and changing
the network configuration. A "standard" account with administrative privileges simply gives
the account holder permission to perform day-to-day administrative operations for the
Pulse system.

HOW TO CREATE AN ADMINISTRATOR ACCOUNT
1. Log in to the Pulse dashboard using the default PulseAdmin account. See "Pulse Dashboard"
on page 185.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Users. The Users page opens. By default, the Manage Users tab is
selected.
4. In the Manage Users tab, click Invite a User. This opens the Invite User page.
5. Type the following information in these fields.
n

First Name The first name of the user.

n

Last Name The last name of the user.

n

Email Address A valid email address for the user.

n

Title A title for the user, such as a professional or job title.

n

Department A department name for the user, such as Engineering or Sales.

n

Location A location for the user, such as La Jolla or New York City.

n

Phone A telephone number for the user.

n

Cell A mobile phone number for the user.

n

Skills & Expertise Click Edit Skills if you want to associate yourself with any skills added by
the Administrator. You can request new skills to be added by clicking I don't see my skill.
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n

Experience Click Add Experience if you want to add any relevant experience, including
your company name, title, time period, and a description.

n

Education Click Add Education if you want to add any relevant educational background,
including your school name, dates attended, field of study, and a description.

n

Certification Click Add Certification if you want to add any relevant certifications, including your certificate name, year, and a description.

6. In the Group area, place a check mark in the Administrators box.
7. When you are satisfied with the invitation, click Send Invite.
8. In the User Invite dialog, click Ok to close the message confirming that the invitation was sent.
When the email message arrives, follow the instructions to log in to Pulse. See "Logging In to Pulse"
on page 317.

CHAPTER 3

264

Inviting New Users to Pulse
Members of the Administrators group have permissions to send Pulse invitations to other individuals
by e-mail.

MINIMUM USER ACCOUNT REQUIREMENTS
In order to send an email invite to users asking them join a Pulse community, you need their basic
user information. This list details the minimum user account requirements:
n

First Name The first name of the user.

n

Last Name The last name of the user.

n

Email AddressA valid email address for the user.

n

Groups The desired group membership for the user. A user can be a member of one or more
groups. The default groups are: Administrators, Employees, or Customers. See "Managing
Groups" on page 251.

HOW TO INVITE A SINGLE USER
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Users. The Users page opens. By default, the Manage Users tab is
selected.
4. In the Manage Users tab, click Invite a User. This opens the Invite User page.
5. Complete the fields on the page.
6. In the Group area, place a check mark in the appropriate group name box(es) to add the user
to one or more groups. You must select at least one group to send an invite.When users
belong to more than one group, they are granted the combined access for all the groups to
which they belong.
7. When you are satisfied with the invitation, click Send Invite.
8. In the User Invite dialog, click Ok to close the message confirming that the invitation was sent.
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HOW TO BULK INVITE USERS
If you would like to bulk invite users to join Pulse, members of the Administrators group can import
users by importing a comma-separated values (CSV) file.

CSV FILE REQUIREMENTS
To successfully import user data from CSV, keep the following in mind:
n

Import a CSV File The file must be saved in the CSV format.

n

Include Column Headings in the Top Data Row Always use the first data row to define the
column headings. Column headings must use exact spelling shown in the table below under
"Column Name."

n

Column Order is Not Important As long as you have named the column headings as required,
the order of your columns is not important.

n

Table Must Contain At Least One Data Row At a minimum, the file must contain at least one
row of data.

n

Always Include the Required Columns At a minimum, the user data you plan to import must
contain these columns: FirstName, LastName, EmailAddress, and at least one assignment for Groups.

EXAMPLE
Below is an example of a properly formatted CSV file:

CHAPTER 3

266

In order to successfully import CSV-formatted user data into the system, see the information in
the table below:
Column
Name
FirstName

Format
text

Required
Column

Description
The first name of the user.

EXAMPLE
Enter the first name
of the user:
Emily
LastName

text

The last name of the user.

EXAMPLE
Enter the last name
of the user:
Smith
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Column
Name
EmailAddress

Format
email address

EXAMPLE
Enter a valid email
address:
emily@example.com
A valid email address
includes the account
(emily), the
ampersand (@) and
the domain
(example.com).
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Column

Description
A valid email address.

IMPORTANT: The email
address is the unique
identifier for the
account. The email
address cannot be
changed once an
account is created.
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Column
Name
Groups

Format
text

Required
Column

Description
This in the group name (or
names) in Pulse.

EXAMPLE
To add the user to a
single group, enter
the group name. For
example:

To add a user to multiple groups,
separate the group names using
a semicolon (;).

Customers
To add the user to
multiple groups,
enter the group
names and separate
them with the semicolon. For example:
Administrators;Employees
Location

text

This can be used to specify the
user location. This might be a
facility, city, town, state, or
region.

Title

text

This is the user's professional
title.

Department

text

This is the user's department.

Phone

telephone number

This is the account holder's telephone number. Always use a
dash (-) to separate the area
code, prefix, and line number. For
example, 000-000-0000.
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Column
Name

Format

Required
Column

Description

Cell

telephone number

This is the users mobile number.
Always use a dash (-) to separate
the area code, prefix, and line
number. For example, 000-0000000.

Password

text

This is the password for the user
account. It must be a minimum
of 7 characters in length.
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HOW TO IMPORT USERS FROM CSV
Follow these steps to import users into Pulse.
WARNING: If you are syncing Pulse with Microsoft Active Directory (AD), you will not need
to import your AD users.

1. Log in to the Pulse dashboard using an account that is a member of the Administrators
group.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Users. The Users page opens. By default, the Manage Users tab is
selected.
4. Click the Import Users tab.
5. Under Select a User Data File, click the Choose File button. The file that you using for the
import must be saved in the CSV file format. The data in the file must also meet the requirement defined above.
6. In the Open dialog for Windows, find the file that you want to open. Then, double-click the file
or highlight it and click Open.

7. Under Email Options, place a checkmark in the Send invitation emails to each user box.
8. Type a message in the text box. The system includes the message "Welcome to Pulse" by
default.

CHAPTER 3

271

9. Click Import.If the import is not successful, an error message appears. Most failed import
attempts are due to a format error in your data file. Be sure to review the requirements for
CSV files above. Then, try the import again.
10. Click Back to return to the Import users page. Until your users log in to Pulse for the first
time, you will not be able to find them in the Manage Users list.

HOW TO RESEND AN INVITE
Administrators can resend invitations to users that have not yet registered for Pulse.
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Users. The Users page opens. By default, the Manage Users tab is
selected.
4. In the Manage Users tab, select the user to manage by following these steps:Type part of all
of the user name.In the selection list, place a checkmark in the box next to the desired username.
5. Click Next.
6. In the User Details page, click Resend Invite..
NOTE: This option is only available if the user has not yet activated their Pulse
account.
7. In the User Invite dialog, click Ok to close the message confirming that the invitation was sent.
The user can click the link in the invitation to log into Pulse for the first time.
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Deleting/Disabling Use Accounts
You can disable, enable, and delete user accounts.

HOW TO DISABLE A USER ACCOUNT
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Users. The Users page opens. By default, the Manage Users tab is
selected.
4. In the Manage Users tab, select the user to manage by following these steps:Type part of all
of the user name.In the selection list, place a checkmark in the box next to the desired username.
5. Click Next..
6. In the User Details page, click Disable.
7. In the Confirm Disable dialog, click Disable.

HOW TO ENABLE A DISABLED ACCOUNT
To enable a disabled account use the same steps as above. Click Enable in the User Details page.
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HOW TO DELETE A USER ACCOUNT
Members of the Administrators group have permissions to delete users in Pulse. After deleting a
user, the user will no longer be able to sign in to Pulse.
In the User Details page, click Delete.
In the Confirm Delete User dialog, click Delete. The user will no longer be able to log in to Pulse.
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Users. The Users page opens. By default, the Manage Users tab is
selected.
4. Click the Manage Users tab.
5. Select the user to manage:Type part or all of the user name. For example, type cal.In the
selection list, place a checkmark in the box next to the desired username. For example, select
Cal Customer.
6. Click Next.
7. In the User Details page, click Delete.
8. In the Confirm Delete User dialog, click Delete. The user will no longer be able to log in to
Pulse.

NOTE: Deleting a Pulse user removes all access to Pulse. To give a user the ability to re-use
the email address in Pulse, you must also delete the user from the dbo.Users and dbo.Login
tables in the SQL Server instance for the Pulse database. Once the entries are deleted, the
email can be used to create a new Pulse account.
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Configuring Profile Settings
Administrators can adjust profile settings, including which fields and elements are available and editable for users. See "Editing Your Profile" on page 323.
Pulse users can self-declare any of the skills you input. A great place to start your skills list is
LinkedIn and other industry-specific websites. Each skill can be assigned to a skill category. Therefore, you may want to create a skill category first. Skill categories are used in Pulse to make locating
and grouping skills easy. Some good skill categories are things like Human Resources, Legal, or
Information Technology. Think about people’s job roles and departments for ideas on skill categories.
In the Settings page, click Profiles. The Profiles page opens.

HOW TO CONFIGURE PROFILE SETTINGS
1. Log in to the Pulse dashboard using an account that is a member of the Administrators
group.See "Logging In to Pulse" on page 317.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Profiles. The Profiles page opens.
4. You can do any of the following:

SKILL CATEGORIES—ADD, EDIT, REMOVE
1. Select the Skill Categories tab.
2. To add a new skill category, do the following:
a. Click Add Skill Category.
b. In the dialog that opens, enter a skill name and click Save.
3. To edit an existing skill category, do the following:
a. In the main list on the Skill Categories tab, select the skill category you want to edit.
b. Click Configure.
c. Change the name.
d. Click Save.
4. To remove an existing skill category, do the following:
a. In the main list on the Skill Categories tab, select the skill category you want to
remove.
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b. Click Remove.
c. Click Delete Skill Category.

SKILLS—ADD, EDIT, REMOVE
1. Select the Skills List tab.
2. To add new skills, do the following:
a. Click Add Skills.
b. In the dialog that opens, enter skills in the text box, one on each line.
c. You can also associate the skills with a category (if you have created one).
d. Click Add Skills.
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3. To edit an existing skill, do the following:
a. In the main list on the Skills List tab, select the skill you want to edit.
b. Click Configure.
c. Change the name and or skill category associated with the skill.
d. Click Save.
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4. To remove an existing skill, do the following:
a. In the main list on the Skills List tab, select the skill you want to remove.
b. Click Remove.
c. Click Delete Skill.

SKILL REQUESTS—APPROVE OR REJECT
1. Select the Skill Requests tab. Any requests from users are listed on the tab.
2. To approve a request, do the following:
a. Click Approve.
b. In the dialog that opens, you can associate the skill with a category (if you have created one).
c. Click Approve Skill.
3. To reject a request, do the following:
a. Click Reject.
b. In the dialog that opens, you can type a reason for the rejection.
c. Click Reject Skill.

PROFILE PROPERTIES (FIELDS)—ADD, EDIT, REMOVE
These are the fields that users see and complete when registering in Pulse (e.g., First Name,
Location, Phone).
1. Select the Profile Properties tab.
2. To add a new property, do the following:
a. Click Add Property.
b. In the Name field, enter a name for the new field.
c. In the Type field, enter a kind of field to be used for the new property.
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d. Depending on the type you selected, complete the fields that are shown. This can
include a text box (if you need to provide a custom type), as well as check boxes to
make the new property editable, make it searchable, or include predefined values.
If you select Predefined Values, enter them (one per line) in the field that displays.
e. Click Save.
3. To edit an existing property, do the following:
a. In the main list on the Profile Properties tab, select the property you want to edit.
b. If you want to reposition it in the order, click either Move Up or Move Down.
c. Click Configure.
d. You can change the name or type for the property. You can also use the fields
below to make the property editable, make it searchable, or include predefined values.
e. Click Save.
4. To remove an existing property, do the following:
a. In the main list on the Profile Properties tab, select the property you want to
remove.
b. Click Remove.
c. Click Delete Profile Property.

PROFILE FEATURES (EXPERIENCE, EDUCATION, CERTIFICATIONS)—ENABLE OR
DISABLE
1. Select the Profile Features tab.
2. Click a check box next to Experience, Education, or Certifications if you want to enable
that feature. If you want to disable the feature, remove the check mark.
3. Click Save.
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Configuring Moderation—Rejection Reasons
As an Administrator, you can configure your moderation settings by adding reasons for rejecting
posts. Then when you reject a post, you can select any of the reasons you've added.

HOW TO ADD A REJECTION REASON
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Moderation. The Moderation page opens.
4. At the bottom of the page, click Add Rejection Reason.
5. In the Reason field, enter the text that you want.
6. Click Save. The text is added to the list of reasons.

NOTE: You can edit a reject reason by selecting it from the list and clicking Configure. You
can delete a rejection reason by clicking Remove.
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Event Log
In the Pulse dashboard, the Administration > Settings menu command is available to members of
the Administrators group. This gives administrators the ability to access the Log feature when you
want to view and research events in the Pulse log.

Pulse Event Logs
The Pulse log shows the following events and information:
Field

Description

EventType

The type of event. For example, critical, error, or warning.

CreatedUTC

The date and time steps the event occurred.

MachineName

They Pulse web server name.

Url

Click to open a URL with more information.

ProcessName

Shows the name of the process.

ExceptionType

Lists events that required special processing.
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Viewing Event Logs
Use the following steps to view the event log.

HOW TO VIEW THE EVENT LOG
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. In Settings page, click Log. The Pulse event log opens.
4. From the drop-down list, select one of these filters:
n

Show All Select this item to reveal all logged events.

n

Critical Select this item to reveal a list of critical events that have occurred. Critical
errors can lead to system disruption/failure, so it is important to take corrective actions.

n

Error Select this item to reveal a list of events that can potentially lead to system disruption/failures, so it is import to locate errors and determine if preventative or corrective action is needed.

n

Warning Select this item to view a list of events that are not significant, but may indicate of a future issue.

n

Information Select this item to show events that completed successfully.

n

Verbose Select this item to reveal more detailed information about the issue. This is a
helpful option to look at should you need to perform troubleshooting.

5. (Optional) If you want to search the log, enter your search terms in the Query field. Then click
Search.
6. (Optional) If you want to clear the Query field of any search terms, click Reset.
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Managing Communities
AVAILABLE TO: Administrators only
A community is a collection of registered users that have access to a set of social features. When a
Flare community is integrated with a Pulse system, users have access to the same type of community functions that one would find on a social media site.
You can manage communities using either the Pulse dashboard or the Flare interface (i.e., the Target Editor).
In the Pulse dashboard, the Administration > Settings menu command is available to members of
the Administrators group. This gives you the ability to click Communities to view a list of the Flarecommunities that have been integrated with Pulse.
Managing a community means that you can add, delete, rename, or provide a published URL for
that community. However, for best results, it is recommended that you always add, delete, or
rename a Flare community using the Flare user interface, rather than using the Pulse dashboard.

HOW TO MANAGE FLARE COMMUNITIES FROM THE PULSE DASHBOARD
1. Log in to the Pulse dashboard using an account that is a member of the Administrators
group.See "Logging In to Pulse" on page 317.
2. Select Administration > Settings. The Settings page opens.
3. Click Communities. The Communities page opens. This shows a list of all the communities
that have been integrated with Pulse. A key is shown, along with the name of the community.
This key is automatically created for you when you install the SQL Server Database.
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4. Make any necessary changes. If you want to provide a published URL for a community, in the
Published Url field type the path to the folder containing your main landing page. Make sure
you include http:// at the beginning of the URL.
EXAMPLE
Let's say you've generated a target called "FlareOutput" and you've uploaded the
output so that users access it
here: help.mycompany.com/FlareOutput/Default.htm. In that case, enter
http://help.mycompany.com/FlareOutput in the Published Url field.
Why is it a good idea to assign a URL path to a community? Because it allows topic feeds to
open in context.
EXAMPLE
Let's say you have not provided a published URL for your community. You receive
an email notification stating that a user has posted a comment in one of your topics. So you click the topic name link in the email notification to see the feed
where the comment was posted. The feed opens in the dashboard view of Pulse,
which shows only the feed and not the topic associated with it.

On the other hand, let's say you provide a published URL to your community. In
that case, when you click the topic link, the topic opens in the actual Flare output.
You see both the topic and the Pulse feed below it, therefore giving context to
the post.
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5. When you are finished, click Save Changes
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Managing Synonyms
In the Pulse dashboard, the Administration > Settings menu command is available to members of
the Administrators group. This gives administrators the ability to create synonyms to enhance the
search capabilities of the Flare search engine.

Working with Synonyms
You can enhance the Flare search engine by creating a synonym file for interchangeable words.
This gives the Flare search engine to ability to return results that include a similar word, when a user
enters a particular word. For example, when a user searches for "hound," the synonym file tells the
Flare search engine to also return results that include the synonym "dog."
When integrated with Pulse, the Flare search engine will search both the Flare topic files and the
embedded Pulse discussion forms.
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There are two ways to create a synonym file to enhance the search capabilities for your Flare output:
n

Using the Flare Synonym Editor You can create synonyms directly in the Flare user interface.
See the Flare online Help.

n

Use the Synonyms Feature in Pulse Members of the Administrators group can add synonyms
to Pulse. If desired, you can also export the synonym file from Pulse and import it into the
desired Flare project as described below.
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Adding Synonyms in Pulse
You can add two types of synonyms in Pulse: A directional synonym or a synonym group.

HOW TO ADD A DIRECTIONAL SYNONYM
A directional synonym is a word that can only be queried in a single direction. For example, a query
for the word "dog" would find results that include the synonym "poodle." However, because the synonym only works in one direction, a query for "poodle" would not find results for "dog."
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Synonyms. The Synonyms page opens. By default, the Directional
tab is active in this page.
4. Select the Directional tab.
5. From the Community drop-down list, select the desired Flare community.
6. In the Directional tab, click NewA new, blank row for data entry is shown.
7. In the entry fields, do the following:
a. In the Word field, type the desired word. For example, type dog.
b. In the Synonym field, type the synonym to include in search results when end users
search for the corresponding word. For example, type pup.
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IMPORTANT: When adding synonyms, the word and synonym must be a single
word. The synonym feature does not support phrases, punctuation, or languages.

IMPORTANT: Synonyms are case-sensitive.
8. (Optional) You can place a checkmark in the Stem box. This gives the search engine the ability to include all forms of the word in the search. For example, a search for "dog" will include
"dogs."
9. Click Save Changes. A confirmation message appears when the save is successful.In order
for your changes to take effect, you must republish your Flare output.
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HOW TO ADD A SYNONYM GROUP
Add a synonym group to perform queries for identical synonyms. An identical synonym is a word
that can be queried in two directions. For example, a query for the "dog" would find results that
include identical synonyms such as "hound" and "canine." A search for "canine" or "hound" would
include the identical synonym "dog."
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Synonyms. The Synonyms page opens. By default, the Directional
tab is active in this page.
4. From the Community drop-down list, select the desired Flare community.
5. Select the Groups tab, then click New.A new, blank row for data entry is shown.
6. In the Group field, type the word followed by the equal (=) symbol, and then type a list of synonyms. You must separate each synonym with a comma. For example, type: dogg=canine,doggy,doggie,hound,pooch,pup,puppy.
7. (Optional) You can place a checkmark in the Stem box. This gives the search engine the ability to include all forms of the word in the search. For example, a search for "dog" will include
"dogs."
8. Click Save Changes. A confirmation message appears when the save is successful.
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Managing Synonyms
You can delete, export, copy, and overwrite synonyms.

HOW TO DELETE A DIRECTIONAL SYNONYM
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Synonyms. The Synonyms page opens. By default, the Directional
tab is active in this page.
4. Select the Directional tab.
5. Next to the synonym that you want to remove, click Delete. This immediately removes the synonym from the list.
6. When you are finished, click Save Changes

HOW TO DELETE A SYNONYM GROUP
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Synonyms. The Synonyms page opens. By default, the Directional
tab is active in this page.
4. Select the Groups tab.
5. Next to the synonym group that you want to remove, click Delete. This immediately removes
the synonym group from the list.
6. When you are finished, click Save Changes
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EXPORTING A SYNONYM FILE FROM PULSE
If you want to use the same synonyms that you created for Pulse in a search of the Flare output, you
can export the synonym file from Pulse. Then copy it into your Flare project.
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Settings. The Settings page opens.
3. In the Settings page, click Synonyms. The Synonyms page opens. By default, the Directional
tab is active in this page.
4. Click the Export (.mcsyns) link at the bottom of the page. This downloads a copy of the synonyms file to your computer. The next step is to copy the synonym file to the Flare project.The downloaded file is saved in the MCSYNS file format, so you can import it into your
Flare project. If you are not able to download the file, check your browser's download settings.

COPYING A SYNONYM FILE TO A FLARE PROJECT
1. Add or make changes to the synonyms in Pulse.
2. Export the synonym file from Pulse.
3. Ensure that the Flare project where you plan to copy the file is closed.
4. Double-click the synonym file to open it. This starts the Flare program.If the Flare project
where you are planning to copy the file is open, an error message appears to inform you the
desired Flare project is already open in another instance. Close the open Flare project and
then open the synonym file again.
5. In the Copy to Project dialog, select the project where you want to copy the synonym file.
Then click Copy.The program copies the file to the selected project and places it in the \Project\Advanced folder in the Flare project. It also opens the file in the Synonyms Editor.
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6. In the Synonyms Editor, ensure that your synonyms appear. In this example, we added a synonym group.

7. Click
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OVERWRITING A SYNONYM FILE IN FLARE
1. Make changes to the synonyms in Pulse.
2. Export the updated synonym file from Pulse.
3. Ensure the file that you exported has the exact same file name as the synonym file in the
Flare project. You may need to rename this file to match.
4. Ensure that the Flare project where you plan to copy the file is closed.
5. Double-click the synonym file to open it. This starts the Flare program.
IMPORTANT: If the Flare project where you are planning to copy the file is open, an
error message appears to inform you the desired Flare project is already open in
another instance. Close the open Flare project and then open the synonym file again.
6. In the Copy to Project dialog, select the project where you want to copy the synonym file.
Then click Copy.
The program copies the file to the selected project and places it in the \Project\Advanced
folder in the Flare project. The program also opens the file in the Synonyms Editor.
When Flare recognizes that a target file with the same file name exists, the Copy File dialog
appears.
7. In the Copy File dialog, make sure that the appropriate source file and target file names
appear. Then click Overwrite.
8. In the Synonyms Editor, ensure that your updated synonyms appear.
9. Click
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Reports
Pulse provides members of the Administrators group with access to a variety of system- and community-specific reports.

CHAPTER 3

295

Report Types
From the Pulse dashboard, you can generate report information about each Flare community that
you've set up. You can also run system-wide reports that show usage information for the entire
Pulse system.

COMMUNITY REPORTS
The following table details the community reports. Data is presented in reports for the selected community for the date period you specify. Each report lets you select a chart type from the Style list.

Report Name

Description

Export
Report
Data?
CSV

Browser Statistics

See which browsers are being used to view your online output.

Context-sensitive
Help Calls

See context-sensitive Help identifiers that have been
invoked at least once in the output.

Operating System
Statistics

See which operating systems are being used to view your
online output.

Search Phrases

See all search queries made to the output.

Search Phrases with
No Results

See all search phrases that didn't produce any results.

Topics

See all topics in the output that have been viewed at least
once.
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SYSTEM REPORTS
The following table details the system reports.

Report Name

Description

Chart
Style

Export
Report
Data?
CSV

User Count

See the number of users who have posted to the Pulse system. This presents data for all communities combined during the date period you specify.

Line

Engaged
Users

See the number of users who have posted to this community.

Line

Overall Activity

See the overall activity in Pulse. This presents data for all
communities combined during the date period you specify.

Line

User Activity

See Pulse activities for a specific user. This presents data
for one selected user for the date period you specify.

Line

Most Active
People

See the most active users. This presents data for all system users for the date period you specify.

Column

Most Active
Groups

Shows the most active groups and embedded discussions
in the project.

Column

Most Followed People

See the users with the most followers.

Column

Most Liked
People

See the most liked users for the time period you specify.

Column

Most Commented
People

See the users with the most comments on their posts for
the time period you specify.

Column

Most Liked
Activities

See the activities that have the most likes for the time
period you specify.

Column
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Report Name

Description

Chart
Style

Export
Report
Data?
CSV

Most ComSee the activities that have the most comments for the
mented Activ- time period you specify.
ities

Column

Most Liked
File Shares

See the shared files that have the most likes for the time
period you specify.

Column

Most Commented File
Shares

See the shared files that have the most comments for the
time period you specify.

Column

Most Liked
Image
Shares

See the shared images that have the most likes for the
time period you specify.

Column

Most Commented
Image
Shares

See the shared images that have the most comments for
the time period you specify.

Column

Most Liked
Link Shares

See the shared links that have the most likes for the time
period you specify.

Column

Most Commented Link
Shares

See the shared links that have the most comments for the
time period you specify.

Column

Storage
Usage

See the storage being used by shared files and images for
the time period you specify.

Line

Monthly Active Users

See the number of users who have accessed the system
by month.

Column
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Running and Formatting Reports
You can run and format a variety of different reports in Pulse.

HOW TO RUN A REPORT
1. Log in to the Pulse dashboard using an account that is a member of the Administrators group.
2. Select Administration > Reports. The Reports page opens.
3. Click the desired report name to open it. The available formatting options depend on whether
you are running a community or system report.

HOW TO FORMAT A COMMUNITY REPORT
Following are ways to format a community report.

HOW TO SELECT A COMMUNITY
If the selected report supports the ability to filter data for each Flare community in your
Pulse system, select one of your communities from the Community list.
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HOW TO SELECT A CHART STYLE
If the selected report supports the ability to select a style for rendering your chart data,
select one of the available chart styles from the Styles drop-down list.

The table below details the available chart styles:
Style

Description

Area

Compares two or more quantities and is used to represent cumulative totals.

Bar

Compares multiple data points using horizontal bars with lengths that are proportional to the values represented.

Box Plot

Summarizes the statistical distribution of multiple data points using box and
whisker plotting.

Bubble

Represents data points using bubbles.

Column

Compares multiple data points using vertical bars with lengths that are proportional to
the values represented.

Doughnut

Depicts numerical proportion. Like a pie chart, the length of each section in the chart is
proportional to the quantity it represents. The only difference is that a pie chart does not
have a hollow center.

Line

Connects a series of data points using straight line segments.

Pie

Depicts numerical proportion. The length of each section in the chart is proportional to the quantity it represents.
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Style

Description

Point

Represents data values using points.

Spline

Similar to a line chart, only the line used to draw the data points use a fitted
curve.

Spline
Area

Similar to an area chart, only the line used to draw the data points use a fitted curve.

Stacked
Area

Similar to an area chart in that it compares two or more quantities and is used
to represent cumulative totals. However, it also shows the relationship of the
part to the whole.

Stacked
Bar

Similar to a bar chart in that it compares multiple data points using horizontal bars with
lengths that are proportional to the values represented. However, it also shows the relationship of parts to the whole.

Stacked
Column

Similar to a column chart in that it compares multiple data points using vertical
columns with lengths that are proportional to the values represented. However, it also
shows the relationship of parts to the whole.

Step Line

CHAPTER 3

Connects data points together using horizontal and vertical lines.

301

HOW TO FILTER REPORT RECORDS
If the selected report supports the ability to filter the records that you include, select one of
the listed options from the Records drop-down list.

The table below describes the options in the drop-down list:
Records

Description

All

Includes all records in the report.

Top 10

Includes only the top 10 records.

Top 25

Includes only the top 25 records.

Top 50

Includes only the top 50 records.
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HOW TO SWITCH THE CHART VIEW
If the selected report supports the ability to filter the records that you include, select one of
the listed options from the Chart drop-down list. The options available depend on the report
type.

HOW TO SELECT THE REPORT LEGEND
If the selected report supports the ability to include a report legend, select one of the listed
options from the Legend drop-down list. The options available depend on the data in the
report.
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HOW TO ENABLE THE DATE FILTER
If the selected report supports the ability to enable a data filter, do the following:
a. Place a check mark in the Enable Date Filter box. This reveals the Start Date and End
Date fields.

NOTE: Most reports define the report period to the previous month by
default.
b. Place the mouse cursor in the Start Date box to reveal a drop-down calendar where
you can navigate to the desired start date. You can click the arrows to switch between
months.
c. Repeat the same action in the End Date box.

HOW TO FORMAT A SYSTEM REPORT
For system reports, the chart style for the report is predetermined. However, you do have
the ability to specify the desired reporting period as follows:
a. Open the desired system report. This reveals the Start Date and End Date fields.
b. Place the mouse cursor in the Start Date box to reveal a drop-down calendar where
you can navigate to the desired start date. You can click the arrows to switch between
months.
c. Repeat the same action in the End Date box.
4. When ready to generate the report, click Run.
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HOW TO EXPORT A REPORT
You can download a copy of the current report to your local drive.
1. Run the desired report.
2. At the bottom of the page, click the Export link.
NOTE: Community reports can be downloaded in CSV or TXT format. System reports
can be downloaded in CSV format only.

NOTE: A refresh button is available in some Pulse reports, allowing you to update the data
while the report is open. The button is available on reports that have a drop-down in the
upper-right corner that lets you switch from one community to another. By clicking Refresh
Data instead of pressing F5, the report data updates for the selected community. If instead
you press F5, the drop-down switches to the first community in the list.
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Searching the Pulse Dashboard
AVAILABLE TO: Administrators and Employees
You can search the Pulse dashboard for information and even follow searches.

Searching the Pulse Dashboard
You can search the entire Pulse system or a feed.

HOW TO SEARCH THE ENTIRE PULSE SYSTEM
1. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
2. In the upper-right corner of the dashboard, type a search query and select one of the following
menu options:
n

Search for Posts with this Phrase Limits the scope of the search to post activities.

n

Search for Messages with this Phrase Limits the scope of the search to messaging activities.

HOW TO SEARCH A FEED
1. In the Pulse dashboard, navigate to a system, user, or group feed.
2. In the feed, type a search query in the Search this Feed box.

Following Searches
If you are a member of the Administrators or Employees group, you can perform a search and then
follow the results from the Pulse dashboard. See "Following Community Activities" on page 426.
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Pulse Dashboard Frequently Asked
Questions
Following are some frequent questions about administration tasks for the Pulse dashboard.

General Settings
Following are general frequently asked questions about the dashboard.

WHAT VERSION NUMBER DO I HAVE?
1. Log in to the Pulse dashboard as an administrator.
2. Select Administration > Settings.The Pulse version number appears in the top right-corner of
the page.

Managing Accounts
If you are a member of the Administrators group and responsible for Pulse user administration, here
are some answers to frequently asked questions.

WHO CAN DISABLE OR DELETE USER ACCOUNTS?
Pulse user accounts can be disabled or deleted by these individuals:
n

Pulse Administrators Members of the Administrators group can disable to delete user
accounts from the Administration > Settings menu. Members of the Employees and Customers groups cannot delete user accounts, including their own account.
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n

SQL Server Administrator If you have administrative permissions to SQL Server, you can
remove user information directly from the SQL database. This will immediately remove a user
from Pulse.

For more information about users, see "Managing Users" on page 261.

CAN USERS CREATE TWO ACCOUNTS WITH THE SAME EMAIL ADDRESS?
Pulse does not allow users to create two accounts with the same email address. If a user attempts
to register for a second account using the same email address, they will see the "Unable to
register" error shown below:

HOW CAN I REUSE AN EMAIL ADDRESS?
If you delete a user account in the Pulse dashboard, access to Pulse features is immediately
revoked. However, to give a user the ability to reuse an email address in Pulse, you must also delete
the user from the dbo.Users and dbo.Login tables in SQL Server. If you are using SQL Server Management Studio you can right-click the user and select Delete from the context menu. Once the
entries are deleted, the email can be used to create a new Pulse account.
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CHAPTER 4

User Tasks
As a user, there are many tasks that you can perform when using Pulse, from registering and logging in, to posting and sending messages, to moderating (if you have appropriate access).
This chapter discusses the following:
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Editing Your Profile

323

Posting Content

328

Responding to Posts

341

Messaging

352

Moderating Pulse

361

Searching for Community Results
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Registering for a Pulse Account
When you integrate a Pulse system with a Flare community, there are two methods for joining the
community. Both methods require you to register and activate an account.

User Account Requirements
In order to register and activate a Pulse user account, you must have the following information:
n

An Email Address

n

An Internet Connection and a Compatible Web Browser

n

(Optional) A Pulse Invitation You can register for Pulse with or without an invitation. However,
some organizations might decided to send their users an invitation to join.
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Registering for a Pulse Account
Use one of these methods to register for a Pulse account:

HOW TO REGISTER FROM AN INVITATION
If you are invited to join Pulse, you will receive an email to join the community from the Pulse system. The invitation is sent by a member of the Administrators group.
1. Check your email Inbox for the "You have been invited to Pulse" message.
2. Open the message. Then click the Login link in the body of the invite. This opens the Setup
Your Account page in a web browser.
3. At the How Would You Like to Login dialog, do the following:
a. Select the With my e-mail address and a password button.
b. Type a unique password in the Enter a Password box. Your password must be a minimum of seven (7) characters.
c. Click Continue.
4. In the Tell Us A Little About Yourself dialog, verify and enter the following information. An
asterisk (*) denotes required fields:
n

*First Name The first name of the user.

n

*Last Name The last name of the user.

n

*Email Address A valid email address for the user.

n

Location A location for the user, such as La Jolla or New York City.

n

Title A title for the user, such as a professional or job title.

n

Phone A telephone number for the user.

n

Cell A mobile phone number for the user.

5. At the Your Account is Ready dialog, click Go to My Feed.The Home page displays. Depending
on the group membership of your user account, you will have different options available to
you. See "Managing Groups" on page 251.
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HOW TO REGISTER FROM THE PULSE DASHBOARD
1. In a web browser, go to the Site URL for the Pulse dashboard.If you do not know the Site URL,
see the Administrator who installed your Pulse server. Alternatively, if you have access to a
Flare target that has already been integrated with the Pulse server, you can open the Community tab and find the URL listed there.This opens the Pulse Account Login dialog.
2. At the Pulse Account Login page, click Register.
3. In the Register page that appears, type the following information. An asterisk (*) denotes the
required fields:
n

*First Name The first name of the user.

n

*Last Name The last name of the user.

n

*Email Address A valid email address for the user.

n

*Password This is the password for the user account. It must be a minimum of 7 characters in length.

n

*Confirm Password Re-enter the password.

n

Title A title for the user, such as a professional or job title.

n

Department A department name for the user, such as Engineering or Sales.

n

Location A location for the user, such as La Jolla or New York City.

n

Phone A telephone number for the user.

n

Cell A mobile phone number for the user.

4. Click Register.The Validate Email Address page appears.
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HOW TO REGISTER FROM THE FLARE OUTPUT
1. In a web browser, go to the URL hosting your published Flare content (e.g., the MadCap Flare
online Help can be found at help.madcapsoftware.com).
Depending on the Pulse features that have been enabled for the output, you can click one of
the following links:
n

Register Link in the Embedded Discussion Form
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n

Register Link in the Community Tab This tab is only available when it is enabled by the
content developer. See "Integrating Flare and Pulse" on page 126.

2. In the Register page that appears, type the following information. An asterisk (*) denotes the
required fields:
n

*First Name The first name of the user.

n

*Last Name The last name of the user.

n

*Email Address A valid email address for the user.

n

*Password This is the password for the user account. It must be a minimum of 7 characters in length.

n

*Confirm Password Re-enter the password.

n

Title A title for the user, such as a professional or job title.

n

Department A department name for the user, such as Engineering or Sales.

n

Location A location for the user, such as La Jolla or New York City.

n

Phone A telephone number for the user.

n

Cell A mobile phone number for the user.

3. Click Register.The Validate Email Address page appears.
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Activating Your Pulse Account
You also need to activate your account.
1. Register for a Pulse account.
2. When the Validate Email Address page appears, check your email Inbox for the "Pulse
User Profile Activation" message and open it.
3. Click the Complete Registration link. This opens the Register - Activation Success page in a
web browser.
4. In the Activation Success page, click Close Window to quit your browser.

CHAPTER 4

315

Troubleshooting Registration Issues
If you are attempting to register for a Pulse account and encounter a message that says "A user
name for that email address already exists," it may be possible that:
n

You have already created a Pulse account and need a new password.

n

You have already created a Pulse account and need to complete the registration process.

n

Someone accidentally entered your email address when creating a Pulse account. However,
since they entered your email address, the confirmation email was delivered to your email
address and the person was never able to confirm that registration.

In any of these events, it is easy to reclaim your Pulse account.

HOW TO RECLAIM YOUR PULSE ACCOUNT
1. Go to the password recovery page. Depending on the interface, you can get there using these
options:
n

From the Online Documentation Visit the Flare output files and under Account, click the
Login link. In the Pulse Account Login page, click the Forgot your password? link.

n

From the Pulse Server Admin Tool Simply visit this link:
http://pulse.madcapsoftware.com/Pulse/ForgotPassword

2. In the Forgot Your Password page, type your email address.
3. Click the Send Instruction button.
4. In the Email Sent dialog, click Ok to close the message that your password has been reset.
5. Open your email inbox and look for the "Reset your password" message.
6. Click the Reset your password link.
7. In the Reset Your Password page, type a unique password for your account in the New Password and Confirm Password boxes.
8. Click Reset Password.
9. If you password is successfully reset, a confirmation page appears. Click Close Window.
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Logging In to Pulse
AVAILABLE TO: Administrators, Employees, and Customers
Once you have registered for a Pulse account, you can log in to the Pulse dashboard or you can log
in to the published Flare output to use the community features.

Logging in to a Flare Community
There are several ways to log in to Pulse. The log in options available depend on the features that
the Flare author enabled.

HOW TO LOG IN/OUT USING THE COMMUNITY TAB
1. In a web browser, go to the URL hosting your published Flare content (e.g., the MadCap Flare
online Help can be found at help.madcapsoftware.com).
2. Click the Community tab. Then, click Login..

NOTE: A content developer must enable the Community tab for the Flare output
using a skin.
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3. In the Pulse Account Login dialog, type the following information:
n

Email Address Type the email address that you used when registering for Pulse. Your
email address is always your username. If you are logging in with the main Administrator
account, in this field you can enter pulseadmin.

n

Password Type the password that you created for that email address. If you are logging
in with the main Administrator account, this is the password that was created when Pulse
was configured (see "Pulse Server Configuration" on page 102).

4. (Optional) Place a check mark in the Keep me signed in box.
NOTE: When selected, Pulse will remember the account information that you used to
log in and won't ask you to enter your credentials again as long as you are using the
same browser on the same computer or device.
5. Click Login.
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HOW TO LOG IN/OUT FROM A TOPIC FEED
1. In a web browser, go to the URL hosting your published Flare content (e.g., the MadCap Flare
online Help can be found at help.madcapsoftware.com).
2. In the Account area of a topic feed (i.e., the area at the bottom of any topic in the output),
click Login.

The Pulse Account Login dialog opens.
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3. In the Pulse Account Login dialog, type the following information:
n

Email Address Type the email address that you used when registering for Pulse. Your
email address is always your username. If you are logging in with the main Administrator
account, in this field you can enter pulseadmin.

n

Password Type the password that you created for that email address. If you are logging
in with the main Administrator account, this is the password that was created when Pulse
was configured (see "Pulse Server Configuration" on page 102).
NOTE: If you do not have an account, you can register for one. See "Registering for a
Pulse Account" on page 310.

4. (Optional) Place a check mark in the Keep me signed in box.
NOTE: When selected, Pulse will remember the account information that you used to
log in and won't ask you to enter your credentials again as long as you are using the
same browser on the same computer or device.
5. Click Login.
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Logging in to the Pulse Dashboard
1. In a web browser, go to the Site URL for the Pulse dashboard.If you do not know the Site URL,
see the Administrator who installed your Pulse server. Alternatively, if you have access to a
Flare target that has already been integrated with the Pulse server, you can open the Community tab and find the URL listed there.This opens the Pulse Account Login dialog.
2. In the Pulse Account Login dialog, type the following information:
n

Email Address Type the email address that you used when registering for Pulse. Your
email address is always your username. If you are logging in with the main Administrator
account, in this field you can enter pulseadmin.

n

Password Type the password that you created for that email address. If you are logging
in with the main Administrator account, this is the password that was created when Pulse
was configured (see "Pulse Server Configuration" on page 102).

3. (Optional) Place a check mark in the Keep me signed in box.
NOTE: When selected, Pulse will remember the account information that you used to
log in and won't ask you to enter your credentials again as long as you are using the
same browser on the same computer or device.
4. Click Login.
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Troubleshooting Login Issues
Below are resolutions to issues that users might encounter when attempting to log in to Pulse.

IF YOU HAVE NOT BEEN GIVEN ACCESS TO PULSE
If you attempt to log in to Pulse and see the "You have not been given access to Pulse" message,
your account has likely been disabled by a Pulse administrator. You should contact the administrator for assistance.

IF YOU HAVE AN INVALID USER NAME OR PASSWORD
If you attempt to log in to Pulse and see the "Invalid User Name or Password" message, you may
have entered your email address or password incorrectly. Enter the correct email address and password and try again.
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Editing Your Profile
AVAILABLE TO: Administrators, Employees, and Customers
When you register for an account, a profile is created for you in the Pulse system. See "Registering
for a Pulse Account" on page 310.
Registered Pulse users can edit their account profile by changing their personal information, uploading a profile image, and specifying notification settings.

Editing Profile Settings
Use the following steps to edit profile settings.

HOW TO EDIT YOUR PROFILE
1. Log into the Flare output using a registered Pulse account. See "Logging In to Pulse" on page
317.
2. Open the Settings page using one of these options:
n

Select the Community tab. Then click Edit My Profile.

n

In the topic toolbar, click
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3. You may be able to update the following information, depending the on the fields that have
been included and made editable by the Pulse Administrator. See "Configuring Profile Settings" on page 275.
n

First Name The first name of the user.

n

Last Name The last name of the user.

n

Email Address A valid email address for the user.

n

Title A title for the user, such as a professional or job title.

n

Department A department name for the user, such as Engineering or Sales.

n

Location A location for the user, such as La Jolla or New York City.

n

Phone A telephone number for the user.

n

Cell A mobile phone number for the user.

n

Skills & Expertise Click Edit Skills if you want to associate yourself with any skills added by
the Administrator. You can request new skills to be added by clicking I don't see my skill.

n

Experience Click Add Experience if you want to add any relevant experience, including
your company name, title, time period, and a description.

n

Education Click Add Education if you want to add any relevant educational background,
including your school name, dates attended, field of study, and a description.

n

Certification Click Add Certification if you want to add any relevant certifications, including your certificate name, year, and a description.

4. Click Save.
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Changing Your Profile Image
Use the following steps to change your profile image.

HOW TO CHANGE YOUR PROFILE IMAGE
1. In the Settings page, click Change Image.
2. In the dialog for your computer's operating system, navigate to the image that you want to
upload. This uploads your image and it appears in the Crop Your Image dialog.
3. Adjust the boundaries. Then click Crop and Save.
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Signing Up for Notifications
Use the following steps to sign up for notifications.

HOW TO SIGN UP FOR NOTIFICATIONS
1. In the Settings page, select the Notifications tab.
2. Select any of these notifications.
Notification Types

Description

Send me email

Sends you email when events related to you occur.

Answers

Notifies you when people post answers to your questions.

Comments

Notifies you when people comment on your posts.

Likes

Notifies you when people like your posts.

Follows

Notifies you when people follow you.

Updates

Notifies you when people post updates on your feed.

Mentions

Notifies you when people mention you in their posts.

Asks

Notifies you when people ask you a question.

Invites

Notifies you when people invite you to join Pulse system feeds.

Daily Digest

Send you one daily digest email containing all account-related Pulse
activity.

Tasks

Notifies you when users assign you a task.

Messages

Notifies you when people send you are direct message while you are
not actively using Pulse.

Skills & Expertise

Notifies you when changes are made to your skills and expertise.

Post Approved

Notifies you if you are using the moderation feature and a new post has
been approved by a moderator.
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Notification Types

Description

Post Rejected

Notifies you if you are using the moderation feature and a new post has
been rejected by a moderator.

Post Pending
Moderation

Notifies you if you are using the moderation feature and a new post is
waiting for approval by a moderator.

3. Click Save.
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Posting Content
Users can post content in a variety of ways, such as status updates, questions, articles, and tasks.

Posting Status Updates
AVAILABLE TO: Administrators, Employees, and Customers
All registered users can post status updates in the feeds associated with a Pulse system. The most
common place for an end user to post a status update is in a topic (i.e., the embedded discussion
form that appears under each topic in the Flare output). However, you can also post status updates
in any group, tag, or user feed that you have access permission to view.

HOW TO POST STATUS UPDATES
1. Log into the Flare output using a registered Pulse account.
2. Navigate to any Flare topic that has been mapped by a content developer to a Pulse feed. See
"Integrating Flare and Pulse" on page 126.
3. In the embedded discussion form below the topic, click Status.
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4. (Optional) Do any of the following if you would like to share a video, image, or file with your
status update:

HOW TO SHARE A VIDEO
Click Share Video. Then select a video to upload.

HOW TO SHARE AN IMAGE
Click Share Image. Then select an image to upload.
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HOW TO SHARE A FILE—UPLOAD OR LINK
Click Share File. Then select Upload a local file or Link to a file from the context menu.

5. Type your status update. You can also enter the @ sign and begin typing to mention a document, people, or groups. See "Mentioning Documents, People, and Groups" on page 350.
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6. When finished typing your update, you can click Share.
If you are responsible for moderating the Pulse feeds that are mapped to your Flare community or if
you are just interested in participating in a discussion, you have several options for responding to a
status update. See "Responding to Status Updates" on page 435.
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Posting Questions
AVAILABLE TO: Administrators, Employees, and Customers
All registered users can post questions in a Pulse feed and vote on answers. The most common
place for end users to ask questions is in a topic feed (i.e., the embedded discussion form that
appears under each topic in the Flare output). However, you can also post questions in any group,
tag, or user feed that you have access permission to view.

Posting a Question
Use the following steps to post a question.

HOW TO POST A QUESTION
1. Log into the Flare output using a registered Pulse account.
2. Navigate to any Flare topic that has been mapped by a content developer to a Pulse feed.
3. In the embedded discussion form below the topic, click Question.
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4. In the text field, type your question.
If you are a member of the Administrators or Employees group, a drop-down list will present
any similar questions in the Pulse system.

5. Click Share. Your question is posted to the feed for the current topic.
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Adding Details to a Question
Use the following steps to add details to a question.

HOW TO ADD DETAILS TO A QUESTION
After you post a question, you have the option of adding details to the question. This is useful when
you want to elaborate on your question.
1. After posting a question, click Add Details.

2. In the text editor that appears, add any relevant details. Then click the Save button in the toolbar.

This posts the details below the question.
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Voting for Answers
Use the following steps to vote for answers.

HOW TO VOTE FOR ANSWERS
Registered users can vote on answers. Over time, the users with the most votes become topic leaders.
1. Log into the Flare output or Pulse dashboard using a registered Pulse account.
2. Go to the desired question in any feed.
3. On the left side of an answer, click the Vote Up or Vote Down button.

The answer with the most votes moves higher in the answer list.
NOTE: If you are a member of the Administrators or Employees group, votes work
with the Find Leaders feature. See "Finding Topic Leaders" on page 425.

If you are responsible for moderating the Pulse feeds that are mapped to your Flare community or if
you are just interested in participating in a discussion, you have several options for responding to a
question. See "Responding to Questions" on page 436.
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Posting Articles
AVAILABLE TO: Administrators, Employees, and Customers
All registered users can create and post articles in the topic feeds associated with a Pulse system.
The most common place for end users to create articles is in a topic feed (i.e., the embedded discussion form that appears under each topic in the Flare output). However, you can also post articles
in any group, tag, or user feed that you have access permission to view.

HOW TO POST AN ARTICLE
1. Log into the Flare output using a registered Pulse account.
2. Navigate to any Flare topic that has been mapped by a content developer to a Pulse feed. See
"Integrating Flare and Pulse" on page 126.
3. In the topic feed, click Article. A text editor opens.
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4. In the text editor, do the following:
n

Title Type a title for the article in the space provided. You do not have the ability to
change the title of the article after you post it.

n

Body Type and format the body of your article. You can apply basic formatting for
emphasis, such as bold, italics, and underline. You can also create ordered and numbered
lists.

5. Click Share. The article is posted to the active feed.
If you are responsible for moderating the Pulse feeds that are mapped to your Flare community or if
you are just interested in participating in a discussion, you have several options for responding to an
article. See "Responding to Articles" on page 440.
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Assigning Tasks
AVAILABLE TO: Administrators, Employees, and Customers
All registered users can create, assign, and manage tasks with Pulse. This gives members of the
Customers group the ability to assign a task to any other registered user. It also gives members of
the Administrators and Employees groups the ability to assign tasks to each other in any topic,
group, tag, and user feed that you have access permission to view.

HOW TO CREATE AND ASSIGN TASKS
1. Log into the Flare output using a registered Pulse account.
2. In the embedded discussion form, click Task.

The task pane opens.
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3. In the task pane, complete the following fields. An asterisk (*) denotes a required field:
n

*Enter a name Type a name for the task.

n

Enter a description Type a description of the task.

n

Assigned To Assign the task to one or more Pulse users.
NOTE: Members of the Administrators and Employees group cannot assign
tasks to members of the Customers group.

NOTE: Members of the Customers group can assign tasks to any registered user
from the Flare output. However, only members of the Administrators and Employees group are permitted to manage tasks. See "Tasks" on page 417.

n

Tags Create a new tag or assign an existing tag to a post.

n

Due Set an optional due date for the task.

n

Importance Set the priority for the task.
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n

Status Set the status of the task.

4. When you are satisfied with the task, click Save. This closes the task pane.
The system sends a notification to the assigned user(s). When a task is assigned to you, you
have the option to accept or decline it. See "Tasks" on page 417.
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Responding to Posts
Users can respond to posts in a variety of ways, such as adding comments; following, liking, and tagging posts; and mentioning documents, people, and groups.

Adding Comments
AVAILABLE TO: Administrators, Employees, and Customers
All registered users can add comments to the posts (i.e., status updates, questions, articles, and
tasks) that people add in Pulse. You can add comments to posts that appear in any topic, group, tag,
and user feed that you have access permission to view.

HOW TO ADD COMMENTS
1. Log into the Flare output using a registered Pulse account.
2. Locate the post where you want to add a comment. You can add comments to status
updates, questions, articles, and tasks.
3. Click the Comment link. Then type your comment in the space provided.
4. Click the Comment button or press Enter to post your response.
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Following Posts
AVAILABLE TO: Administrators, Employees, and Customers
All registered users have the ability to follow a post. In Pulse, a post is a status update, question, article, or task. You can follow posts that appear in any topic, group, tag, and user feed that you have
access permission to view.

HOW TO FOLLOW A POST
1. In the Pulse dashboard or Flare output, navigate to the desired post.
2. Immediately below the post, click Follow.

Pulse begins notifying you about any activities relating to that post, such as new comments,
likes, follows, tags, and shares. See "Notifications" on page 355.
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HOW TO UNFOLLOW A POST
1. In the Pulse dashboard or Flare output, navigate to the desired post.
2. Immediately below the post you are following, click Unfollow.

Pulse stops notifying you about any activities relating to that post, such as new comments,
likes, follows, tags, and shares. See "Notifications" on page 355.

NOTE: If you are a member of the Administrators or Employees group, you have other
options for following community activity. See "Following Community Activities" on page
426.
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Liking and Unliking Activity
AVAILABLE TO: Administrators, Employees, and Customers
All registered users can like and unlike posts, just as you do with social media tools. You can like
(and subsequently unlike) posts that appear in any topic, group, tag, and user feed that you have
access permission to view.

HOW TO LIKE AND UNLIKE A POST
To like a post, click Like.

To unlike a post, click Unlike.
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Tagging Posts
AVAILABLE TO: Administrators, Employees, and Customers
Tags are simple keywords and short phrases that describe what a piece of online content is about.
In Pulse, tags are used as a means for categorizing Pulse feeds and Flare posts. Because tags can
be informally created and applied to a variety of Pulse content (e.g., status updates, questions, articles, tasks, images, and videos), they are a particularly useful to members of the Administrators and
Employees groups, as they help moderators better organize and find information. All registered
users can add tags to posts that appear in any topic, group, tag, and user feed that you have access
permission to view.

EXAMPLE
Let's say you are a member of the Administrators or Employees group and publishing
Flare output for a project titled "Pets." You might want to create a different tag for each
animal you've written a Flare topic about. For example, you might create tags for: cat,
dog, fish, hamster, parrot, and turtle. You can then apply these tags to the embedded
discussion form in Pulse.
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Let's say you are a member of the Customers group and when reading another user's
post, you decide you want to apply the existing tag (e.g., "dog") to a post. However, you
also want to create two new tags. For example, you might create tags for dog breed
and dog breed selector.
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HOW TO CREATE TAGS AND TAG CONTENT
Log into the Flare output using a registered Pulse account.
1. See "Logging In to Pulse" on page 317.
2. Locate a post in one of the topic feeds. In this example, we will show you how to add a tag to a
status update. However, registered users can add tags to questions, articles, tasks, images,
and videos.
3. Immediately below the post, click the Tag link.

4. In the Edit Tag dialog, you have these options:
n

CHAPTER 4

Create a New Tag Type a simple keyword or short phrase. Unlike some tagging utilities,
when a single tag consists of more than one word, you do not need to separate the
words with an underscore (i.e., if you want to add a tag named "dog breed," simply type
dog breed instead of dog_breed). However, if you are adding more than one tag,
you must separate each tag with a comma. Then click Update.
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EXAMPLE
Let's say you want to add the tags "dog" and "dog breed" to a post. Below
shows you how your tags would appear in the Edit Tag dialog before clicking Update.

After clicking Update, the tags that you created appear below the post.
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n

Add an Existing Tag Begin typing a simple keyword or short phrase. Then select a match
from the list that appears, and click Update.
EXAMPLE
Let's say you want to apply a tag that already exists to the post. Below
shows you how a list of existing tags appears so you can select a match.

After clicking Update, the tags that you created appear below the post.

NOTE: If you are a member of the Administrators or Employees groups, you have additional
options available to you when working with tags from the Flare content and Pulse dashboard.

NOTE: This feature also works with the Find Topic Leaders feature. See "Finding Topic
Leaders" on page 425.
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Mentioning Documents, People, and Groups
AVAILABLE TO: Administrators, Employees, and Customers
All registered users can use the Mentions feature to mention other registered users by name in
status updates, questions, articles, and comments. If users have added documents or groups to
Pulse, you can also insert mentions to those items.
Like many popular social media sites, this feature lets you type the @ sign and then start typing the
name of a document, person, or group to insert a mention. This is a useful tool for building social
relationships. It lets you express interest in others by highlighting a user in conversation. Its also a
great way to highlight a document, thank a group for their contribution, or just say congratulations
on a job well done.

HOW TO MENTION DOCUMENTS, PEOPLE, AND GROUPS
1. Log into the Flare output or Pulse dashboard using a registered Pulse account.
2. Navigate to the desired Pulse feed.
3. Type a status update, question, or comment. When you want to mention another registered
user, enter the @ sign and begin typing a name. A drop-down list reveals any matching documents, people, or groups.

4. Begin typing letters that match the user you want to mention. When a match is found, click
the match in the drop-down list.
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5. Finish typing your content and click Share. The content is posted and Pulse sends the people
mentioned a notification.
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Messaging
Users can take advantage of messaging in a variety of ways, such as general messaging tasks,
checking notifications, and sending chat messages.

Messaging Tasks
AVAILABLE TO: Administrators, Employees, and Customers
The Messages app gives you the ability to read, send, and hide conversations with other Pulse
users. You must access the Messages app from the Pulse dashboard. Messages are not accessible
from the Flare output.

Sending a New Message
Use the following steps to send a new message.

HOW TO SEND A NEW MESSAGE
1. Log in to the Pulse dashboard.
2. In the dashboard, choose one of these options:
n

From the menu bar, select Pulse > Messages.

n

In the top-right corner of the page, click the

button.

3. In the Messages page, click New Message.
4. In the New Message dialog, do the following:
n

To Start typing the name of a registered user and then select the appropriate match
from the list.

n

Message Type the body of your message in the space provided.

n

Add Attachment Click to add a file attachment.

5. Click Send.
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Viewing Messages
Use the following steps to view your messages.

HOW TO VIEW YOUR MESSAGES
1. Log in to the Pulse dashboard.
2. In the dashboard, choose one of these options:
n

From the menu bar, select Pulse > Messages.

n

In the top-right corner of the page, click the

button.

3. In the Messages page, your most recent messages and conversations appear in the list.
4. Click a message to open the conversation thread.

Loading Earlier Messages
Use the following steps to load earlier messages.

HOW TO LOAD EARLIER MESSAGES
1. Log in to the Pulse dashboard.
2. In the dashboard, choose one of these options:
n

From the menu bar, select Pulse > Messages.

n

In the top-right corner of the page, click the

button.

3. In the Messages page, your most recent messages and conversations appear in the list.
4. Click a message to open the conversation thread.
5. Click the Load earlier messages link.
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Replying to Messages
Use the following steps to reply to a message.

HOW TO REPLY TO A MESSAGE
1. Log in to the Pulse dashboard.
2. In the dashboard, choose one of these options:
n

From the menu bar, select Pulse > Messages.

n

In the top-right corner of the page, click the

button.

3. In the Messages page, click one of your messages. This opens the message or conversation.
4. In the space provided, type your reply.
5. If you want to add an attachment, click Add Attachment. Then select the file to attach.
6. Click Reply.

Downloading Message Attachments
Use the following steps to download a message attachment.

HOW TO DOWNLOAD A MESSAGE ATTACHMENT
1. Log in to the Pulse dashboard.
2. In the Pulse dashboard choose one of these options:
n

From the menu bar, select Pulse > Messages.

n

In the top-right corner of the page, click the

button.

3. In the Messages page, your most recent messages and conversations appear in the list.
4. Click a message to open the conversation thread.
5. Click the desired attachment to download it to your computer.

NOTE: If you do not know how to access the Pulse dashboard, see the Pulse Server Administrator for the Site URL. See "Pulse Server Configuration" on page 102.

CHAPTER 4

354

Notifications
AVAILABLE TO: Administrators, Employees, and Customers
Do you want to receive notifications when a Pulse users posts an answer to one of your questions?
Or be notified when someone asks a question about a particular Flare topic? Pulse provides users
with a convenient way to sign up to receive email notifications about different system events and
activities.

Notification Types
Pulse provides users with these notification types:
n

Comments Notifies you when people comment on your posts.See "Responding to Status
Updates" on page 435.

n

Answers Notifies you when people post answers to your questions.See "Posting Questions" on
page 332 and "Responding to Status Updates" on page 435.

n

Mentions Notifies you when people mention you in their posts.See "Mentioning Documents,
People, and Groups" on page 350.

n

Invites Notifies you when people invite you to join Pulse system feeds.To learn how to send
invites to users, see "Inviting People" on page 430.

n

Tasks Notifies you when you are assigned a task to complete. See "Assigning Tasks" on page
338.
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Checking Notifications
Pulse allows you to check your notifications.

HOW TO CHECK YOUR NOTIFICATIONS
1. Open the Notifications app using one of these options:
n

Flare Output In a web browser, navigate to the Flare output. Then log in to the Pulse system (see "Logging In to Pulse" on page 317). Click the Community tab in the Flare output.
Under the Your Apps list, click Notifications.

NOTE: The Your Apps list in the only available to members of the Administrators
and Employees groups. It is not available to members of the Customers group.

NOTE: You can select which applications display in the Your Apps menu. See
"Customizing the Your Apps Menu" on page 370.
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n

Pulse Dashboard Log in to the Pulse dashboard (see "Logging In to Pulse" on page
317). Then click
in the upper-right corner of the dashboard. In the drop-down message, click View All Notifications.
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2. In the Notifications page, all of your notifications are listed. You have these options:
n

Click one of the hyperlinks in the notifications page to open the corresponding Pulse
feed.

n

Click one of the buttons in the upper-right corner of the page to filter your notifications
by type.
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Signing Up for Email Notifications
When Pulse issues a notification, it appears in the Notifications app. If you would like Pulse to send
you an email message as well, enable the appropriate setting in the Notifications tab on the Settings
page of your profile. See "Editing Your Profile" on page 323.
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Sending Chat Messages
AVAILABLE TO: Administrators, Employees, and Customers
Chat features are available to all registered Pulse users. You can initiate a chat if you are a member
of the Customers group. Members of the Administrators and Employees group have additional chat
options. See "Contacting Registered Users" on page 366.

HOW TO INITIATE A CHAT SESSION
1. Log in to Pulse.
2. Hover the mouse cursor over a username.
3. When the popup menu appears, click the Chat button.

This reveals the Conversation with Customer Name window, where you can enter your message and attach a document. If the user is not online, Pulse will notify the recipient.
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Moderating Pulse
If you are a member of the Administrators or Employees group, there are two user interfaces for
moderating the activity in your Pulse system. You can use the Flare output or the Pulse dashboard
to moderate activity in a variety of ways.

Moderating Posts
AVAILABLE TO: By default, this feature is initially available only to Administrators and Employees,
because they have status as moderators. However, when configuring the privacy settings for the
community (i.e., system), you can assign moderation rights to other groups as well. See "Using the
Systems Menu" on page 226.
New Pulse communities will initially be set for moderation (i.e., requiring approval of new posts). If
you have a community that does not have this option set, you can select it in the Pulse dashboard.
Moderators will receive an email notification when there is a new post pending approval. You can
then click the link to that topic and accept or reject the post.

MODERATION ACTIONS BY USER GROUP
The moderation tasks that can be performed depend on the user group.
Moderation Actions

General Public

Customer

Employee

Administrator

Post Comments (must have approval)
Post Comments (without approval
See Pending Comments
See Rejected Comments
Approve Comments
Reject Comments
Delete Comments
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HOW TO MODERATE POSTS
1. Log in to the Pulse dashboard.
2. Select Systems > Find Systems. Then click the desired system link to configure it. The system
page appears.

3. In the system page, click Settings.The system's Feed Settings page opens.
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4. On the Basic tab, select the Moderation check box.

5. Click Save.
6. When a user posts to a topic, you will receive an email notification stating that the post is
pending approval. Click the topic link in the email. You should see an icon indicating that the
post has a pending status.
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7. Depending on what you want to do, click Approve or Reject.

8. If you select "Reject," choose a reason from the drop-down that displays, and click Reject
Activity. (Administrators can configure rejection reasons, adding as many as you need. See
"Configuring Moderation—Rejection Reasons" on page 280.)

NOTE: All moderators will receive email notifications when new posts require approval.
However, any moderator can update his or her email notifications to not receive those
types of emails (e.g., one administrator might be in charge of post approvals, whereas a
second administrator might be responsible for other tasks and doesn't need to be informed
of new posts). See "How to Sign Up for Notifications" on page 326.
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NOTE: If you opt to moderate all of your posts, there is no need to subscribe to them as well
since you will automatically receive emails with the moderation feature. However, if you
decide not to use the moderation feature, it is recommended that you subscribe to all of
your topics globally so that you are informed whenever someone posts to that topic. See
"Subscribing to Communities and Topics" on page 443.
Keep in mind that, with the global subscription route, email notifications are tied to each
community, whereas the moderation route sends email notifications to all moderators,
regardless of the community where the post was made. For example, let's say you've got
two documentation groups (Group A and Group B) producing different Flare outputs. Suppose someone in Group A creates a Pulse community associated with his Flare output and
publishes it. In addition, that person chooses the option to moderate posts for that community. Whenever an end user posts a comment to that Flare output, all moderators in both
Group A and Group B will receive a notification about that post. That might be fine for the
moderators in Group A, but the moderators in Group B may not want to see those emails,
because they have nothing to do with any of their outputs. There are two options to avoid
this kind of situation. First, you can install Pulse on two different servers—one for Group A
and the other for Group B. Second, you can make sure all communities are using the global
subscription method instead of moderation; so you'd be giving up moderation, but you'd be
able to work off the same server and you'd only receive email notifications for the communities to which you've subscribed.
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Contacting Registered Users
AVAILABLE TO: Administrators and Employees
Using the Pulse dashboard, members of the Administrators and Employees group can contact other
registered users using the chat and messaging features.

Using a Pulse Chat
Pulse offers members of the Administrators and Employees group a chat feature where you can initiate a conversation with any registered user. You can also send chat messages using the same
method available to members of the Customers group. See "Sending Chat Messages" on page 360.

HOW TO USE PULSE CHAT
1. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
2. Select People > Find People.
3. In the Find People page, click the desired user name.
4. In the user's page, click
browser.

. This opens a chat window in the lower-right corner of your

5. Enter a message text in the space provided. Then press Enter to send the conversation.
NOTE: If the user is not online, your conversation will appear in their Pulse inbox on
their Messages page. See "Using the Pulse Menu" on page 197.
6. Click the paperclip icon to add an attachment.
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Sending a Message
Registered users can create and send messages to other registered users. To learn about more of
the messaging features, see "Using the Pulse Menu" on page 197.

HOW TO SEND A MESSAGE
1. Log in to the Pulse dashboard.
2. In the dashboard, choose one of these options:
n

From the menu bar, select Pulse > Messages.

n

In the top-right corner of the page, click the

button.

3. In the Messages page, click New Message.
4. In the New Message dialog, do the following:
n

To Start typing the name of a registered user and then select the appropriate match
from the list.

n

Message Type the body of your message in the space provided.

n

Add Attachment Click to add a file attachment.

5. Click Send.
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Replying to a Message
Use the following steps to reply to a message.

HOW TO REPLY TO A MESSAGE
1. Log in to the Pulse dashboard.
2. In the dashboard, choose one of these options:
n

From the menu bar, select Pulse > Messages.

n

In the top-right corner of the page, click the

button.

3. In the Messages page, click one of your messages. This opens the message or conversation.
4. In the space provided, type your reply.
5. If you want to add an attachment, click Add Attachment. Then select the file to attach.
6. Click Reply.
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Contacting Users by Email
If your computer is set up with a local email client, such as Microsoft Outlook, you can launch it from
Pulse. This lets you send an email from your regular email account using the "mailto" command
(e.g., mailto:name@example.com).

HOW TO CONTACT USERS BY EMAIL
1. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
2. Select People > Find People.
3. In the Find People page, click the desired user.
4. Click the email link.

If your computer is properly configured, this opens your email client. If you do not know how to
configure an email client on your computer, please see your IT or Email Administrator.
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Customizing the Your Apps Menu
AVAILABLE TO: Administrators and Employees
If you are a member of the Administrators or Employees group, you have the ability to customize the
Your Apps menu commands that appear in the left navigation pane of your user feed. In addition, a
number of the commands that are available in the Your Apps menu are also available in the left navigation area of the group, tag, and topic feeds in Pulse.

About the Your Apps Menu
In order to view the Your Apps menu, you must be logged into Pulse from either the Pulse dashboard
or the Flare output. In the Flare output, you can access the Your Apps menu by selecting the Community tab. In the Pulse dashboard, select the Pulse > Home menu command to view the Your Apps
menu in your user feed. You can also navigate to different group, tag, and topic feeds and use the
commands that are available in the left navigation pane.
EXAMPLES
The Your Apps menu in the Flare output:
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The Your Apps menu in your user feed on the Pulse dashboard:
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LIST OF AVAILABLE APPS
The table below details the apps that are available in the Your Apps menu on your user feed (or in
the left navigation pane of the group, tag, or topic feeds in Pulse). An asterisk (*) by the App Name
denotes that an app is available by default on the Your Apps menu of your user feed.
App Name
Articles

Description
Read and review the articles posted to Pulse (see "Posting Articles"
on page 336).

Group
Feed

Tag Topic
Feed Feed

User
Feed

Learn More
"Articles " on
page 379

NOTE: For an article to
appear as an update
when using the Articles
app on your user feed, you
must be following the
group, tag, topic, or user
feed where the article
was posted. See "Following Community Activities" on page 426.

Files

Upload files to share with others,
and download files. See "Files" on
page 381.

"Files" on
page 381

Mentions*

Shows all of the times you were
mentioned in a conversation. See
"Mentioning Documents, People,
and Groups" on page 350.

"Mentions" on
page 401

Messages*

View and send messages to other
users.

"Messages"
on page 402

Moderation

View content that is pending,
awaiting moderation.

"Moderation"
on page 405
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App Name

Description

Group
Feed

Tag Topic
Feed Feed

User
Feed

Learn More

Most Recent* View and moderate the recent
Pulse community activity.

"Most Recent"
on page 407

Notifications*

"Notifications"
on page 408

Shows all of the notifications
you've received from the Pulse system. See "Notifications" on page
355.

NOTE: For a notification
to appear as an update
when using the Notifications app on your user
feed, you must be the
recipient of a notification
or following the group,
tag, topic, or user feed
where the corresponding
notification activity was
posted. See "Following
Community Activities" on
page 426.

Profile
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Open the Settings to update your
profile.

"Profile" on
page 410

373

App Name
Questions

Description
Read and respond to the questions added to Pulse. See "Posting
Questions" on page 332.

Group
Feed

Tag Topic
Feed Feed

User
Feed

Learn More
"Questions"
on page 410

NOTE: For a question to
appear as an update
when using the Questions
app on your user feed, you
must be following the
group, tag, topic, or user
feed where the question
was posted. See "Following Community Activities" on page 426.

Read it Later

Bookmark posts to add it to your
read it later list. See "Bookmarking
a Post to Read it Later" on page
434.

"Read It
Later" on
page 413

Tasks*

Assign and manage tasks. See
"Assigning Tasks" on page 338.

"Tasks" on
page 417
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App Name
Top News

Description
Shows you the most active posts
in Pulse.

Group
Feed

Tag Topic
Feed Feed

User
Feed

Learn More
"Top News"
on page 423

NOTE: For an activity to
appear as an update
when using the Top News
app on your user feed, you
must be following the
group, tag, topic, or user
feed where the activity
was posted. See "Following Community Activities" on page 426.

Statuses
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Shows the latest updates posted
to the selected feed.

"Statuses" on
page 415
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Customizing Menu Commands
Use the following steps to customize menu commands on the Your Apps menu.

HOW TO CUSTOMIZE THE MENU COMMANDS ON THE YOUR APPS MENU
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Depending on where you logged in, select the appropriate option:
n

Flare Output If you logged into the Flare output, click the Community tab. The Your Apps
menu appears in the left navigation pane.
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n

Dashboard If you logged into the Pulse dashboard, choose Pulse > Home to view the Your
Apps menu in your user feed.

3. Click the MORE link. This opens the Customize Your Apps dialog.
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4. Select the apps that you want to display in your user feed from the menu. A blue background
indicates the app is selected. This will not have an effect on the availability of menu commands on the group, tag, or topic feeds.

5. Close the Customize Your Apps dialog. The Your Apps menu is updated with your selections.
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Articles
AVAILABLE TO: Administrators and Employees
The Articles app gives you the ability to read the articles that have been posted to a specific group,
tag, topic, or user feed. In addition, it gives you the ability to edit the articles you've posted to a
feed. If you post an article, you have the ability to delete it. If you are a member of the Administrators group, you can also delete the articles that others post. To learn how to post an article, see
"Posting Articles" on page 336.

HOW TO OPEN THE ARTICLES APP
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Choose the appropriate option:
n

If you are logged into the Flare output, click the Community tab. The Your Apps menu
appears in the left navigation pane.
OR

n

If you are logged into the Pulse dashboard, navigate to the desired group, tag, topic, or
user feed. The Your Apps menu is on the left side of the page.

3. In the Your Apps menu (or left navigation pane of a group, tag, or topic feed), click Articles.
This reveals any articles that have been posted to the selected group, tag, topic, or user feed.
NOTE: You can select which applications display in the Your Apps menu. See "Customizing the Your Apps Menu" on page 370.

HOW TO EDIT AN ARTICLE
You can edit the body text of an article, but not the title. In addition, you can only edit the articles
that you post.
1. Navigate to the desired group, tag, topic, or user feed.
2. In the Your Apps menu (or left navigation pane of a group, tag, or topic feed), click Articles.
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3. In the Articles page under the desired post, click Edit. This link is only available if you posted
the original article.

4. In the article page, you may edit only the body of the article. You cannot modify article titles.

HOW TO DELETE AN ARTICLE
1. Navigate to the desired group, tag, topic, or user feed.
2. In the Your Apps menu (or left navigation pane of a group, tag, or topic feed), click Articles.
3. In the Articles page under the desired post, click the
ing articles:

link. Remember these rules for delet-

n

If you are a member of the Administrators group, you may delete any article.

n

If you are a member of the Employees group, you can only delete the articles you create.

4. In the Confirm Delete Activity box, click Delete Activity.
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Files
AVAILABLE TO: Administrators and Employees
There are two ways to share files in Pulse:
n

Files App The Files app works like a file sharing service within Pulse. Administrators and
Employees can use the Files app to share files in either their personal user feeds or in a group
feeds.

n

Files in Status Updates You can upload files when you post a status update. Anyone viewing
the status can click on the file to download it.

The following activities are supported in the Files app.
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HOW TO ACCESS THE FILES APP
1. Log in with an Administrator or Employee account.
2. Do one of the following:
n

Access Your Own User Feed This lets you manage folders and upload files on your own
feed. Others can then go to your page to download files.
On the Community tab of the Flare output, or on your Home page in the Pulse dashboard,
click the Files app. If the Files app is not displayed, you can add it by clicking the MORE
link.
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n

Access Another User's Feed This lets you view and download files another user has
uploaded.
In the Pulse dashboard, use the People menu to locate and select a particular user's feed.
Then on the left side of that user's page, click the Files app.
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n

Access a Group Feed This lets you open the page for a group and then upload or download files within it.
In the Pulse Dashboard, use the Groups menu to locate and select a group. Then on the
left side of the group page, click the Files app.
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HOW TO CREATE FOLDERS
1. Access the Files app where you want to create a folder. See "How to Access the Files App" on
page 382.
2. In the upper-right corner of the Files page, click New Folder.

3. In the dialog that opens, type a name for the folder and click Create Folder.
4. After the folder is added, you can click it and add other folders or files in it.
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HOW TO UPLOAD FILES
1. Access the Files app where you want to upload files. See "How to Access the Files App" on
page 382.
2. If you want to place the file in a subfolder, click that folder to open it.
3. In the upper-right corner of the Files page, click Upload Files.

4. In the dialog that opens, click Choose Files.
5. In the dialog that opens, find and select the file(s) that you want to upload, and click Open.
6. Click Upload Files.
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HOW TO DOWNLOAD A FOLDER AND ALL OF ITS FILES
1. Access the Files app where you want to download a folder and its files. See "How to Access
the Files App" on page 382.
2. If you stay at the root folder of the Files app all of the subfolders and files will be included in
the download. If necessary, you can open a subfolder to download all files within it.
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3. In the upper-right corner of the Files page, click Download Folder.

All of the subfolders and files are compressed into a ZIP file and downloaded.
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HOW TO DOWNLOAD AN INDIVIDUAL FILE
1. Access the Files app where you want to download a file. See "How to Access the Files App" on
page 382.
2. If necessary, open a subfolder to see the files within it.
3. Do one of the following:
n

Click the small box at the right end of the file row, and from the context menu click Download.

OR
n

Click the name of the file. A new page opens, just for that file. In the upper-right corner of
the page, click Download.
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HOW TO RENAME A FOLDER OR FILE
1. Access the Files app where you want to rename a folder or file. See "How to Access the Files
App" on page 382.
2. If necessary, open a subfolder to see the files within it.
3. Click the small box at the right end of the folder or file row, and from the context menu click
Rename.

4. In the dialog that opens, edit the name of the folder or file, and click Save.
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HOW TO DELETE A FOLDER OR FILE
1. Access the Files app where you want to delete a folder or file. See "How to Access the Files
App" on page 382.
2. If necessary, open a subfolder to see the files within it.
3. Click the small box at the right end of the folder or file row, and from the context menu click
Delete.

4. In the dialog that opens, click Delete Folder and Contents (if deleting a folder) or Delete Activity (if deleting an individual file).
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HOW TO MOVE A FOLDER AND FILE
These steps let you cut and paste a folder or file from one folder to another.
1. Access the Files app where you want to move a folder or file. See "How to Access the Files
App" on page 382.
2. If necessary, open a subfolder to see the files within it.
3. Click the small box at the right end of the folder or file row, and from the context menu click
Cut.

CHAPTER 4

393

4. Navigate to the folder where you want to move the other folder or file. You can use the breadcrumb links in the upper-left corner of the page to navigate.

5. After you navigate to another folder, at the top of the page click the Paste button.
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HOW TO SET SECURITY ACCESS FOR A FOLDER
1. Access the Files app where you want to set security access for a folder that you've created.
See "How to Access the Files App" on page 382.
2. Click the small box at the right end of the folder row, and from the context menu click
Security.

The page that opens displays which users or groups have access to the folder.
3. You can click Add a user or group to add others to the security access.
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4. You can also click the drop-down to the right to adjust the security permissions level of each
user or group.
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Following are the different security permission levels. These can also be configured on a system.
Option

Description

Owner

Provides full access to the system and its feeds. They can comment, post,
add and remove content, adjust system settings, and add feeds.

Moderator

Provides users in the group with the ability to moderate (approve or reject)
new posts in the community.

Contributor

Provides users and group members with the ability to post content to the system and its feeds.

Commenter

Provides users and groups members with the ability to comment on system
post and its feeds. This setting does not allow individuals to post content
themselves.

Viewer

Provides users and group members with read-only access to the system and
its feeds.
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HOW TO SHARE A LINK TO A FILE
These steps let you create a link to a file you've uploaded. You can then copy and send that link to
someone. This allows the file to be opened by anyone who has access to your server, whether they
are registered in your Pulse community or not.
1. Access the Files app where you want to share a file link. See "How to Access the Files App" on
page 382.
2. If necessary, open a subfolder to see the files within it.
3. Click the name of the file. A new page opens, just for that file.
4. At the top of the page, click Share Link.

5. In the dialog that opens, click Get Link. A URL is generated.
6. Copy the link that is generated and send it to an individual. When you are finished with the dialog, either click the small red x in the upper-right corner or click Share Link again.
WARNING: Do not click "Delete Link"; that button will erase the generated link, and
once you do that, the other person will not be able to access the file.
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HOW TO UPLOAD A NEW VERSION OF A FILE
You can use the following steps if you've already uploaded a file but want to replace it with a newer
version.
1. Access the Files app where you want to upload a newer version of a file. See "How to Access
the Files App" on page 382.
2. If necessary, open a subfolder to see the files within it.
3. Click the name of the file. A new page opens, just for that file.
4. At the top of the page, click Upload New Version.

5. In the dialog that opens, select the new version of the file and click Open.
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HOW TO VIEW THE ACTIVITY LOG FOR A FILE
You can use the following steps to see the activity for a file that has been uploaded.
1. Access the Files app where you want to upload a newer version of a file. See "How to Access
the Files App" on page 382.
2. If necessary, open a subfolder to see the files within it.
3. Click the name of the file. A new page opens, just for that file.
4. At the top-left of the page, click the drop-down and select Activity Log.

NOTE: On the General Settings page of the Pulse dashboard, Administrators can control
whether file sharing is available for users only or for groups as well. At the bottom of this
page is a Files drop-down that lets you make a selection.
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Mentions
AVAILABLE TO: Administrators and Employees
The Mentions app is available in your user feed. It gives you the ability to see all the times you were
mentioned in post by other Pulse users. To learn how to mention a user by name in a post, see
"Using Mentions" on page 448 and "Mentioning Documents, People, and Groups" on page 350.

HOW TO OPEN THE MENTIONS APP
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group. See "Logging In to Pulse" on page 317.
2. Choose the appropriate option:
n

If you are logged into the Flare output, click the Community tab. The Your Apps menu
appears in the left navigation pane.
OR

n

If you are logged into the Pulse dashboard, navigate to your user feed. The Your Apps
menu is on the left side of the page.

3. In the Your Apps menu, click Mentions.
This reveals a list of all the posts where your user name was mentioned.
NOTE: You can select which applications display in the Your Apps menu. See "Customizing the Your Apps Menu" on page 370.
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Messages
AVAILABLE TO: Administrators and Employees
The Messages app is available in your user feed and gives you the ability to exchange messages
with other Pulse users. It also gives you the ability to hide your messages.

HOW TO OPEN THE MESSAGES APP
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Choose the appropriate option:
n

If you are logged into the Flare output, click the Community tab. The Your Apps menu
appears in the left navigation pane.
OR

n

If you are logged into the Pulse dashboard, navigate to your user feed. The Your Apps
menu is on the left side of the page.

3. In the Your Apps menu, click Messages.
This reveals a list of your Pulse messages.
NOTE: You can select which applications display in the Your Apps menu. See "Customizing the Your Apps Menu" on page 370.
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HOW TO CREATE A NEW MESSAGE
1. Navigate to your user feed.
2. In the Your Apps menu, click Messages.
3. In the Messages page, click New Message.
4. In the Messages dialog, do the following:
n

To Start typing the name of a registered user and then select the appropriate match
from the list.

n

Message Type the body of your message in the space provided.

n

Add Attachment Click to add a file attachment.

5. When finished, click Send. The message is sent to the user and a copy of the conversation
thread appears in the Messages page.

HOW TO READ AND REPLY TO A MESSAGE
1. Navigate to your user feed.
2. In the Your Apps menu, click Messages. Your messages appear in the list.
3. In the Messages page, click one of the messages in the list to open the conversation thread.
4. (Optional) If you want to reply to a message, choose from these options:
n

Type a reply in the space provided.
AND/OR

n

Click the paperclip to add an attachment.

5. Click Reply.
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HOW TO HIDE A CONVERSATION
1. Navigate to your user feed.
2. In the Your Apps menu, click Messages. Your messages appear in the list.
3. In the Messages page, click the Hide Conversation link (the x) to remove it from the page.
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Moderation
AVAILABLE TO: Administrators and Employees
The Moderation app is available in your user feed and gives you the ability to view posts that are
pending moderation. You can then approve or reject any of those posts. In addition, you can use the
Moderation app to view posts that have previously been rejected. See "Moderating Posts" on page
361.

HOW TO OPEN AND USE THE MODERATION APP
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Choose the appropriate option:
n

If you are logged into the Flare output, click the Community tab. The Your Apps menu
appears in the left navigation pane.
OR

n

If you are logged into the Pulse dashboard, navigate to the desired group, tag, topic, or
user feed. The Your Apps menu is on the left side of the page.

3. In the Your Apps menu, click Moderation.
NOTE: You can select which applications display in the Your Apps menu.See "Customizing the Your Apps Menu" on page 370.
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4. After the app is open, you can select options to see all pending posts or those that have previously been rejected. You can click Approve or Reject at the bottom of a pending post.
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Most Recent
AVAILABLE TO: Administrators and Employees
The Most Recent app is available in your user feed and gives you the ability view the latest community activity in Pulse. This includes status updates, questions, articles, and more. This is a helpful
way to view updates in chronological order.

HOW TO VIEW THE MOST RECENT ACTIVITY
You can open the Most Recent page from the Flare output or Pulse dashboard.
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Choose the appropriate option:
n

If you are logged into the Flare output, click the Community tab. The Your Apps menu
appears in the left navigation pane.
OR

n

If you are logged into the Pulse dashboard, navigate to the desired group, tag, topic, or
user feed. The Your Apps menu is on the left side of the page.

3. In the Your Apps menu (or left navigation pane), click Most Recent.
This reveals the most recent post activities for the selected group, tag, topic, or user feed.
NOTE: You can select which applications display in the Your Apps menu. See "Customizing the Your Apps Menu" on page 370.
4. Review the content in the list. You can comment, like, edit, follow, tag, and share the most
recent posts.
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Notifications
AVAILABLE TO: Administrators and Employees
The Notifications app is available in your user feed and gives you the ability to view and filter a list of
Pulse notifications. You can open the Notifications app from the Community tab of the Flare output
or Pulse dashboard.

HOW TO OPEN THE NOTIFICATIONS APP
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Choose the appropriate option:
n

If you are logged into the Flare output, click the Community tab. The Your Apps menu
appears in the left navigation pane.
OR

n

If you are logged into the Pulse dashboard, navigate to your user feed. The Your Apps
menu is on the left side of the page.

3. In the Your Apps menu, click Notifications.
This reveals a list of your Pulse notifications.
NOTE: You can select which applications display in the Your Apps menu.See "Customizing the Your Apps Menu" on page 370.

4. Review the notifications in the list. You can click the available links to navigate to any items of
interest.
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HOW TO VIEW A LIST OF NOTIFICATIONS
1. Navigate to your user feed.
2. In the Your Apps menu, click the Notifications app.
3. In the Notifications page, review the activity in the Notifications page. You can click the hyperlinks to view the related content.

HOW TO FILTER THE NOTIFICATIONS
1. Navigate to your user feed.
2. In the Your Apps menu, click the Notifications app.
3. In the Notifications page, click one of the buttons to view only that type of content.
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Profile
AVAILABLE TO: Administrators and Employees
In the Your Apps menu, the Profile menu item opens the Settings page so you can edit your profile.

Questions
AVAILABLE TO: Administrators and Employees
The Questions app gives you the ability to read the questions that have been posted to a specific
group, tag, topic, or user feed. If you are a member of the Administrators group, you also have the
ability to delete the questions and answers that have been posted.

HOW TO OPEN THE QUESTIONS APP
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Choose the appropriate option:
n

If you are logged into the Flare output, click the Community tab. The Your Apps menu
appears in the left navigation pane.
OR

n

If you are logged into the Pulse dashboard, navigate to the desired group, tag, topic, or
user feed. The Your Apps menu is on the left side of the page.

3. In the Your Apps menu (or left navigation pane), click Questions.
This reveals any questions that have been posted to the group, tag, topic, or user feed.
NOTE: You can select which applications display in the Your Apps menu. See "Customizing the Your Apps Menu" on page 370.
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HOW TO FILTER THE QUESTIONS
1. Navigate to the desired group, tag, topic, or user feed.
2. In the Your Apps menu (or left navigation pane), click Questions.
3. In the Questions page, click one of the buttons at the top of the list to filter the list of questions. You can filter questions by:
n

Recent View the most recent questions.

n

Unanswered View any unanswered questions.

n

Uncategorized View the questions that have not been tagged.

n

Asked by Me View the questions you posted.

n

Followed by Me View questions asked by people you follow.
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HOW TO ANSWER A QUESTION
1. Navigate to the desired group, tag, topic, or user feed.
2. Under the question, click Answer.
3. In the Answer field, type a response.
4. Click Answer to submit the answer.

HOW TO DELETE A QUESTION
1. Navigate to the desired group, tag, topic, or user feed.
2. In the Your Apps menu (or left navigation pane), click Questions.
3. In the Questions page under the desired post, click
information:

. Remember these rules for deleting

n

If you are a member of the Administrators group, you can delete any question.

n

If you are a member of the Employees group, you can only delete the questions you posted.

4. In the Confirm Delete Activity dialog, click Delete Activity to permanently remove the file.
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Read It Later
AVAILABLE TO: Administrators and Employees
The Read it Later app is available in your user feed and gives you the ability to view the post activity
that you bookmarked earlier. See "Bookmarking a Post to Read it Later" on page 434.

HOW TO OPEN THE READ IT LATER APP
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Choose the appropriate option:
n

If you are logged into the Flare output, click the Community tab. The Your Apps menu
appears in the left navigation pane.
OR

n

If you are logged into the Pulse dashboard, navigate to the desired group, tag, topic, or
user feed. The Your Apps menu is on the left side of the page.

3. In the Your Apps menu, click Read it Later.
The reveals a list of all the posts you have bookmarked. See "Bookmarking a Post to Read it
Later" on page 434.
NOTE: You can select which applications display in the Your Apps menu. See "Customizing the Your Apps Menu" on page 370.
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REVIEWING A READ IT LATER POST
For each post that you add to your read it later page, you have these options:
n

Comment Post a comment.

n

Like Like the post.

n

Follow Follow post activities.

n

Tag Add a tag to the post.

n

Share Share the post with other registered users.

REMOVING A POST FROM YOUR READ IT LATER PAGE
If you want to remove the bookmark, click the blue
icon until it turns gray. A gray checkmark
indicates the next time you open or refresh the page, the post will no longer appear on your Read it
Later page.
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Statuses
AVAILABLE TO: Administrators and Employees
The Statuses app gives you the ability to view the latest updates posted to the selected feed. See
"Posting Status Updates" on page 328.

HOW TO OPEN AND USE THE STATUSES APP
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Choose the appropriate option:
n

If you are logged into the Flare output, click the Community tab. The Your Apps menu
appears in the left navigation pane.
OR

n

If you are logged into the Pulse dashboard, navigate to the desired group, tag, topic, or
user feed. The Your Apps menu is on the left side of the page.

3. In the Your Apps menu, click Statuses.
NOTE: You can select which applications display in the Your Apps menu. See "Customizing the Your Apps Menu" on page 370.
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4. After the app is open, you can filter the statuses shown for those containing links, files,
images, videos, or everything.
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Tasks
AVAILABLE TO: Administrators and Employees
The Tasks app gives you the ability to create, view, and manage task activity. You can open the
Tasks app from the Community tab of the Flare output or Pulse dashboard.

HOW TO OPEN THE TASKS APP
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Choose the appropriate option:
n

If you are logged into the Flare output, click the Community tab. The Your Apps menu
appears in the left navigation pane.
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n

If you are logged into the Pulse dashboard, navigate to the desired group, tag, topic, or
user feed. The Your Apps menu is on the left side of the page.

3. In the Your Apps menu (or left navigation pane), click Tasks.
This reveals a list of all the tasks for the selected group, tag, topic, or user feed.
NOTE: You can select which applications display in the Your Apps menu. See "Customizing the Your Apps Menu" on page 370.

CHAPTER 4

418

HOW TO MANAGE YOUR TASKS
If you are a member of the Administrators or Employees group and a user assigns you a task in
Pulse, you have the option to accept or decline the task. You can also update the task.
1. Navigate to the desired group, tag, topic, or user feed.
2. In the Your Apps menu (or left navigation pane), click Tasks.
3. In the Tasks page, any tasks that have been assigned to you appear in the list. You have these
options:

HOW TO DECLINE A TASK
In the Tasks page, click the ACCEPT? button. Then select Decline Task from the context
menu.
A task declined message appears and the status of the button label changes to declined.

HOW TO ACCEPT A TASK
In the Tasks page, click the ACCEPT? button. Then select Accept Task from the context
menu.

HOW TO MARK A TASK COMPLETE
In the Tasks page, click the ACCEPT? button. The select Mark Complete. This immediately
places the task to the completed status.

HOW TO UPDATE A TASK
a. In the Tasks page, click a task to view the details:
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The tasks pane opens.
b. In the task pane, make any desired changes.

c. Click Save.
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HOW TO FILTER TASKS
By default, the Tasks page shows a list of all the tasks that have been assigned to you.
You can filter the list display by clicking
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HOW TO FILTER TASKS BY PEOPLE
Click

and select one of these options from the drop-down menu:

n

Assigned to Anyone Shows tasks assigned to you and tasks assigned to others by you.

n

Assigned to Me Shows tasks assigned to you

n

Assigned by Me Shows tasks that you assigned to other users.

n

Assigned to My Direct Reports Shows tasks assigned to your Direct Reports folder. Direct Reports is an option you can select in the Notifications tab of the Settings page that
deliver daily reports to your email.

HOW TO FILTER TASKS BY VIEW
In the Your Apps menu, click Tasks. Then click
drop-down menu:

and select one of these options from the

n

Status Shows tasks assigned by current status.

n

Upcoming Shows tasks with upcoming due dates.
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Top News
AVAILABLE TO: Administrators and Employees
The Top News app is available in your user feed. It gives you the ability to create, view, and manage
the most popular activity in Pulse.

HOW TO OPEN THE TOP NEWS APP
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Choose the appropriate option:
n

If you are logged into the Flare output, click the Community tab. The Your Apps menu
appears in the left navigation pane.
OR

n

If you are logged into the Pulse dashboard, navigate to the desired group, tag, topic, or
user feed. The Your Apps menu is on the left side of the page.

3. In the Your Apps menu, click Top News.
This reveals the top news in your user feed.
NOTE: You can select which applications display in the Your Apps menu. See "Customizing the Your Apps Menu" on page 370.
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HOW TO DELETE A TOP NEWS POST
1. Navigate to your user feed.
2. In the Your Apps menu, click Top News.
next to the post that you want to delete. Remember these
3. In the Top News page, click
rules for deleting information:
n

If you are a member of the Administrators group, you may delete any post containing a
hyperlink.

n

If you are a member of the Employees group, you can only delete the posts that you
shared in Pulse.

4. In the Confirm Delete Activity dialog, click Delete Activity to permanently remove the Top
News post.
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Finding Topic Leaders
AVAILABLE TO: Administrators and Employees
The Find Topic Leaders feature works with tags and questions (see "Tagging Posts" on page 345
and "Responding to Questions" on page 436). When your users vote on the best answers to questions, the user who posts the most answers and gets the most votes are ranked on a topic leaders
list.

HOW TO FIND A TOPIC LEADER
1. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
2. Select Tags > Find Tags.
3. In the Find Tags list, click the desired tag to open its page.
4. At the bottom of the tag page, click the Find Topic Leaders link.

The Find Topic Leaders page opens. This page ranks all of the users who have posted
answers to questions with the specific tag. It also shows the total number of votes the answer
has received.
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Following Community Activities
AVAILABLE TO: Administrators and Employees
To help you stay connected with your users, members of the Administrators and Employees group
can follow a variety of community activities. Following activities gives you the ability to view updates
in the Your Apps menu on the Home page (Pulse > Home) of the Pulse dashboard. See "Customizing
the Your Apps Menu" on page 370.

Following Users From the Pulse Dashboard
You can follow other users who are members of the Administrators or Employees group.

HOW TO FOLLOW A USER—PULSE DASHBOARD
1. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
2. Select People > Find People.
3. In the Find People page, locate and click the name of the user that you want to follow. This
opens the user's system feed.
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NOTE: You can only follow users who are members of the Administrators or Employees group.
4. Click the Follow button. Pulse will now notify you about user activities. After following a user,
you have these options:

HOW TO OPEN YOUR FOLLOWED BY ME LIST
a. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
b. Select People > Followed by Me. This opens a list of all the users that you follow.

HOW TO STOP FOLLOWING A USER
a. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
b. Select People > Followed by Me. This opens a list of all the users that you follow.
c. Click the user you want to stop following. This opens the user's feed.
d. Click Unfollow. Pulse will not longer notify you about activities involving that user.
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Following Users From the Flare Output
You can follow other users who are members of the Administrators or Employees group.

HOW TO FOLLOW A USER—FLARE OUTPUT
1. Log in to the Flare output using an account that is a member of the Administrators or Employees group.
2. In the Pulse form, hover over the name of the user you want to follow. A popup window
appears.
3. Click Follow. Pulse will now notify you about user activities. After following a user, you have
these options:
NOTE: You can only follow other members of the Administrators or Employees group.

HOW TO STOP FOLLOWING A USER
1. Log in to the Flare output using an account that is a member of the Administrators or Employees group.
2. In the Pulse form, hover over the name of the user you want to stop following. Then click
Unfollow. Pulse will no longer notify you about activities involving that user.

Following Searches
You can search for Pulse content in the Pulse dashboard and then follow your searches.

HOW TO FOLLOW SEARCHES
1. Log in to the Pulse dashboard using an account that is a member of the Administrators or
Employees group.
2. In the search field, type your search term. Then select Search for Posts with this Phrase from
the context menu.
3. In the results page, click Follow.
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Following Topics
You can subscribe to a feed when you want to follow any community activity for a topic. You can
also add a topic's feed to your Favorites list:
n

Subscribe to a Feed See "Subscribing to Communities and Topics" on page 443.

n

Work With Favorites See "Working With Favorites" on page 449.

NOTE: Following posts is available to all registered Pulse users. See "Following Posts" on
page 342.

NOTE: Users can apply tags to posts. Tags make it easier for readers to find posts about a
specific subject in Pulse. For example, you can tag all topics about cats with a "cat" tag. See
"Tagging Posts" on page 345.
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Inviting People
AVAILABLE TO: Administrators and Employees
Members of the Administrators or Employees group can send invitations to other Administrators
and Employees to read, follow, or subscribe to a specific topic, group, tag, or user.

Sending Invites
Use the following steps to send invites to people.

HOW TO SEND INVITES TO PEOPLE
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Navigate to a topic, group, tag, or user. Then click the Invite People link.

This opens the Invite People dialog.
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3. In the Invite People dialog, type all or part of a user or group name. Then place a check mark
next to the desired matches and click Invite.

The system sends an invitation to the designated recipients.

CHAPTER 4

431

Responding to Invites
Use the following steps to respond to invites.

HOW TO RESPOND TO INVITES
You can invite registered users to follow a topic, group, tag, or user.
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Check your notifications for invites. See "Notifications" on page 355.
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3. Click the invitation.
In this example, the user was invited to join the group for the Welcome topic, as shown below.
You can then perform a variety of different tasks.
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Bookmarking a Post to Read it Later
AVAILABLE TO: Administrators and Employees
The "Read it Later" feature let's you bookmark status updates, questions, articles, and tasks so you
can read the information more closely at a later time.

HOW TO ADD A POST TO YOUR READ IT LATER PAGE
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Navigate to a topic, user, group, or tag feed.
3. Hover over the upper-right corner of any post in the discussion form. A gray bookmark
appears.

4. Click the gray bookmark so it turns blue
added to your Read it Later page.

. A blue bookmark indicates the post has been

NOTE: You can repeat this step for as many different posts as you want.

NOTE: To remove a post from the Read it Later page, click the blue bookmark so it
turns gray.
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Responding to Status Updates
AVAILABLE TO: Administrators, Employees, and Customers
When a registered user posts a new status update, you have several options if you choose to
respond to the post.
The list below describes each available response. An asterisk (*) denotes that the option is only available to members of the Administrators and Employees group:
n

Add a Comment Click Comment. Then type your comment and press Enter to post it. See
"Adding Comments" on page 341.

n

Like the Post Click Like. This adds your name to a list of users who likes the post. See "Liking
and Unliking Activity" on page 344.

n

Follow the Post Click Follow. Pulse will send a notification to you when there is any postrelated activity (see "Following Community Activities" on page 426). When you create a post,
Pulse automatically selects the follow option for you. You can unfollow any posts you might
be following.

n

Tag the Post Click Tag. This opens the Edit Tag dialog so you can add one or more tags to the
post. See "Tagging Posts" on page 345.

n

*Share the Post Click Share. This opens the Share Activity dialog so you can type a message
and then choose to share the message and post on your feed , someone else's feed, or in a
group. See "Sharing Posts" on page 442.
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Responding to Questions
AVAILABLE TO: Administrators, Employees, and Customers
When a registered user posts a question, you have several options if you choose to answer it.
The list below describes each available response. An asterisk (*) denotes that the option is only available to members of the Administrators and Employees group:
n

Answer the Question Type an answer in the Answer field and press Enter to post it. See "How
to Answer a Question" on the next page.

n

Ask a Specific User for an Answer Click Ask to open the Ask dialog. This lets you solicit a
response to the post from the people you select. See "How to Ask a Specific User or Group for
an Answer" on page 438.

n

Add a Comment Click Comment. Then type your comment and press Enter to post it. See
"Adding Comments" on page 341.

n

Like the Post Click Like. This adds your name to a list of users who likes the post. See "Liking
and Unliking Activity" on page 344.

n

Follow the Post Click Follow. Pulse will send a notification to you when there is any postrelated activity (see "Following Community Activities" on page 426). When you create a post,
Pulse automatically selects the follow option for you. You can unfollow any posts you might
be following.

n

Tag the Post Click Tag. This opens the Edit Tag dialog so you can add one or more tags to the
post. See "Tagging Posts" on page 345.

n

*Share the Post Click Share. This opens the Share Activity dialog so you can type a message
and the choose to share the message and post on your feed , someone else's feed, or in a
group. See "Sharing Posts" on page 442.
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HOW TO ANSWER A QUESTION
1. Navigate to any Flare topic where a question has been posted.
2. In the Answer field, type your response. Then click Answer or press Enter.

VOTING FOR ANSWERS
All registered users have the ability to vote for answers in the Flare output and Pulse dashboard. If
you want to vote for an answer, you have these options:
n

Vote Up Click the up arrow to vote in favor of the given answer.

n

Vote Down Click the down arrow to vote against the given answer.
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The more votes an answer receives, the higher it moves up in the display order. The answer with the
most votes is listed closest to the question.

If a user decides to add one or more tags to the question, voting on an answer will add weight to the
Pulse user's expertise rating. See "Finding Topic Leaders" on page 425.

HOW TO ASK A SPECIFIC USER OR GROUP FOR AN ANSWER
If you are a member of the Administrators or Employees group and know of a particular individual
(or Pulse group) that might have an answer to the question, you can solicit their input using the Ask
option.
1. Navigate to any Flare topic where a question has been posted.
2. In the question area, click the Ask link.

The Ask for an Answer dialog appears.
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3. In the Select the people you would like to ask for an answer box, type a full or partial name or
email address. Place a check mark next to the users (or groups) to ask.

4. In the dialog, click the Ask button.
Pulse notifies the selected people. The user will be notified then next time he or she logs in to
the Pulse dashboard.
NOTE: To receive the notification message by email, the user must enable the appropriate feature in the Notifications tab on the Settings page of their profile. See "Editing Your Profile" on page 323.
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Responding to Articles
AVAILABLE TO: Administrators, Employees, and Customers
When a registered user posts a new article, you have several options if you choose to respond.

The list below describes each available response. An asterisk (*) denotes that the option is only available to members of the Administrators and Employees group:
n

Add a Comment Click Comment. Then type your comment and press Enter to post it. See
"Adding Comments" on page 341.

n

Like the Post Click Like. This adds your name to a list of users who likes the post. See "Liking
and Unliking Activity" on page 344.

n

Edit the Post Click Edit. Then make any changes. This option is only available when you author
the post.

n

Follow the Post Click Follow. Pulse will send a notification to you when there is any postrelated activity. See "Following Community Activities" on page 426. When you create a post,
Pulse automatically selects the follow option for you. You can unfollow any posts you might
be following.

n

Tag the Post Click Tag. This opens the Edit Tag dialog so you can add one or more tags to the
post. See "Tagging Posts" on page 345.

n

*Share the Post Click Share. This opens the Share Activity dialog so you can type a message
and the choose to share the message and post on your feed , someone else's feed, or in a
group. See "Sharing Posts" on page 442.
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Responding to Tasks
AVAILABLE TO: Administrators, Employees, and Customers
All registered users can respond to task assignments posted in the topic feeds associated with a
Pulse system (i.e., the embedded discussions forms that appear at the bottom of each topic in the
Flare output).
If you have not been assigned a task, the list below describes each available response that is available. Members of the Customers and Employees group can edit tasks, with the exception of
the Tags field. When tasks are changed, Pulse sends a notification to the task owner.
n

Add a Comment Click Comment. Then type your comment and press Enter to post it. See
"Adding Comments" on page 341.

n

Like the Post Click Like. This adds your name to a list of users who likes the post. See "Liking
and Unliking Activity" on page 344.

n

Edit the Post Click Edit. Then make any changes. This option is only available when you author
the post.

n

Follow the Post Click Follow. Pulse will send a notification to you when there is any postrelated activity. See "Following Community Activities" on page 426. When you create a post,
Pulse automatically selects the follow option for you. You can unfollow any posts you might
be following.

n

Tag the Post Click Tag. This opens the Edit Tag dialog so you can add one or more tags to the
post. See "Tagging Posts" on page 345.

n

*Share the Post Click Share. This opens the Share Activity dialog so you can type a message
and the choose to share the message and post on your feed , someone else's feed, or in a
group. See "Sharing Posts" on the next page.

NOTE: If you have been assigned a task and you are a member of the Administrators or
Employees group, you also have a number of task management options. See "Tasks" on
page 417.
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Sharing Posts
AVAILABLE TO: Administrators and Employees
You can share Pulse posts on your own feed, on someone else's feed, and in a group.

HOW TO SHARE A POST
1. Immediately below a post, click the Share link.

This opens the Share Activity dialog.
2. In the Share Activity dialog, type a message in the Message field.
3. In the Share list, select one of these options:
n

On your own feed This lets you share the article on your feed.

n

On someone else's feed This lets you share the article on the feeds of the registered
users you specify. If you select this option, type the user name(s) in the People field.

n

In a group This lets you share the article in a group feed. If you select this option, type the
group name(s) in the Group field.

4. Click OK.
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Subscribing to Communities and Topics
AVAILABLE TO: The ability to subscribe to communities is available to Administrators and Employees only. The ability to subscribe to single topics is available to Administrators, Employees, and Customers.
If you want to be notified when Pulse users post updates, questions, and articles, you must subscribe to the community or a topic.
Subscribing to a community globally is recommended because you are then receive email notifications when activity occurs on any topics within that community.
Alternatively, if you subscribe only to a single topic, you will be notified only when activity occurs on
that specific topic. Depending on your access permissions, you can also subscribe to feeds that are
associated with groups, tags, and users.

HOW TO SUBSCRIBE TO A COMMUNITY
1. Log in to the Pulse dashboard with an Administrator or Employee account.
2. Select Systems > Find Systems.
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3. On the Find Systems page, locate and click your community.

4. On the page that opens, click the envelope icon in the upper-right corner.
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The pressed look of the icon indicates that you have subscribed to the community.

HOW TO SUBSCRIBE TO A SINGLE TOPIC
1. Log in to Pulse from the Flare output or using the Pulse dashboard. See "Logging In to Pulse"
on page 317.
2. Navigate to the desired Flare topic feed, user feed, group feed, or tag feed. Then click
have these options:

.You

HOW TO SUBSCRIBE TO A SINGLE TOPIC FROM THE FLARE OUTPUT
The table below describes your subscription options in the Flare output.
Feed Type

Instructions

System Feed

Navigate to a Flare topic.

User Feed

Click a user name to reveal the user's feed.

Group Feed

Click a group name to reveal the group's page.

Tag Feed

Click a tag to reveal the tag's page.
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HOW TO SUBSCRIBE TO A SINGLE TOPIC FROM THE PULSE DASHBOARD
The table below describes your subscription options in the Pulse dashboard.
Feed Type

Instructions

System Feed

Navigate to a Flare topic.

User Feed

Click a user name to reveal the user's feed.

Group Feed

Click a group name to reveal the group's page.

Tag Feed

Click a tag to reveal the tag's page.

NOTE: If you opt to moderate all of your posts (see "Moderating Posts" on page 361), there
is no need to subscribe to them as well since you will automatically receive emails with the
moderation feature. However, if you decide not to use the moderation feature, it is recommended that you subscribe to all of your topics globally so that you are informed whenever
someone posts to that topic.
Keep in mind that, with the global subscription route, email notifications are tied to each
community, whereas the moderation route sends email notifications to all moderators,
regardless of the community where the post was made. For example, let's say you've got
two documentation groups (Group A and Group B) producing different Flare outputs. Suppose someone in Group A creates a Pulse community associated with his Flare output and
publishes it. In addition, that person chooses the option to moderate posts for that community. Whenever an end user posts a comment to that Flare output, all moderators in both
Group A and Group B will receive a notification about that post. That might be fine for the
moderators in Group A, but the moderators in Group B may not want to see those emails,
because they have nothing to do with any of their outputs. There are two options to avoid
this kind of situation. First, you can install Pulse on two different servers—one for Group A
and the other for Group B. Second, you can make sure all communities are using the global
subscription method instead of moderation; so you'd be giving up moderation, but you'd be
able to work off the same server and you'd only receive email notifications for the communities to which you've subscribed.
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NOTE: If your user account does not have an appropriate level of access permissions, the
system will show the message "You do not have permission to view the content you have
requested."

NOTE: Once subscribed to a feed, the Pulse system will issue a notification where there is
any activity. You can change your notification settings to suit your preference. See "Editing
Your Profile" on page 323.
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Using Mentions
AVAILABLE TO: Administrators, Employees, and Customers
You can use the Mentions feature to mention other registered users by name when posting status
updates or creating articles. Like many popular social media sites, this feature lets you type the
@ sign and then a user name to mention a user in your update.

HOW TO MENTION OTHERS IN STATUS UPDATES AND ARTICLES
1. Navigate to the desired topic.
2. Start posting a status update or an article. See "Posting Status Updates" on page 328 and
"Posting Articles" on page 336.
3. When you want to mention another registered user, type the @ sign. This reveals a drop-down
that describes how to use the mentions feature.

4. Begin typing letters that match the user you want to mention. When a match is found, select it
in the drop-down list.

5. Finish typing the status update or article. Then click Share. The post is added and Pulse sends
notifications to the people(s) you mentioned.
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Working With Favorites
AVAILABLE TO: Administrators and Employees
Pulse allows you to add group, tag, and topic feeds to a list of favorites. In addition, you can create
more than one favorites list to help you organize information.The Favorites feature is available both
the Flare output and Pulse dashboard.

HOW TO CREATE A FAVORITES LIST
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Navigate to the desired group, tag, or topic feed.
3. In the top right corner of the feed, click
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4. In the space provided, type a name for your new list and press Enter.

HOW TO ADD A FEED TO YOUR FAVORITES
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Navigate to the desired group, tag, or topic feed.
3. In the top right corner of the feed, click
list.
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HOW TO DELETE A FAVORITES LIST
1. Log in to the Flare content or Pulse dashboard using an account that is a member of the
Administrators or Employees group.
2. Depending on which tool you are using, do the following:
n

If you are logged into the Flare output, click the Community tab.
OR

n

If you are logged into the Pulse dashboard, choose Pulse > Home.

3. In the left pane, locate the Lists area and highlight the list you want to remove.
4. Click

.

5. In the Delete Favorites dialog, click OK.
NOTE: You cannot delete the default list named "Favorites."
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Searching for Community Results
AVAILABLE TO: Administrators, Employees, and Customers
When integrating a Pulse system with a Flare community, you have two different search options.
You can search a feed in Pulse or, if you enable the feature, you can extend the scope of a Flare
search to include the Flare community results stored in Pulse.

Searching a Pulse Feed
In the Flare output, users can search a Pulse feed for matches. With this method of search, the
scope of the search is limited to the active topic feed.

HOW TO SEARCH A PULSE FEED
1. Log into the Flare output or Pulse dashboard using a registered Pulse account.
2. In the embedded discussion form, type a search query in the Search this Feed box.
3. Press Enter. This searches only the active feed.
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Searching the Flare Output for Community Results
If you enable the display of community search results in the Flare skin (i.e., select Display community search results), the scope of a Flare search can be extended to include matching community activity from Pulse. See "Integrating Flare and Pulse" on page 126.

HOW TO SEARCH THE FLARE OUTPUT FOR COMMUNITY RESULTS
1. Log into the Flare output using a registered Pulse account.
2. In the search entry field associated with the Flare output, type your search query and then
press Enter.

3. In the search results page, any posts containing your search terms appear under a heading
titled "Community Results." Any matching Pulse activity is listed beneath the heading.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.
TUTORIALS

Getting Started Tutorial
Product Foldout Tutorial
Side Navigation Tutorial
Top Navigation Tutorial
Tripane and PDF Tutorial
USER GUIDES

Accessibility Guide

Getting Started Guide

Analysis and Reports Guide

Global Project Linking Guide

Architecture Guide

HTML Help Guide

Autonumbers Guide

HTML5 Guide

Condition Tags Guide

Images Guide

Context-sensitive Help Guide

Importing Guide

DotNet Help Guide

Index Guide

Eclipse Help Guide

Key Features Guide
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Language Support Guide

Source Control Guide: Git

MadCap Central Integration Guide

Source Control Guide: Perforce

Movies Guide

Source Control Guide: Subversion

Navigation Links Guide

Source Control Guide: Team Foundation Server

Plug-In API Guide

Styles Guide

Print-based Output Guide

Tables Guide

Project Creation Guide

Tables of Contents Guide

Pulse Guide

Targets Guide

QR Codes Guide

Templates Guide

Reports Guide

Topics Guide

Reviews & Contributions Guide

Touring the Workspace Guide

Search Guide

Transition From FrameMaker Guide

SharePoint Guide

Variables Guide

Skins Guide

WebHelp Outputs Guide

Snippets Guide

What's New Guide

CHEAT SHEETS

Folders and Files Cheat Sheet
Print Output Cheat Sheet
Shortcuts Cheat Sheet
Structure Bars Cheat Sheet
Styles Cheat Sheet
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